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1.1  Introduction to Channel Strip 
This chapter describes all the functions available within an SD and Quantum series channel strip. Sections 2 

and 3 cover the common elements of input and output channels, sections 4 and 5 cover features specific to 

different channel types. Familiarise yourself with the Channel Strip (Figure 1) and Channel Setup Display 

(Figure 2).  

Note: Most of the images in this manual reference the SD display style and the Quantum console version 

will probably differ slightly in appearance and have separate manual chapters to deal with relevant 

additional features. 

 

Figure 1 - Channel Strip 

 

Figure 2 - Channel Setup 
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1.2  Channel Input - Common Elements 

1.2.1  Channel Strip Input Area 

  

The Input Area is located at the top of the Channel Strip which displays digital trim and polarity on all channels. 

Input channels also display Main/Alt input selection and input metering plus analogue gain, gain tracking and 

phantom power depending on the input route. Output channels display channel delay. 

Note: Alt inputs now store a separate digital trim Value. This feature will only function correctly in a new 

session made in V1528 or later.  

Other input parameters and channel settings are contained in the Channel Setup display, accessed by touching 

the channel’s input or filters area at the top of the channel strip.  

The large on-screen rotary controls remote pre-amp gain, if this is available on the input route socket of an 

input channel, or otherwise digital trim. The smaller on-screen rotary controls digital trim when the large on-

screen rotary is controlling gain, or delay on an output channel.  

The large on-screen rotary be adjusted on the rotary encoders immediately above the channel strip (SD7, 8, 10, 

Q7) or assigned to the under-screen rotaries using the Quick Select buttons (SD5, 9, 11, 12, Q3). When this on-

screen rotary is selected, the buttons under the rotary encoders toggle polarity.  

The smaller on-screen rotary can be adjusted by scrolling the selection down using the assign scroll buttons. 

When this on-screen rotary is selected, the buttons under the rotary encoders toggle gain tracking or delay 

on/off.  

Note: that a large channel input meter is displayed by scrolling up on the assign buttons or scroll buttons 

(already displayed on Q3) 

  



SD & Quantum Software Reference Manual  1.2 Channel Input - Common Elements  

1.2.2  Channel Delay 

Delay controls are found in the Channel Setup Display (opened by touching the top of the channel strip). The 

left-hand blue on-screen rotary controls the coarse delay amount in milliseconds. The right-hand blue on-

screen rotary enables fine adjustments to be made, at sample precision. Both on-screen rotaries can be 

assigned to under-screen rotary encoders by touching this area of the Setup Display.  

It is also possible to enter a specific delay amount using the delay keypad. Touch the keypad symbol to the right 

of the on button, select the desired units, enter the value using the keypad, and touch OK. 

Note: that altering the delay units in this keypad display will affect all instances of this value on the 

console.  

 

1.2.3  DiGiTube 

 

DiGiTube emulates the non-linearities of a valve amplifier: At low levels the valve is almost linear and at high 

levels the valve starts to compress and exhibits ‘soft clipping’. 

To enable, touch the on button available in the Channel Setup Display.  

The drive control increases the gain into the virtual valve and automatically reduces the output gain so that the 

volume stays constant; the indicator shows how hard the valve is being driven and hence how much distortion 

is being introduced.  

The bias control sets the symmetry of the distortion: At 0 the distortion is symmetrical and produces largely 

2nd harmonic (and other even) distortion; as the bias is increased, the distortion becomes more asymmetrical 

and starts adding 3rd harmonic (and other odd) distortion. In effect, the bias controls the characteristics of the 

distortion; a lower bias produces a softer distortion, whereas as a higher bias produces a harder distortion.  

The warmth button (which is hidden if the on button is pressed) switches DiGiTube on, sets it to its default 

settings, and hides the rest of the controls.  
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1.2.4  Naming Channels & Busses 

 

 

To edit a name, touch any white text box or the keyboard symbol to its right, to bring up an on-screen QWERTY 

keyboard.  

This includes functions such as Cut, Copy and Paste which can be used to move names between channels. The 

arrow buttons in the bottom right-hand corner of the keyboard display move the cursor within the text box. 

Once editing is complete, press OK (or Enter on an external keyboard). To close the keyboard display without 

changing the name, press CAN (or Esc). To move the keyboard display to the following channel, press Next (or 

Tab). 

The Channel Name display enables commonly used words to be inserted quickly without the use of the 

keyboard. To open the Channel Name display, touch the button immediately to the right of the channel name 

text box. Touching any word from the display inserts that word into the channel name text box. Further words 

can then be added to the channel name in the same way, divided by a single space. Numeric and L/R identifiers 

can be added from the column down the right-hand edge of the display. By default, text is entered in lower 

case. It can be entered in CAPS or Initial Caps by pressing the respective buttons at the top of the display.  

  

Other commonly used words can be added and accessed by touching the Custom button. To add a new word to 

the custom set, touch an empty slot, press Edit, enter the word followed by OK (Enter). The Next button saves 

any text inserted in the current slot and moves the keyboard to the next slot in the custom list.  

Note: that Channel names can also be edited in quick succession within the Channel List as described in 

Chapter 2 (2.2.3) 
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1.2.5  Channel Safes 

 

 

 

 

Figure 3 - Safe Button in Channel Strip 

 

 

The Channel Safes area of the Channel Setup Display defines which parts of the channel will not be changed 

when snapshots are recalled. The buttons turn red when pressed to indicate that they are safed. The presence 

of safes within the channel are also indicated by red text and the background of the channel’s name turning 

red. EQ and dynamics parameters can also be safed and unsafed from within the EQ and dynamics displays. 

The whole channel can also be safed and unsafed quickly by pressing the SAFE button at the bottom of channel 

(using a mouse), shown in the red box in Figure 3. The SAFE button is lit red to indicate a full safe.  

There is also a physical Safe button on the SD5 & Q5, SD7 & Q7 and Q8 consoles, which performs the same 

action as the button on the bottom of the channel strip.  

Note: that channel safes refer specifically to snapshot recalls and do not protect channel settings when 

using the copy from, copy to and presets. 

1.2.6 Copy Channels 

 

 

Figure 4 - Channel Settings Area of Channel Strip 

 

Figure 5 - Copy Channels Display 

The Channel Settings area (Figure 4) of the Channel Setup Display (Figure 2) allow channel settings to be 

copied between channels. The left and right arrow buttons are used to move the Channel Setup Display to 
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adjacent channels. The Copy From button allows settings to be copied from other channels to this channel and 

following channels (if number of channels is greater than 1). 

Pressing Copy From opens the Copy Channels Display (Figure 5). The segments of channel settings to be 

copied is selected using the scope buttons towards the bottom of the display. These buttons turn pink to 

indicate that they are included in the copy function. The number of channels to be copied from is selected 

using the appropriate grey numbered button, or by entering a number on the keypad available from the icon to 

the right of the text box 

Press the LCD/channel select button (Figure 6) on the left-most source channel in order to action the channel 

copy. If more than one source channel has been selected, the settings of appropriate number of channels to 

the right of the source channel will copy to the channels to the right of the destination channel (the currently 

assigned channel). 

 

Figure 6 - LCD Copy Functions 

 

Figure 7 - Copy Channel Display 

The Copy To function allows settings to be copied from one selected channel to either one or multiple channels. 

Pressing Copy To opens a slightly different Copy Channels Display (Figure 7). This also includes a Stay Open 

button on the top left of the display. This means that the display isn’t closed when a user presses Copy using the 
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LCD function or the select buttons. Instead the display remains open allowing the user to copy the selected 

channel multiple times to different channels.  

If a copy from or copy to function is actioned by mistake, it can be undone by pressing the undo previous copy 

button in the current Copy Channels display. 

Tip: Use copy to for copying one channel’s settings to a number of other channels; Use copy from to copy the 

settings of a group of channels to another group of channels. 

1.2.7  Channel Presets 

 

Figure 8 - Channel Settings Area of Channel Strip 

 

Figure 9 - Presets Display 

Presets are used for storing and recalling settings for channels, fx units, graphic EQs and the matrix. The 

Presets Display (Figure 9) can be accessed via Channel Settings (Figure 8) area of the Channel Setup Display 

(Figure 2) below the copy buttons.  

The left-hand column of a Preset Display contains the available groups of presets and select one of these 

groups brings up the list of presets within that group. The columns to the right of the preset name displays the 

number of channels whose settings are included in the preset (chs) (Channel and Matrix presets only), the date 

and time it was created or updated (notes), and whether it is locked (lock). 

Note: that a presets display will only list presets of the relevant channel type.  

To recall a preset, select the name of the group containing the preset you wish to recall, and then touch the 

preset’s name. The recall scope buttons at the bottom of the preset displays allow you to select which 

elements are recalled and which elements remain unchanged. The buttons are included in the recall when they 

are lit. To save the current settings as a new preset, select the group in which you want the preset to be stored 

and press the ‘new’ button on the right. To alter the preset’s name, type the new name using the keyboard 

display (or the external keyboard) then, if relevant, touch and edit the number of channels’ settings that you 
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want to store in the preset (the default is one channel - if more than 1 is specified then the channel settings of 

the channels to the right of the selected channel will be saved). Now press OK.  

Note: that pressing CAN in the keyboard display will cancel the display but create the new preset with a 

default name. 

To save the settings as an update of a previous preset, press update, select the preset you wish to overwrite, 

and press Yes in the confirmation display which appears.  

Note: that when updating a previous preset, failing to press update will result in the preset you wish to 

overwrite being recalled, and the settings to be saved being lost. 

To create a new group of presets, press new group. A new group will be created, called Group n, where n is the 

next available preset group number. To alter the group’s name, type the new name using the keyboard display 

that appears (or the external keyboard) and press OK (or Enter). 

Note: that pressing CAN in the keyboard display will cancel the display but create the new group with its 

default name. 

The edit name button allows preset names and group names to be edited, and the preset to be locked, 

preventing them from being edited, overwritten, or deleted. The button is lit to indicate that it is active. To edit 

a preset’s name, make sure the preset is unlocked (see below), activate the edit name button and touch the 

preset’s name. Type the new name in the keyboard display and press OK. To edit a preset group name, activate 

the edit name button and touch the group name. Type the new name in the keyboard display and press OK.  

To lock the preset, activate the edit name button and touch the preset’s lock column. A grey padlock appears, 

indicating that the preset is now locked. Touching the lock again with edit name active unlocks the preset. To 

delete a preset, press delete, touch the preset to be deleted, and press confirm. 

To delete a consecutive range of presets, press delete followed by select range, touch the first and last preset 

to be deleted and press confirm. To delete one preset, or a non-consecutive range, touch each preset to be 

deleted and press confirm. To delete an entire group of presets, press delete followed by select all, then press 

confirm.  
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1.2.8  Channel Solos 

SD and Quantum consoles have two solo buses, and each channel can be assigned to solo 1, solo 2 or both. If 

the console was being used for stage monitors, this would allow the first solo bus to feed IEMs (In-Ear 

Monitors) and the second solo bus to feed a monitor wedge. 

Note: the solo busses are configured in the Solo Display accessed by pressing the Solos button from the 

menu bar at the top of the Master Screen (Figure 11). 

 

 

The channel’s solo routing is assigned in the section at the bottom section of the channel Setup display. 

Pressing the green solo 1 and solo 2 buttons enables the channel to be routed to solo busses 1 and 

respectively. The text is white to indicate that the solo buss is available, and grey to indicate that it isn’t.  

Figure 10 - Solo Display 

Figure 11 - Master Screen 
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When the auto solo buttons are active (indicated by blue), that channel is automatically routed to the solo bus 

whenever another channel is soloed to the same bus. Note that a list of channels with auto solo enabled is 

displayed in the auto solo section of the master solo display.  

The auto solo function has to be activated by pressing the ‘disabled’ button below the auto solo list in the 

master solo display, this will turn blue with ‘enabled’ to indicate an on state. Auto solo is disabled when in 

single solo mode. 

Tip: If you are using effects returns, selecting auto solo can allow soloed tracks to be auditioned with their 

effects returns. 

 

Figure 12 - Solo Routing 

The channel’s solo routing (Figure 12) is assigned in the section at the bottom section of the Channel Setup 

Display. Pressing the green solo 1 and solo 2 buttons enables the channel to be routed to solo buses 1 and 2 

respectively. The buttons turn green to indicate that the solo bus is enabled on that channel. 

Note: Each channel must be assigned to at least one solo bus. 

Note: A list of channels with auto solo enabled is displayed in the auto solo section of the master Solo 

Display. The auto solo function has to be activated by pressing the blue enabled button below the auto 

solo list in the master solo display. Auto solo is disabled when in single solo mode.   
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1.3  Channel Output and Inserts - Common Elements 

1.3.1  Channel Strip Output Area  

The Channel Strip Output Area (Figure 13) makes up the lower half of the Channel Strip (Figure 1). This is 

where the channel output routes are configured (including Aux sends in the case of Input channels). Some 

basic output and insert functions are found in the channel strip. However, most of the output and insert 

parameters are contained in the channel Output display, accessed by touching the channel’s output or insert 

areas. 

 

Figure 13 - Channel Output Display 

 

Figure 14 - Aux Send Area of Channel Strip 

 

Figure 15 - Output Channel Meter 

On Input channels, the lower part of the channel strip contains the aux sends (Figure 14). For all output 

channel types, there is a channel meter displayed in place of aux outputs (Figure 15). On stereo and multi 

channels, symbols below each meter indicate which signal they correspond to. LFE meters are indicated by a 

small box with a dot in it.  

Note: input channels can display a meter in the top section of the channel strip. 

Meter sources are defined in the Options menu, described in Chapter 2: Master Section. Below the meters 

section of output channels, there is an FX Output button (Figure 15). This button brings up either the controller 

display for the effects preset that has been assigned, or the FX Presets display if no preset has been assigned. 

Note: that below the aux section of an Input channel, there is a pan control in place of the FX Output 

button. When an effects preset has been assigned to that channel's Direct Out, touching this pan control 

brings up the FX preset controller display.  
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Figure 16 - Bottom of Channel Strip 

Below the channel name (Figure 16), there is indication of the lowest group (Grp:) output (along with 

indication of the lowest direct output (Dir:) in the case of Input channels), and indication of any control group 

(CG:) to which the channel belongs. The on-screen channel has MUTE and HARD (mute) indicators located 

above the Channel Name.  

Hard Mute 

Pressing the worksurface Mute Button of a channel silences all outputs from the channel apart from any which 

have been assigned pre-mute (this option is available for auxes and direct outs). Pressing the worksurface 2nd 

Function button to activate the Hard Mute silences all outputs from the channel, including those which are 

assigned pre-mute. A dedicated Hard Mute button for the selected channel can also be found on the 

worksurface of relevant consoles.  

Immediately below the HARD button, there is a numeric display of the channel’s main fader value in dB. Below 

the MUTE button there is a CG MUTE Indicator which shows when the channel is muted as the result of its 

membership of a muted Control Group. In the bottom left-hand corner of the channel strip, there is a GANG 

display. To the right of the GANG button there is a SAFE button. This indicates that one or more of the channel's 

recall safes have been activated 

Note: Multi channels do not have their own insert controls – each multi-channel component's insert 

points are configured individually. 

Note: An Input channel’s aux display is opened by touching the aux area. To open the Output display, 

touch in the muting and naming area below the pan control. 
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1.3.2 Channel Strip Insert Area 

Each channel also has two inserts: insert A and insert B.  Both inserts follow the format (mono or stereo) of 

their channel. The channel strip insert areas are located above the EQ Section (Insert A) (Figure 17) and 

below the 2nd Dynamics Section (Insert B) (Figure 18), and their signals are sent and returned to that 

position within the signal path: insert A is pre-signal processing (but post filters), and insert B is post signal-

processing (SD- see below for Quantum). Only one point, either insert A or insert B, can be used per channel 

on SD9 or SD11. 

 

Figure 19 - Insert A in the Channel Strip 

Channel strip insert areas include a button for switching that insert send on and off. The button is grey when 

the send is off, and red when it is on. Below the on/off button, there is a display of the current insert routing. 

The send route is displayed on the left, with the prefix “S:”, and the return route is displayed on the right, 

prefixed by R: (Figure 19). If no routing has been selected, these areas are blank apart from these prefixes. If 

the channel is stereo, only the left side of the insert routing is displayed. 

Post Fader Inserts 

Up to 32 mono input channels (SD) can have their insert B point switched to a post fader insert point using the 

button in the Channel Output display (Figure 20). 

 

Figure 20 - Channel Output Display 

Inserts on Quantum Consoles 

On Quantum consoles, there are 5 selectable insert positions available on every channel. These are: pre-fade, 

mid EQ/dyn, pre-EQ/dyn, pre-processing and post-fade. These are shared between Inserts A & B, and Mustard 

processing. One of these items can be placed in each insert position, and each one can go in any of the 5 

selectable positions (provided neither of the other items are using that particular insert point). 

 

Figure 17 - Insert A in the Channel Strip 

 

Figure 18 - Insert B in the Channel Strip 
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1.3.3  Console Output and Insert Routing 

The Output displays for all channel types allow direct routing either to the external IO racks, or to one of a 

variety of internal locations, for both the channel’s main output (or direct output in the case of Input channels), 

and its insert send and return. In addition to touching inside the output area of the channel strip, it is also 

possible to open each channel's output display from the Channel List Display (Figure 21), opened from the 

Master Screen menu Layout > Channel List. Activate the Edit button at the base of the display, expand the 

required channel type by touching its entry in the list, then touch the output column within the required 

channel row. An outputs display will open within the Master Screen. 

 

Figure 21 - Channel List Display 

Towards the bottom of the Outputs display, there are three buttons marked output (direct in Input channels), 

insert A and insert B. Selecting one of these buttons opens the Signal Routing Area. When either insert is 

assigned, the ins A send or ins B send routing button appears in the left-hand column, and the ins A return or 

ins B return routing button in the right-hand column; When the output (direct output in Input channels) is 

assigned, the outputs (direct outs in Input channels) routing button appears in the left-hand column and the 

right-hand column is left blank. Pressing any of these routing buttons opens a routing display (Figure 22). 

An extra button labelled send+return is included above the ports list in the Insert Send Route display button 

(Figure 23). When this button is activated, the send and return routing is linked for all signals within the 

INTERNAL port; if Graphic EQ 1’s input is assigned to the insert send, then Graphic EQ 1’s output is 

automatically assigned to that insert return. Similarly, if it is the return which is manually assigned, the send 

automatically copies that send assignment. The send+return button is grey when inactive and brown when 

active (Figure 24).  
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Figure 22 - Direct Out Display 

 

Figure 23 - Insert Send Route 

 

Figure 24 - Insert Return Route 

The mono > mono and mono > stereo buttons are used when routing a mono channel to internal FX units and 

Waves plug-ins (where available). When mono > mono is selected, the channel signal is routed to left side of an 

FX unit, or to a mono Waves rack input. When mono > stereo is selected, the channel is routed to both sides of 

the FX unit or Waves rack. 

1.3.4  FX Presets 

Each channel output or insert send can be sent to an internal FX Unit. Pressing the fx presets button at the 

bottom of the Outputs display brings up the fx Presets display. Or pressing the FX Output button available on 

Aux, Group and Matrix channels.  

The fx preset is applied to whichever channel output is active in the Outputs display when the fx presets button 

is pressed: the main channel output (or direct output), insert send A or insert send B: 

  

For more details of SD and Quantum FX and FX preset management, please refer to Chapter 2: The Master 

Screen. 
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1.4  Input Channel – Specific Functions 

1.4.1  Gain Tracking 

The gain tracking option allows the trim level to compensate automatically for any adjustments made to the 

analogue input level. If the analogue input level is increased, the trim level will decrease to keep the channel 

signal level the same (Figure 25). This function is particularly useful when the analogue level is being controlled 

from another console, such as when one console is running monitor mixes and another console is running 

Front of House. Control of the trim rotary and track on/off button can be assigned to the encoder and button 

above/below the channel using the assign scrollers to the left of the encoders or the quick select buttons. 

 

Figure 25 - Input Area of Channel Strip 

1.4.2  Relative Gain-Tracking - Snapshot Recalls Total Gain 

Relative Gain-Tracking is implemented as a Snapshot Recalls Total Gain option at the bottom of the Snapshot 

Global Scope panel (Figure 26) When a snapshot recalls an input channel trim, it compares the snapshot’s 

stored analogue gain against the current gain on the channel’s input socket. If there’s a difference, it offsets the 

value recalled by the trim. This only happens when the socket’s rack is in Receive Only, or the analogue gain is 

not in Recall Scope. 

 

Figure 26 - Snapshot Global Scope Panel 

Note: more information on snapshots and scope is available in Chapter 2: The Master Section 
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1.4.3  Input Routing 

Inputs are routed using the Channel Setup display, opened by touching the input area of the channel strip 

(Figure 25). It is also possible to open this display from the Channel List display, accessed via the Master Screen 

Menu Layout > Channel List. Activate the Edit button at the base of the display, expand the required channel 

type by touching its entry in the list, then touch the main input column within the required channel row. A 

Setup display will open within the Master Screen (Figure 27). 

 

Figure 27 - Channel List with Setup Display 

The buttons at the top of the channel Setup display to define the format of the channel: mono or stereo. 

Note: that Multi-channel formats are configured in a different way from mono and stereo formats, as 

described later in this chapter 

The channel format affects a number of functions within the Setup display, therefore it is advisable to select 

the format before any further configuration takes place. The current format of the channel is indicated in the 

channel strip by the number of meters displayed: One meter for mono channels and two for stereo. 

For mono channels, each input channel has two inputs: a main input and an alt(ernative) input. These are 

selected using the ‘main’ button in the channel strip. The button is grey when the main input is selected and 

red when the alt input is selected. The input can also be selected using the main and alt buttons towards the 

top of the Setup display. These buttons light to indicate which one is currently selected (Figure 28). For stereo 

channels, the alternative input becomes the right side of the stereo input, and therefore no main and alt input 

selection buttons are shown. 
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Figure 28 - Alt Input in Channel Setup 

Note: The inputs available on an Input channel include feeds from the external IO racks, the local inputs 

on the back of the console and a variety of internal signals. Pressing either the main input or alt input 

routing button in the Setup display opens the Input Route display.  

(V1260+) Input Channels can be ripple routed by pressing or typing in the number of channels to be routed, 

then pressing the first input route source. There are two options for ripple routing, channel number or fader 

bank. Channel number is the default selection and routes channels in channel number order. So, if the first 

three channels in the bank are Ch 2, Ch 1, Ch 3: ripple routing from local IO gives Mic 2, Mic 1, Mic 3. Fader 

bank routes the channels in the order that they appear on the bank, so the routing in the example gives Mic 1, 

Mic 2, Mic 3.  
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1.4.4  Input Configuration 

If a channel is stereo, balance and width controls appear below the mono and stereo buttons. The left-hand 

blue, on-screen, rotary controls the balance and can be reset to centre by pressing the centre button below it. 

The right-hand blue rotary effects the width of the stereo signal, with a range from mono to wide. The width 

can be reset to stereo by pressing the stereo button beneath the width rotary. The value of the balance and 

width is displayed to the right of each rotary as a percentage divergence. 

 

Stereo channels also have an m-s button, located above the input routing button, which switches in a decode 

function for replaying M-S signals as a normal stereo pair. There are three further buttons in this panel: L<>R 

swaps the channel’s left and right outputs, L>L+R sends the left signal to both left and right busses, and R>L+R 

sends the right signal to both left and right busses. 

1.4.5  Channel Metering 

Channel meters can be displayed in the top section of the Input channel strip, in place of the input and filters 

areas (Figure 29). To do this, press the Assign up arrow (SD7, Q7), or the Rotary Assign up arrow (SD8, SD10), or 

the Gain quick select and screen scroll up arrow (SD5, SD9, SD11, SD12, Q3, Q5), all located on the console’s 

worksurface. 

   

Figure 29 - Meter in Channel Strip 

On Quantum consoles, switching the channel view from SD to Mustard will also switch the large meters at the 

top of the screen to display the relevant SD or Mustard dynamics metering. 

A small SD or M indicator shows which of the 2 options is active. 
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1.4.6 CG/HARD mute indicators on the Meterbridge (Q7/SD7/Q5/SD5) 

In the multi-layer meter view on consoles with meterbridges, there are indicators displayed for all 3 types of 

mute function – Channel mute, CG Mute and Hard mute.  

 

1.4.7  Output Routing 

Signals can be fed from Input channels to four different places: aux busses, group busses, insert sends and 

direct outputs. The top half of the output section of the Input channel strip contains the aux buss controls, as 

previously described. Touching under the pan controls opens the Output Display (Figure 30), from here the 

channel strip can be assigned to groups and to direct outputs. Outputs can be routed from the Channel List just 

like inputs (Figure 27). 

 

Figure 30 - Output Routes 
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1.4.8  Pan Controls 

The controls are formatted to match the format of the buss with the most components: 

• Where there are only stereo or LCR busses, a simple pan slider is shown (see below left). Move the 

slider to adjust the pan. A text box indicates the panning position as a percentage from the centre 

towards the right. 

 

• Where there are LCRS busses, a two-dimensional panning scope is shown (see below centre). Move the 

central grey square to adjust the position. Text boxes indicate the left-right and front-back position. 

 

• Where there are 5.1 busses, a two-dimensional panning scope is shown, along with a pink LFE level 

control (see below right). Move the central grey square to adjust the position. Text boxes indicate the 

left-right and front-back position, as well as the LFE gain. 

 

To send a channel to the LFE channel of the 5.1 buss, the LFE level must be assigned to a rotary row. Pressing 

the rotary button then toggles the channel between being sent to the 5 channels but not LFE, just LFE, and 

both LFE and the 5 other channels of the buss. 

There is also an LCR blend knob. This control allows adjustment of the amount of signal that is sent to the 

centre leg (where one exists) of a surround or LCR buss. In the extreme left LR position, no signal will go to the 

centre leg: 

 

Note: the pan of the Assigned channel can be controlled using the worksurface joystick (SD5,7,8,10). The 

pan control can also be assigned to one of the encoder rows. LR/LCR Blend is adjusted using the 2nd 

function button. 
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1.4.9  Aux Buses & Assignable Controls 

Within an Input channel strip, each aux send has a level rotary and on/off switch to the right. The switch is grey 

to indicate that the send is off, and red to indicate that it is on. The send level is displayed in dB on the right of 

the channel strip, underneath the aux number. 

There are three places within the channel from which the aux sends can be fed (SD), as indicated by the source 

display immediately to the right of the level trim (Figure 31), these are pre-fader, post-fader and pre-mute. 

On Quantum consoles, there are 6 locations for the aux send in the channel strip. These are: pre-fade, pre-

mute, mid EQ/dyn, pre-EQ/dyn, pre-processing and post-fade.  

 

Figure 31 - Aux Send Position 

The source position can be changed by pressing the worksurface 2nd function button and using the buttons 

below the rotary encoders (with the aux assigned to that particular row of rotaries). The source for each aux 

can also be adjusted globally via the aux channel’s Setup display. 

On stereo aux sends, there is a pan control to the right of the on/off switch. This can be adjusted by pressing 

the worksurface 2nd function button and using the rows of encoders below the worksurface screen. The pan 

controls for each aux can be globally linked (or reverse linked) to the channel pan via the aux channel’s Setup 

display. 

At the bottom of the assigned channel SD7/Q7 worksurface controls, there are four dedicated aux encoders 

with buttons, which control four contiguous aux send rotaries and on/off switches for the Assigned channel. 

 

The auxes controlled by these encoders and buttons can be selected using the scroll buttons to the left of the 

top encoder and is indicated by purple ring on the on-screen aux sends. 
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Note: that this assignment is channel specific and will be recalled if the Assigned channel is changed and 

returned to that channel. 

The encoders and buttons immediately below the Channel Strip can be used to control either the aux sends, or 

a separate function. This function is referred to as the ‘locked’ function, as it does not change when the auxes 

are moved. The button at the end of each row, next to the LCD display, flips the assignment of that row 

between the aux sends and the locked function. 

Touching any on-screen aux send assigns the highest available encoder row to that send and assigns any other 

available encoder rows to the aux sends below it. The scroll button outside the bottom left-hand corner of the 

screen can also be used to change which auxes are assigned to the encoders. (SD5,7,8,10) 

Note: that a maximum of six auxes can be displayed in the Channel Strip panel at once. The panel will 

always display the auxes assigned to the encoder rows below it. This means that the auxes controlled by 

the dedicated aux encoders in the channel worksurface controls may not be visible. 

By default, the encoders control the aux level and the button controls the aux on/off status. However, by 

pressing the 2nd function button (located on the surface), the button becomes the aux’s send position selector 

and the encoder becomes the pan control of a stereo channel. On mono auxes, the encoder has no second 

function. 

It is also possible to show all of the aux sends for a channel in a single display and assign them to the rotaries 

beneath the screen. This is done by assigning the required channel to the aux controls (the assigned auxes will 

be displayed in dark purple with a dark purple surround) then touching one of the assigned auxes. The layout 

of the display indicates which encoder each aux is assigned to; if there are more sends than rotaries, the 

assignments become scrollable using the Screen Scroll function. The Picture below shows an SD7 with 36 

Sends. 

 

Once you have adjusted the auxes in this display, you need to close it manually before opening any other 

channel detail display. 

(V1260+) Aux sends/nodes can be safed individually, which includes aux send level, aux on/off, node solo 

(Quantum only), nodal processing (Quantum only) and KLANG parameters. All aux nodes in a channel can still 

be safed together by pressing the all safe button in the expanded aux send panel or aux node panel. To safe 

nodes individually, press the node safe button, then press on the nodes to be safed, which will be indicated by 

the aux node text turning red. Once the safes are complete, press the node safe button again. 
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(V1455+) A more/less button has been added to Aux Expanded panel that will increase the panel size to show 

up to 5 rows of aux sends depending on the session.  These can be scrolled to assign them to under screen 

rotaries.  

 

Note that when folded the amount of auxes displayed in the Aux Expanded panel will depend on how 

many rows of assignable rotaries a console has.  

 

Note: that further worksurface assignments of auxes is available via the Surface, Faders and Solo tabs of 

the Options menu 

  

More/Less button folds and unfolds 

up to 5 rows of aux sends. 

Safe all aux 
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Aux send rotary 
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1.4.10  Aux Nodes Panel (all consoles) and Nodal Processing (Quantum only) 

In Layout > Aux Nodes, there is an input/groups button, and an aux buss button.  

The input/groups button will show the aux sends per channel for the last selected channel.  

The aux buss view will show all the channel contributions or group contributions to an aux buss. 

When in aux buss view, either channels or groups can be shown in the aux contribution panel. This is selected 

in the show section located bottom right corner of the panel. 

 

 

When a console has more than 128 input channels, the 129-256 button will become available. 

 

Along the top and bottom of the panel are function buttons. 

Solo node Each aux node can be soloed.  This feature can also be accessed from the channel screen expanded 

aux panel or from the nodal processor control panel.  The circular node On/Off indicator will show a green “s” 

when nodal solo is active. 
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If Options>Solo>Solo Displays All Aux Sends is enabled, soloing either an input channel or an aux master will 

open the aux nodes panel with the appropriate view selected. 

The follow selection button links the input/groups view and aux buss views together.  If a node has been 

selected, switching between input/groups and aux buss view will show the sends for the selected channel.   

For Example, in input/groups view select aux 17.  When the aux buss view is selected, this will show all the 

contributions for aux 17.  If in aux buss view the node for CH3 is selected, when the input/groups view is 

selected, the aux sends for Ch3 will be shown. 

The bring to surface button will bring the selected channel or buss to the worksurface and open the nodal 

processing panel if active. 

There are three Nodal processing mode buttons in the Aux Nodes panel. 

Add. Touching add then selecting an aux node will activate nodal processing for that aux send.   

Bypass. Toggling this control will temporarily bypass the Nodal processing on the selected aux send.  This 

function is not recallable with snapshots. 

Remove. This will remove nodal processing from the selected Aux send. 

Nodal Processing.  

Each Aux node send can have SD Nodal EQ and Dynamics inserted in its audio path. The maximum number of 

aux nodes available simultaneously depends on the model of Quantum console. The number of nodes in use is 

displayed in the Diagnostics panel.  Each nodal processor also has its own entry in snapshot scopes and they 

are also included in the channel list. 

If processing is active on a node, a purple P is displayed next to the node on/off button.   

 

This status will also be visible in the channel strip aux display.  When the node is touched in the Aux Nodes 

panel, the processing controls will be displayed and assigned on the screen where that channel is located.  

Both the EQ and dynamics controls will be displayed at the same time.  There is also a control panel for aux 

node functions located in the bottom right-hand corner. 
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Nodal Processing Copying  

‘Copy To’, ‘Copy From’, and ‘Copy From Channel’ are available for Nodal Processing via a popup panel on the 

nodal processing expanded view. Processing can be copied from other nodal dynamics or SD channel strip 

dynamics. 

 

1.4.11 KLANG Nodes 

 

KLANG Nodes can be activated on aux send to allow control of the channel’s KLANG parameters. A KLANG 

button is displayed in expanded aux panel and the Aux Nodes panel after KLANG is enabled in the External 

Control panel (See Chapter 2 - 2.12.14). 

To add or remove a KLANG node press the KLANG button, which will turn purple to indicate edit mode, and 

press on the individual aux sends to activate or deactivate a KLANG node. A KLANG ‘G’ will appear in the aux 

send box to indicate a KLANG node. When the addition/removal of KLANG nodes is complete, press the KLANG 

button again to disable editing.  

When an aux send with a KLANG node is pressed, an expanded KLANG control panel is shown at the bottom 

right of the display.  

A KLANG ‘orbit’ is displayed in the left-hand side of the panel, which displays the KLANG source position. When 

pressed, this will show an expanded orbit in which positional data can be adjusted. 

To the right of this are the individual KLANG parameter adjustments: azimuth, type, elevation and solo 

(indicated by a green KLANG ‘G’). On the right-hand side are controls for the Klang send level and an on/off 

toggle. All of these on-screen controls are assigned to the under-screen rotaries. In the top row of the panel 

there are ‘copy’ and ‘copy from’ buttons to copy the KLANG and aux parameters to another KLANG node. 

The processing can be copied 

from the main channel strip or 

from other nodes 
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When KLANG is active, a new copy to KLANG button is visible in the copy levels drop down menu in the Aux 

master setup panel.  This will copy the aux send levels to the KLANG levels for that mix and in that snapshot. 

 

1.4.12 True Solo (Quantum only) 

This function allows the user to copy any internal processing used on an output buss to the solo buss so that 

they get a true representation of what the artist is hearing.  Any changes to the buss processing are updated in 

real time to the solo buss.  The True solo controls are accessed from the Solos panel or by creating a macro 

that will directly open the True Solo panel. 
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1.4.13 Insert Point Locations (Quantum only) 

As with aux nodes, each insert point can be moved Post Fader, Pre-Fader, Mid EQ/Dyn, Pre EQ/Dyn and Pre 

Processing.  Only one insert point can be in each location at any one time. 

 

1.4.14  Group Outputs 

Group outputs are routed from within the groups section of the channel Outputs display. Touching the mono 

button to the left of the display produces a list of available mono groups in the right of the display and touching 

the stereo or surround format buttons produces a list of the other types of groups. These buttons 'light' to 

indicate that it is their group outputs list which is currently displayed, and 'half-light' to indicate that there is 

routing to busses of that format which isn't shown in the display. Touching any of the groups within each list 

routes the channel to that group. Each channel can be routed to as many mono and stereo groups as have 

been created. 

 

Any mono groups being fed by a stereo channel will receive a L+R summed signal of the channel output. The 

lowest selected group output is displayed in the channel strip, below the left side of the channel name, and the 

currently selected direct output is displayed below the right side of the channel name. When a new session is 

created, the lowest numbered stereo group is always designated the Master (SD7/Q7), or the first of the 

largest group type (e.g. 5.1 group) is master (all other consoles). All input channels are routed to the master 

group by default, and the master fader(s) are assigned to it. 



SD & Quantum Software Reference Manual  1.4 Input Channel – Specific Functions  

1.4.15 Mix Minus function on Quantum Consoles 

A different Mono Mix Minus feed can be created at the Direct Output of any mono input channel. 

Firstly, send all required signals (including the channel that is to be removed) to an existing Mono Buss and 

note the name of this buss. 

Then open the Output routing setup on the channel that is to be removed (see picture below) and in the Mix 

Minus section press the button for the Mix Minus buss that you have just created. 

When this channel’s Direct Output signal is now routed to a physical console or rack output, the channel’s input 

signal will be removed from the direct output signal. 

 

1.4.16 Direct Outputs 

Basic routing is described in your console's Getting Started section. Once the direct output has been routed, it 

is switched on by pressing the grey on button next to the output level meter in the grey area below the direct 

outs routing button. The direct out is taken post-fader by default but can be switched to pre-fader or pre mute 

by pressing the button to the right of the on button. The current selection is displayed to the right of the 

button. 
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1.5  Output Channel Specific Functions 

1.5.1  Unfolding Channels 

Group and Aux Channels which are stereo or surround have an Unfold button above their meters, which is 

used to display the components of the signal in their own channel strip with a master channel displayed to 

their left.  

In the top section of the unfolded Master channel, buttons for each component channel allow you to define 

which channel's elements are displayed in the Folded View.  

In the middle area of the unfolded Master channel, the links between component channels can be edited. Links 

function in the same way as Gangs but are limited to the components of a multi-channel signal. To edit links, 

press the Set Links button so that it goes red, then press the LINK buttons above the channel meters in the 

channels to be linked or unlinked - each button will take on the same colour, indicating that they are linked. To 

remove a link, press the LINK button while Set Links is active. Note that if you start a set of links and then de-

link and re-link another channel, a new link set will be started, as indicated by the introduction of a new link 

colour. When you have finished linking channels, deselect Set Links. You can also clear all links and link all using 

the buttons below Set Links. 

Note: that if component channels have different settings when linked, changes in hidden, linked channels 

will be made relative to the change in the Folded View channel, but the display will only reflect the Folded 

View channel. 

Below the link buttons in the master, there are buttons for each element in the components' channels - trim & 

delay, filters & EQ, dynamics and faders & mutes. Pressing one of these buttons will cause that element in all 

the channels to match those of the Folded channel. Once you have finished with the unfolded view, press the 

FOLD button to fold the channels back together (Figure 32)  

 

Figure 32 - Folded and Unfolded View 
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1.5.2  Group Channels Specific Functions 

The Group channel input signals are defined within the Input channels Output display. The top section of the 

Group channel Setup display lists all of the currently selected inputs to that group. The inputs list can be 

scrolled using the scroll bar to the right if necessary. Below the list there are two buttons: clear all removes all 

of the input routes to that group. Pressing this button produces a confirmation box in which the clear all can be 

confirmed or cancelled. connect all routes all Input channels to the group. When select is toggled, multiple 

input channels can be routed to the group by pressing their LCD button which will change to green (Figure 33). 

Press select again once you are finished. The join all button places all input channels in the group, 

Note: With either the connect or clear all functions, you can exclude individual channels from the function 

by touching their faders when the button is pressed. 

 
 

Figure 33 - Assign to Group LCD Function 

 
Group output Busses can send audio to Aux output busses. Pressing the Aux send button, located above the 

output meter, will open the expanded aux panel and the sends will be assigned to the under-screen rotaries. To 

access the aux sends for a stereo, LCR, LCRS or 5.1 Group, the Buss must be unfolded to show the individual 

legs, each leg having its own aux send levels. 
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1.5.3  Aux Specific Functions 

As the Aux channel input signals are defined within the Input channels, there is no input selection available 

within the Aux Channel Setup display. There are, however, a number of configuration options in the top half 

of the Channel Setup display: 

 

The set all sends buttons at the top of the Setup display affect the sends to that aux bus from all of the Input 

channels. The three buttons on the left, pre mute, pre fader and post fader, set the point in the channel from 

which the aux send is taken. The current send point is displayed next to the aux send level in the Input 

channels. 

Note: that send points can also be individually selected within the Input channel using the 2nd function 

button. 

Pressing the link pans button, located to the right of the pre mute button, links that aux send pan to the main 

channel pan in the Input channels. This button lights red to indicate that it is active. Further indication is 

provided by the aux pan slider in the Input channel strip being lit pink. Rev link pans inverts the link between 

the channel pan and aux send pan. Pressing aux to fader assigns control of all input channel’s auxiliary sends to 

the channel faders. 

Pressing aux to rotary assigns control of all input channel’s auxiliary sends to the top available encoder row 

beneath the Channel Strip panel. The purple copy levels from buttons also affect the sends to that aux bus 

from all of the Input channels. The buttons list can be scrolled using the scroll bar on the right. These buttons 

are used for universally setting the aux send levels: Off sets the level to off and 0dB to 0db. fader sets each 

Input channel’s aux send level to match the level of its channel fader. 

The remaining copy levels from buttons copy a different set of Input channel aux send levels to that aux send. 

Note: that when a copy levels from button has been pressed, send levels can still be individually 

readjusted within the Input channel. 

Touching the mix presets button (below the copy mix levels from list) opens the Aux Mix Presets display, where 

you can store and recall presets of an aux send's parameters for all input channels, using the standard presets 

procedure, detailed in Section 2. 



SD & Quantum Software Reference Manual  1.5 Output Channel Specific Functions  

1.5.4  Buss EQ – SD5, SD7, SD10 & Quantum consoles 

On selected SD/Quantum consoles, the option is provided to switch between either high-pass and low-pass 

filters, or 4 extra bands of parametric EQ on output busses. These extra bands of EQ are pre-insert. This allows 

up to 8 bands of EQ in total on an output buss. 

Pressing the curve button on Pre-Insert bands of output EQ will switch the top or bottom two bands to be 

24dB/Oct filters rather than parametric filters. The filter points are controlled by the EQ Freq control.  

 

1.5.5  Addition Buss Features – Input Merge & Ident 

The merge input function allows an additional signal to be mixed with a buss. Touch the top of the buss/output 

channel to open the setup panel (Figure 34).  

 

Figure 34 - Merge Input 

Pressing the merge input button will open the input routing panel for source selection. The level control 

adjusts the level of the selected signal that is added to the buss and an On/Off switch activates the merge 

function. 

Below the merge input button there is a tone button. Pressing and holding this button will route the oscillator 

signal into the output buss. The level and frequency of the oscillator is set in the master screen oscillator panel. 
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1.6  Channel Signal Processing 
Each channel type contains similar signal processing functions, including EQ and dynamics. Input channels also 

have high-pass and low-pass filters. Pressing on each of these areas of the channel strip will open the relevant 

signal-processing display. 

1.6.1  Channel Filters (All SD and Quantum input channels and on SD8,9,11 output channels) 

The filters section of the channel-strip is located below the input section of each input channel. It consists of 

two frequency rotaries, each with its own on/off button and a display of the filter’s cut off frequency (the -3dB 

value) in Hertz. The low-pass filter is at the top and the high-pass filter is at the bottom, and both have a roll-off 

of 24dB per octave.  

The filters directly follow the input section in the signal chain. The filters area is replicated at the top of the 

EQ/filters display, accessed by touching the EQ area of the channel strip. The filter can be configured using the 

dedicated filter encoders and buttons at the top of the channel worksurface controls: 

 

A graphic representation of the filters is included in the EQ graph located below Insert A in the channel strip, 

described below. The red line in the graph represents the current filter settings. 

Note: that the filters section of the input channel strip may be hidden behind channel meters. In this case, 

moving the filter encoders will cause them to be displayed momentarily. To hide the meters and retain a 

permanent display of the filter controls, press the assign down button, located to the left of the encoders 

above the screen. 

1.6.2  Input Channel EQ 

The SD and Quantum input channel EQ has four bands, each of which can be made dynamic. The four EQ 

bands are colour coded: Blue for HF, green for HMF, yellow for LMF and red for LF. The in-channel display is 

located below Insert A and consists of a graphic representation of the current EQ and an on/off button. The 

button is grey to indicate that the EQ is off, and red to indicate that it is on. The green line in the graph 

represents the frequency response of the EQ, and the red line represents the response of the filters – each line 

goes bright to indicate that it is on. The extent and brightness of the opaque area in the bottom half of the 

graph also indicates which elements are on. The central frequency of each band is displayed by small lines in 

the band colours, along the bottom of the graph. 

 

Touching the EQ area of the channel strip brings up the EQ/filters display. The EQ section of the display is 

below the filters section and has another graphic representation of the current EQ at the top. Touching this EQ 

graph will open an expanded view of the graph. The EQ can be configured using the dedicated encoders and 

buttons on the worksurface which follow the same layout as the display: 
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In both the EQ/filters display and on the worksurface, each band has a ±18dB gain controller on the left, a 

frequency controller (ranging from 20Hz to 20kHz) top right and a Q control bottom right. Each rotary has its 

value displayed to its right.  

Bands can be switched between a bell curve (which is the default setting) and a Hi/Lowshelf using the bell 

button. On SD5, SD7 & Q3, the bell button's 2nd function allows each band to be switched between prec 

(precision, where the Q is narrower on the cut curve than the boost curve) and class (classic, where the cut and 

boost Q curves are identical in width). The active setting is shown in red to the right of the bell button. Pressing 

the precision or classic buttons above the EQ controls will switch all four visible bands to that shape. The active 

button goes blue – if different bands are employing different shapes, neither button will be lit. The EQ is 

switched on using the eq on button between the HMF and LMF controls which rings red to indicate that it is 

on. 

Note: that when a band is in dynamic mode, it can also be switched on and off individually in the dynamic 

display. See below. 

Towards the bottom of the EQ/filters display are four grey buttons marked ‘safe’, ‘flat’, ‘preset’ and ‘copy to’. 

Touching ‘safe’ adds the EQ to that channel’s list of channel safes. Touching ‘flat’ resets the EQ gain controls to 

0dB. Touching ‘preset’ brings up the Presets display which can be used to save and recall presets. Touching 

‘copy to’ will open the copy to panel with the EQ section pre-selected. Below these buttons is a smaller round 

button which is also found at the bottom of the channel worksurface controls, for switching the signal-

processing order. The default setting is EQ followed by dynamics, as indicated by the eq-dyn label being to the 

left of the button. Pressing this button reverses the order, as indicated by the labelling switching to a dyn-eq 

display to the right of the button. 
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1.6.3  Dynamic EQ 

When any dynamic EQ bands are on, a dynamic EQ icon appears above the EQ graph in the channel strip (as 

shown on the previous page). The four boxes beneath the icon indicate the status of each band – each box is 

empty (light grey) when the band dynamics are off, dark grey when the dynamics are on but the band is off, 

and coloured when the dynamics and band are on. DiGiCo dynamic EQ can operate in two modes: 'over' or 

'under'. 

Over Mode 

To place the dynamic module into Over mode, ensure that ‘over’ below the threshold control is highlighted 

red. When the signal entering the module passes the threshold, the EQ adjustment (as determined by the 

frequency and Q controls) starts to be applied, up to a maximum adjustment, determined by the EQ band gain 

control. The manner in which the EQ adjustment is applied once the threshold has been reached is determined 

by the attack, release and ratio controls. 

Under Mode 

To place the dynamic module into Under mode, ensure that the Over indication below the threshold control is 

illuminated.  

In under mode, the maximum EQ adjustment (as determined by the frequency, Q and band gain controls) is 

applied when the signal entering the module is below the threshold. As the signal level approaches the 

threshold, the EQ adjustment is reduced to the point where there is no EQ being applied at the threshold. The 

manner in which the EQ adjustment is reduced as the signal level approaches the threshold is determined by 

the attack, release and ratio controls. 

 

Gain: Sets the maximum EQ adjustment that could be applied 

Frequency / Q / Curve: Adjusts the EQ characteristics 

Threshold: Sets the threshold at which the EQ starts to be applied 

Attack: controls how quickly the dynamic module responds to level passing the threshold 

Release: adjusts how quickly the module responds to a fall in level 

Ratio: controls how quickly the maximum adjustment is reached once the threshold level is passed. 

Over Mode is generally used with a reduction in gain at a specific frequency, such that when the threshold is 

reached, a gradual reduction of level at that frequency is applied. This could be used to control a change in 

tonal characteristics as a singer pushes their voice to sing louder. 
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1.6.4  Output Channel EQ 

The EQ located in each output Channel is similar in operation to the input channel EQ, with the following 

exceptions: Output channel EQs have either have 4 Bands of EQ and HPF/LPF (SD8,9,11) or eight bands – four 

pre-insert and four post-insert (SD5,7,10). Buttons in the channel strip (pre-insert eq and post-insert eq) and in 

the EQ display (pre-insert bands and post-insert bands) select which set of bands is assigned to the 

worksurface and display controls. All eight bands are shown in the EQ graph, with the pre-insert bands shown 

in lighter shades than the post-insert bands. 

The precision and classic buttons above the EQ bands only affect the four bands currently displayed, and not 

the full 8 bands available. The pre-insert bands do not have dynamic EQ or bell-shelf switching. 
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1.6.5  Channel Dynamics 

The SD channel dynamics includes two dynamics modules. Module 1 can be a compressor, multiband 

compressor or desser; Module 2 can be a gate, ducker, or compressor with high and low-pass filtering on a self 

or external sidechain. 

The channel strip dynamics section is located below the eq. Each module can be enabled individually using the 

dynamics section next to the screen. 

The display includes an input (In) meter and a gain reduction (GR) meter. The input meter has arrows to its 

right which display the current threshold values for each module.  

Each arrow is distinguished by its colour, which matches its associated threshold rotary. 

When Module 1 is in Compressor or Multiband mode, threshold and gain rotaries, each with a value display in 

dB, are also shown in the channel strip (when in Multiband mode, the threshold rotary affects all bands and 

the mid band's value is displayed).  

The Desser only displays a threshold rotary and its value. There is a threshold rotary (with value display) shown 

for Module 2, with three status indication lights shown when in Gate or Ducker mode. 

At the top of the expanded display are buttons marked undo, safe, presets, copy to and graph. Touching the 

undo button will undo the last change that was made to a parameter of the module. Touching safe adds the 

dynamics to that channel’s list of channel safes. Touching preset brings up the Presets display which can be 

used to save and recall presets. Touching copy to will open the copy to panel with the dynamics section pre-

selected. Touching graph opens up a view of the module in a graphical format. 

 

  

Dynamics 1 Dynamics 2 
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Dynamics 1: Compressor 

In Module 1's compressor, threshold, attack, release, ratio and gain controls are provided, each of which 

function in the normal way. The compressor has an auto gain function which is switched on by pressing the 

auto gain button below the ratio rotary. This function automatically adjusts the gain makeup when changes are 

made to the threshold, thus keeping the compressor output steady. The threshold knee can be switched 

between hard, mid and soft using the knee button in the right side of the module. The gain reduction (GR) 

meter is duplicated in this display. 

 

Dynamics 1: Multiband Compressor 

In Module 1's multiband compressor, each band includes all of the parameters found in the single band 

compressor. The link function remains available for the whole compressor and is not assigned to any band. The 

bands can be switched on individually using the on buttons in the left-hand side of each band, or together 

using the all on button in the display’s right. 

 

The crossover frequency between bands is controlled using the purple and red rotaries to the left of the hi and 

lo bands. Each crossover has a range of 20Hz to 20kHz, and the crossover frequencies are displayed below each 

rotary. Each band can be auditioned (destructively) by pressing the listen button below each gain rotary. 

Dynamics 1: Desser 

The de-esser's controls are similar to those of the compressor, with the following exceptions: In the right side 

of the module, there is a band-pass filter control for the de-esser sidechain, with rotaries provided for the 

centre frequency and filter width. The -3dB points for the hi-pass (hp) and lo-pass (lp) frequencies are shown. 

The filtered sidechain can be auditioned by pressing the listen button. Note that there is no makeup gain 

included. 
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Dynamics 2: Gate 

Gates can be keyed by a different signal by pressing the key button below the attack rotary. This brings up a 

Gate Key Route display from which a key input can be selected. Consecutive channel gates can be keyed by 

consecutive input signals using the ripple channels function. The key button is ringed red and displays the key 

input in the text box to its right to indicate that another signal is keying the gate. The key input signal can be 

auditioned by pressing the key listen button underneath the range rotary. 

There is a band-pass filter available: the width control adjusts the width of the band being passed, and the freq 

control moves that band through the frequency range. The hi- and lo-pass sidechain filter frequencies are 

displayed. To the right of the link button, there are red, amber and green status indication 'traffic lights'. 

 

Dynamics 2: Ducker 

The ducker has the same controls as the gate, though the sidechain performs the opposite function of ducking 

the signal rather than gating it. 

 

Dynamics 2: Compressor 

Module 2's compressor is identical to the single band mode of Module 1, with the addition of the band-pass 

filter in the sidechain as described above, and a sidechain input function (S/C) which functions exactly like the 

key function of the gate. 
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1.7  Mustard Channels (Quantum only) 
Mustard channels are a feature of Quantum engines and work alongside standard SD channel strip processing, 

with both being available at once.  

Mustard provides a tube/preamp modelling section, an EQ, a compressor with four different models and a 

gate/ducker.  

The maximum number of simultaneous Mustard instances available is dependent on the model of console. In 

System > Diagnostics > Engine, there are two counters to display the amount of Mustard Channel Processing 

currently in use and the amount remaining.  

A channel is counted as having Mustard processing active once any one of the Mustard modules are turned on. 

When this is the case, the channel will display the ‘Active’ icon above the Mustard processing icon, as shown 

below. 

 

1.7.1  Mustard Channel Strip 

The Mustard channel strip layout and operation is similar to that of the SD channel strip, as shown below. 
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1.7.2  Insert Position 

There are 5 selectable positions to choose from when enabling Mustard processing on a channel. 

The default position for Mustard processing is between the EQ & Dynamics module (depending on the 

EQ/Dynamics order). 

Two options will be unavailable as these are the locations of the channel’s Insert A and Insert B. These insert 

positions can be selected for the Mustard processing by changing the location of Insert A/B, at which point 

they become available. 

 

1.7.3  Safes/Scopes 

Each Mustard module (tube, EQ, dynamics) can be safed individually, with the tube safe including the insert 

position of the Mustard processing. 

The global scopes follow SD processing with tube under input/trim, EQ under EQ and the compressor and gate 

under dynamics. Input/trim scope also includes the insert position of Mustard processing.  

1.7.4  Presets 

Channel presets can be created as normal and each Mustard module can be included or excluded in the recall 

scope. 

Recalling a preset from within the view of a particular module will include only that module in the recall scope 

by default. 

The insert position of the Mustard processing is included within the pre-amp scope. 

 

1.7.5  Pre-amplifier Modelling 

The Mustard pre-amp modelling section provides the user with a choice of either a simple tube model or a 

more advanced pre-amp model. This is chosen by selecting type, where a menu will display with the two 

options. 

 

This comes after channel trim and before channel 

delay/DiGiTube 

This comes after the channel’s fader 

This comes after processing and before the mute & fader 

This comes in between EQ & Dynamics 

This comes after filters and before EQ/dynamics 
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Mustard Tubes 

Mustard Tubes has a drive control, an output gain control, an on/off button and six selectable preset options. 

 

Odd harm – This is a modern sounding, low gain distortion preset 

Even harm – This is a vintage sounding, medium gain distortion preset 

Overdrive – This is modern sounding, medium gain distortion preset 

Distortion - This is modern sounding, compressed, high gain distortion preset 

Crunch – This is a vintage sounding, high gain distortion preset 

High distortion – This is a modern, heavy sounding, very high gain distortion preset 

Mustard Amp Model 

The Mustard Amp Model is a two-stage, highly customisable distortion & overdrive processor. 

Both stages can be switched to odd or even harmonics independently of each other. Even harmonics can 

create a triode-style distortion whereas odd harmonics can create a pentode-style distortion. 

The drive control alters the input level to the first stage of distortion. 

A bias control between the two stages can create asymmetrical distortion if desired. The midpoint value of 11 

is the most transparent. Turning on the ‘saturate’ option increases the effect of the bias setting.  

There is a high frequency boost after both stages which applies a shelving boost above 6kHz. This is followed 

by the output gain. 
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1.7.6  Mustard Equaliser 

Mustard EQ operates in a similar manner to the standard SD channel EQ, with four fully parametric bands.  

When used on a channel alongside the standard SD processing, this allows the user to have double the amount 

of fully parametric bands. 

The top and bottom bands can be switched to act as high and low shelf filters respectively, rather than bell.  

The middle two bands can be switched from bell filters to all-pass filters. 

There are also high-pass and low-pass filters (both 24dB/8ve). 

1.7.7  Mustard DYN1 & DYN2 

The Mustard channel strip gives the user a choice of four different compressor models, which are modelled on 

classic analogue compressors. 

All of the compressor types give the user an on/off button, a wet/dry mix knob, and an output gain control. 

Other controls vary depending on the type selected.  

The mix knob controls the balance between the wet (compressed) audio and the dry (uncompressed) audio. If 

it is set to 100%, there will only be the compressed signal at the output. 

On all but the Green FET Limiter, there is a threshold control, along with high and lowpass filters in the 

compressor’s side chain controlled by the low and high rotaries. The effect of the filters on the sidechain signal 

can be monitored by pressing the s/c listen button. 

An external sidechain, that is shared with the gate/ducker, can be used with the compressor by selecting a 

sidechain source in the box underneath the gate/ducker controls and then selecting to send it to the 

compressor sidechain. 

Classic - The Mustard classic compressor is a general-purpose feed-forward compressor design with multiple 

controls allowing flexibility.  

The threshold, attack time, release time, and ratio can be all controlled by the user. 

A hard or soft knee can also be selected, and the sidechain’s amplitude sensing can be changed between RMS 

(Root Mean Squared) level and peak (instantaneous) level. 

 

Vintage VCA - The Vintage VCA compressor models classic VCA compressors, with a fixed attack time and an 

auto-release time. The user can set the threshold and ratio. 
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Optical - The optical compressor models classic opto-compressors, with a unique release characteristic that 

models the gain reduction provided by an optical compressor circuit. It has three options for attack time and 

recovery time, along with a ratio control.  

The gain reduction also behaves uniquely by having a ratio-dependent maximum gain reduction value, with the 

compressor continuing to be linear above this value. 

 

FET Limiter - The FET limiter has a fixed threshold like many classic FET limiters, however the input and output 

gain knobs can be adjusted accordingly in order to achieve the desired output level and gain reduction. The 

attack and release values can be adjusted and the ratio can be set at either 4:1, 8:1, 12:1 or 20:1. 

 

Gate/Ducker - The gate/ducker works functions similarly to the gate and ducker found in the standard SD 

channel strip, however it has different attack and release shape characteristics. 

An external sidechain source can be selected, which can then be sent to the sidechain of the compressor 

and/or gate/ducker 

.  

Mustard Source Expander (V20xx+) - In Quantum engines running V20+ there is a new processor type in 

Mustard Dynamics 2 known as the Mustard Source Expander. 

 

The MSE reduces the level of a signal by a given amount when it is below a threshold. This works a bit like a 

gate but is better for non-transient signals, like vocals or brass. By reducing the level when the singer stops 
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singing, this can reduce the chance of feedback and generally reduce the level of stage noise spilling onto open 

mics. The controls available are threshold, depth (of up to 40dB) and release rate. There is also a sidechain 

available. 

Press the Type button and the Mustard Dynamics 2 module and select MSE from the list of options. 

1.8  LCD Functions 
The LCD button/display is located above the channel fader and is included in every channel in both the centre 

section and side sections of the consoles. The channel number is displayed in the top half and the current 

function mode of the button is displayed in the bottom half of the display and is also indicated by its colour.  

 

LCD buttons (SD5,7) or Select Buttons (SD8,9,10,11,12, Quantum consoles) are able to fulfil a number of 

different functions, and are even involved in selecting their own function. These functions are accessed by 

pressing the LCD function button, located above the bank buttons on each section of the desk. When this 

button is pressed, LCD displays for the channels associated with it turn yellow, indicating that they have 

become function mode selectors: 

 

Selecting one of these options assigns that function mode to the LCD/select buttons for all the channels within 

the banks associated with that lcd function button. There are twelve different function mode options. 

(1260+) The LCD function menu can be closed and have LCDs revert back to Solo function after a set period of 

time by turning on ‘Auto-revert LCD menu to solo’ and setting the duration in Options -> Surface.  
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1.8.1  Solo 

When an LCD function button is pressed, the left-hand LCD display is labelled SOLO. When SOLO mode is 

selected, the LCD/select buttons become solo buttons. The bottom half of the LCD display indicates which solo 

busses are available to the channel, as defined in the channel Setup display and the SOLO CHOICE function 

mode (described below). The display also shows whether each buss is AFL or PFL, as defined in the top-left 

corner of the master solo display. 

In SOLO mode, the LCD displays are coloured according to their channel type when not soloed, and coloured 

green when soloed. 

Note: this is the default mode of the LCD/select buttons, current when no other function modes have been 

selected. 

1.8.2  Solo Choice 

When an LCD function button is pressed, the second LCD display from the left is labelled SOLO CHOICE. When 

this mode is selected, the LCD/select buttons are used to select the solo bus assignment for that channel, 

toggling between 1, 2 and 1+2. In SOLO CHOICE mode, the LCD displays are coloured cyan. 

1.8.3  Gang 

When an LCD function button is pressed, the third LCD display from the left is labelled GANG. When this mode 

is selected, the LCD/select buttons are used for linking together all channel controls. All LCD/select buttons 

which are then pressed will have their controls linked. In the case of currently ganged channels, the LCD/select 

button can be used to remove them from their ganging group. The colour of the GANG symbols in the bottom 

left-hand corner of the on-screen channel display indicates what ganging groups exist: All faders which are 

ganged together will share one colour. Each time the GANG LCD function is selected, a new ganging group is 

started, as indicated by the GANG symbols turning a different colour. 

To gang channels across different surfaces of the console, activate the GANG LCD function on each surface 

before starting to build the gang. A single cross-surface gang can then be created using the LCD/select buttons 

in the usual way. 

To stop adding channels to the current gang and start a new gang, simply reselect the GANG LCD function. 

When channels are ganged together, operating any of their channel controls will cause all other channels 

within the ganging group to replicate that movement. Pan and phase controls are not included in gangs. 

Note: it is the level change associated with the fader movement which is replicated, not the physical 

distance the fader is moved. 

Note: that when a ganged channel is muted, those channels within the ganging group which were 

already muted will stay muted. When the channel is then unmuted, all channels unmute, irrespective of 

whether they had been initially muted. 

Note: that when any member of a gang is Assigned, the Undo function will always take the faders back to 

their position when the channel Assignment was made. Channels can be temporarily isolated from Gangs 

by pressing the Option button. 

Note: gangs cannot be edited once they have been created. 
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1.8.4  Join CG (Control Group) 

When an LCD function button is pressed, the fourth LCD display from the left is labelled JOIN CG. When this 

mode is selected, the LCD/select buttons can be used for assigning channels to Control Groups. Control Groups 

enable a number of channel output levels and mute functions to be controlled from one master fader. Control 

Groups can include any combination of channels from all four channel types. For more detailed information on 

Control Groups, please refer to the Master Section of this Manual. 

1.8.5  Assign Faders 

To assign channels to the worksurface, enter ASSIGNFADERS mode. The LCD displays will turn dark green and 

their lower halves will read ASSIGN. Press the LCD/select buttons for each of the channel strips to which you 

wish to assign new channels. 

 

 

To select the channels you wish to assign to those channel strips, open up the Channel List display, accessed by 

going to the master screen and touching Layout > Channel List. There you will find a list of all input, output and 

control channels that are present in the session structure, grouped by channel type. Open up the channel list 

for the channel type of the first channel to be assigned by touching the appropriate down arrow in the left-

hand column.  

The channel list can be scrolled using the scroll bar on the right of the display: To assign one of the listed 

channels to the channel strip, simply touch the channel name in the list. The remaining channels can now be 

assigned in the same way, the channels selected in the Channel List display are assigned to the selected 

channel strips in ascending order, starting with the lowest channel in the bank. 

Note: the assign function is restricted to the currently selected bank. 

Note: that when new channels are added to a session, or when a session is created, all of the existing 

channels can be assigned to the worksurface using the rebuild banks function within the Session Structure 

display. 

Press the LCD 

function 

button then 

ASSIGN 

FADERS 

Press the 

LCD 

buttons for 

assignment 

Go to Layout > 

Channel List on the 

Master Screen and 

expand the group of 

channels you want to 

assign and then click 

on the first channel 

you want to apply 
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1.8.6  Unassign Faders 

To remove channel assignments from a channel strip, enter UNASSIGN FADERS mode. The LCD displays will 

turn dark green and their lower halves will read UNASSIGN. Press the LCD/select button for any channel strip 

you wish to clear, and the strip will go blank. 

1.8.7  Swap Faders 

To swap the positions of two channels, enter SWAP FADERS mode. The LCD buttons will turn dark green and 

their lower halves will read SWAP. Press the LCD button for the two channels you wish to swap, and they will 

swap places. 

1.8.8  Move Faders 

To move channels within a channel strip, enter MOVE FADERS mode. The LCD buttons will turn dark green and 

their lower halves will read MOVE>>. Pressing any LCD button will result in that channel moving one space to 

the right. If the bank is full all channels to the right of the moved channel will move right, and any channel 

which had been occupying channel-strip 12 will be lost from the layout. If there is a blank channel strip 

anywhere to the right of the moved channel, any channels further right than the blank will not move, and the 

moved channels will simply fill the blank space. 

For example, if the bank is occupied by input channels 1 to 12, pressing MOVE>> on channel 6 will result in 

channels 6 to 11 moving one space to the right, leaving a space in channel strip 6, and channel 12 being 

removed from the layout. Pressing MOVE>> on channel 4 will then result in channels 4 and 5 moving one space 

to the right, filling the space that was in channel strip 6 and leaving a space in channel strip 4. 

When blank channels are moved they simply swap positions with the channel to their right. Note that any 

blank channels immediately to the right of the one being moved will move as well, and the blanks will move by 

as many channel strips as there are blank spaces being moved. 

For example, if channel strips 1 to 3 are blank and Input channels 1 to 9 are occupying strips 4 to 12, pressing 

MOVE>> on channel strip 2 will result in blanks 2 and 3 swapping places with Input channels 1 and 2. 

1.8.9  Copy Bank From 

To copy a different bank of channels to the current bank location, press COPY BNK FROM. The message ‘PRESS 

| A BANK | BUTTON | FOR | COPYIN | FROM’ will be shown across the LCD displays. Simply press the bank 

button for the bank which you want to copy to the current location. 

1.8.10  Copy Bank To 

To copy the current bank to different bank location, press COPY BNK TO. The message ‘PRESS | A BANK | 

BUTTON | FOR | COPYIN | TO’ will be shown across the LCD displays. Simply press the bank button for the 

bank to which you want to copy. 

1.8.11  Clear Bank 

To clear all channels from a bank, press CLEAR BANK. ‘The message ‘CONFIR| CLEAR| BANK:| YES| NO’ will be 

shown across the LCD displays. Press NO to cancel the action or YES to continue. 

Note: banks can be moved between layers, and also between sections of the console. 

Note: also, that the Fader Banks display on the master screen can also be used for altering the bank 

layout. 

Note: also, that there is no undo function for these actions. Proceed with care! 
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1.8.12 Create Multi 

The final LCD function, CREATE MULTI, is used to place new Multi channels onto the surface. When active, the 

LCD function buttons of any assigned faders will remain in their SOLO mode, whereas all unassigned faders will 

be available for creating new Multis. Once created, Multis can be configured in the normal way, as described 

below. 

1.9  Multi Channels 
If you are working in Surround, or using another multi-channel format, you can create LCR, LCRS and 5.1 busses 

in the Session Structure window described in Chapter 2. 

1.9.1  Creating a Multi 

Multi-channel inputs are controlled by routing each component through a mono channel and then linking 

those channels via a 'Multi' channel. To start with, use the normal input and output routing procedures to 

route each component through a channel. There are then two options for creating a Multi-channel: If you want 

to create the Multi in place of the channel strip for its first component, open the Channel Setup display for the 

first component and select Multi at the top. Alternatively, if you want to create a Multi in a previously 

unassigned location, use the CREATE MULTI LCD function described above. 

Whichever procedure you use to create the Multi and assign it to a fader, you will now be presented with a 

Setup Multi Channels display. Select the format – LCR, LCRS, 5.1 or multi-input (which allows you up to 11 

components) – and then press the LCD buttons for the remaining component channels, working down the 

displayed list in order. Channel names will appear against each component. Channels can then be left on the 

worksurface or removed using the buttons towards the base of the display. Finally, touch OK to close the 

display to link the channels together. 

 

OR 
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Multi’s can be unfolded in order to access controls for each component. This is done by pressing the Unfold 

button in the channel strip. When unfolded, the normal channel assignments are hidden, each component is 

given its own channel strip, and a Multi master channel is displayed to their left. 

Note: if leave (channels on the surface) was selected when the Multi was created, the component channel 

strips are available whether or not the Multi is folded. 

In the top section of the unfolded Master channel, buttons for each component channel allow you to define 

which channel's elements are displayed in the Folded View, if any Folded Controls are activated (see below). 

In the middle area of the unfolded Master channel, the links between component channels can be edited. Links 

function in the same way as Gangs, but are limited to the components of a multi-channel signal. To create or 

edit links, press the Set Links button so that it goes red, then press the LINK buttons below the channel names 

in the channels to be linked - each button will take on the same colour, indicating that they are linked. To 

remove a link, press the LINK button while Set Links is active. Note that if you start a set of links and then de-

link and re-link another channel, a new link set will be started, as indicated by the introduction of a new link 

colour. When you have finished linking channels, deselect Set Links. You can also clear all links and link all 

using the buttons below Set Links.  

Below the link buttons in the unfolded Multi Master, there are buttons for each element in the components' 

channels - trim & delay, filters & eq, dynamics and faders & mutes. Pressing one of these buttons will cause 

that element in all the channels to match those of the Folded channel. Once you have finished with the 

unfolded view, press the FOLD button to fold the channels back together. 

In folded view, the channels included in the Multi are shown in the middle of the Multi channel strip. Touching 

the Folded Controlbutton brings up four buttons which allow you to define which channel elements are 

displayed in the folded channel strip: Input, EQ, Dynamics and Aux Sends. These settings reflect the channel 

which has been set as the Folded View channel; the Folded View Channel is shown with a blue (as opposed to 

black) channel number in the list displayed in the folded channel, if any Folded Controls are activated. 

Adjusting any element in the Folded channel strip will affect all linked channels. 

Note: If channels have different settings when linked, changes in hidden, linked channels will be made 

relative to the change in the Folded View channel, but the display will only reflect the Folded View 

channel. 

Note: that activating the Aux Sends Folded Controls will result in the channel components list becoming 

hidden. 

The fader and mute on the Multi channel strip will always affect all of the Multi members irrespective of the 

link settings and thusserves as a “Master” fader and mute for that multi’s members. The on screen indicators 

for Channel Mute, Hard Mute and CG Mute at the bottom of the Multi strip give an indication as to whether 

any of the Multi members are Channel Muted, Hard Muted or CG Muted. If any member has any one of these 

types of mute active, the Folded Multi’s indicator will show this. 

In the Folded Multi view the worksurface Mute switch can have one of three different states: 

1) Not lit (OFF) - the Multi Master Mute is not active - unmuted. Note that if any channels are muted 

individually, the mute indicator below the unfold button will be red. 

2) Lit and red (ON) - the Multi Master Mute is active - muted. 
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3) Flashing from OFF to ON - the Multi Master Mute is active but at least one of the members has been 

unmuted (opened) thusoverriding the Multi Master Mute on one or more of the Multi’s Members. 

1.9.2  Edit Multi 

At the bottom of the Multi strip there is also an Edit Multi button which allows the members of the Multi to be 

changed or the Multi to be cleared or deleted. Pressing this button will open the Setup Multi Channels panel. 

To edit the members of the Multi, press one of the grey buttons on the left to select a member and then press 

one of the worksurface Channel Select buttons to assign a channel. To clear the Multi, press the Clear All 

button at the top of the panel and then either select a new type of Multi or delete the Multi completely by 

pressing the Delete Multi button at the bottom of the panel. 

 

  

Folded View Unfolded View 
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Chapter 2: The Master Screen  
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This chapter describes all of the functions accessed from the Master Screen. The chapter focuses on the 

functions of the menu buttons across the top of the Master Panel, working through the buttons from left to 

right. Master Section worksurface elements are described within the context of the Master Panel display. 

To open the Master screen, press the worksurface ‘master screen’ button (on relevant consoles).  

2.1  System Menu 

2.1.1  Diagnostics 

The Diagnostics displays status reports for various elements of the console system. 

Note: Indicators displayed may differ according to console model. 

 

2.1.2  Oscillator 

The oscillator is configured in the Oscillator display. 

 

The frequency of the oscillator is controlled by the left-hand frequency on-screen rotary, and its audio level is 

controlled by the right-hand level rotary. The buttons below each rotary, can be used to set the oscillator to 

standard frequencies (100Hz, 440Hz, 1kHz, 10kHz) and levels (-3dB, -6dB, -12dB, -18dB). The current value of 

each parameter is displayed below its respective rotary. 

For Stereo channels, the 1 kHz oscillator can be set to produce a pulsing ID signal on the left signal or a GLITS 

signal as indicated by the on-screen graphic. 
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2.1.3  GPIO Relays 

Selecting GPIO Relays opens a panel displaying the current GPI and GPO states. The panel will show the GPIO 

configuration for your console. The numbered 'out:' buttons allow GPOs to be triggered. If the toggle button 

above them is active (lighter), then touching a GPO button will switch it on (red) or off (brown). If the pulse 

button is active, touching a GPO button will send an 'on' pulse. 

Note: GPOs which are on when entering pulse mode will stay on. Touching them while in pulse mode will 

switch them off. 

The GPI event light in the top right-hand corner indicates when GPI messages arrive.  Below the GPO buttons is 

a row of indicators (labelled 'in:') showing the current state of each GPI.  

The GPI macro mode can be selected, either ‘ON and OFF’ to trigger a macro on both a low to high and high to 

low voltage transition or ‘ON only’ to trigger only on low to high transitions.  

 

2.1.4  Security 

Security modes are selected in the system menu, with a choice of three levels of access: 

Setup: Users have full access to every function on the console. 

Live: Access to elements of the console can be limited, and password protected. 

Unattended: The console worksurface is locked and cannot be operated. 

 

User passwords can be defined for the Live and Unattended modes. To set a password, press the Set Password 

button. Enter the old password then the new one twice and press OK. By default, the passwords are blank. 
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Note: If you should forget your password, call your Distributor to obtain a reset password. Entering the 

master override password will allow new passwords to be set. 

To modify restrictions in Live mode, press the Set Live Restrictions button in the Console Security Panel. A 

range of parameters are shown, with a tick indicating that access is allowed and a cross that the item will be 

locked out in Live mode. Each group list can be expanded for item-specific restrictions by pressing on the down 

arrow in the left-hand column, as shown for FX below: 
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2.1.5  Signal Over Indicators 

Pressing this entry in the System menu opens the Signal Overs panel, showing details of any signals which have 

peaked. Touching an entry in the Signal Overs list brings the channel to the surface to be adjusted. The Signal 

Overs panel also duplicates the Clear Over Indicators button. 

Note: The Signal Overs panel can also be set to open automatically when a signal peaks. This is done in 

the Status tab in the Options menu. 

2.1.6  Overview Clear Screen 

Some panels such as the information bar and the status indicators can be dragged with the trackball to an 

external overview screen. To quickly reset the position of these panels back to the Master screen, press the 

Overview Clear Screen button, and select Yes in the confirmation pop-up which appears. 

2.1.7 Clear Master screen 

[V1455+] A System Menu item and associated Macro “Clear Master Screen” has been added under the System 

Command Type.  This closes all the panels which can be opened by the user using the master screen menu 

buttons, except for the Snapshots/Cues panel. 

2.1.8  Keyboard Help 

The Keyboard Help button opens up a display detailing the console control elements which are available via an 

external keyboard (useful when using offline software): 

 

2.1.9  F10: Reset FX 

Pressing this entry in the System sub-menu will reset the FX module audio. This allows, for example, lengthy 

delay and reverb tails to be killed. To complete the reset, select Yes in the warning pop-up which appears. 

Note: This will briefly bypass all of the FX units. 
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2.1.10  F11: Reset Engine 

Pressing this entry in the System sub-menu will restart the audio engine 

Note: that this will briefly interrupt the audio - do not use this function unless absolutely necessary. 

2.1.11  F12: Reset Surfaces 

Pressing this entry in the System sub-menu will reset all of the worksurface controls. This function will briefly 

interrupt the audio on the Local I/O only.  

2.1.12 Reset Computer  

Pressing this entry in the System sub-menu shuts the console’s control computer down and restarts it. If the 

session is not saved, pressing Restart will bring up a warning display. Press Yes to restart without saving, or No 

to cancel the restart. 

2.1.13 Set Date & Time 

Pressing this entry in the System sub-menu will open the Date and Time window for the console's operating 

system. 

2.1.14 Enable Extensions 

Some SD and Quantum consoles can be upgraded to include a theatre mode (SD7, SD9, SD10, Q7, Q2) and a 

broadcast mode (SD7, SD9, SD10, SD11, Q5, Q7) which can be purchased from DiGiCo or an authorised dealer.  

Navigate to System > Enable Extensions, provide the dealer with your console’s license number and they will 

provide you with instructions on how to complete the upgrade. 

2.1.15 Quit to Windows/Home 

Pressing this entry in the System sub-menu quits the console software but leaves Windows or Quantum Home 

running.  If the session is not saved, pressing Quit to Windows/Home will bring up a warning display. Press Yes 

to quit without saving, or No to cancel the quit. 

2.1.16 Shutdown 

Pressing this entry in the System sub-menu shuts the console’s control computer down. If the session is not 

saved, pressing Shutdown will bring up a warning display. Press Yes to shut down without saving, or No to 

cancel the shutdown. 

2.1.17 Shutdown All 

When consoles, engines or remotes are mirrored together in Full Mirror or expander mode, an additional 

Shutdown All button will appear at the bottom of the system menu.  When pressed, it will shut down all 

SD/Quantum consoles or remotes which are in either Full Mirror or Expander mirroring modes. 
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2.2  Files Menu 

2.2.1  Templates 

Touching on Templates in the Files menu brings up the Session Templates display. This lists any ordinary 

session files which are located in the folder D:\Templates (or C:\Templates in offline), along with key session 

information. 

Note: If this folder doesn't exist, it should be created manually. The required template sessions can then 

be copied into it.  

[V1455+] A Save as template option in the Save as New File panel allows the user to save the entire 

session as a single template, the session template is saved into the templates folder, subsequent saves 

using the save session button or macro will save changes into the sessions folder not the templates folder. 

 

To load a Session Template, simply select it in the list and touch the Load button. 

2.2.2  Session Structure 

Touching on Session Structure in the Files menu brings up the Session Structure display. This is where a 

session is named and where the channel allocation and sample rate for the session are configured. While 

changes to session structure can be made once a session has been started, it is best to try and set these 

parameters before configuring the session. Session Structure changes are not implemented until the 

Restructure button in the bottom right-hand corner of the display is pressed. 

To name the session, touch the session title box, type the session name using the either the on-screen or 

external keyboard, and press OK. 

Set the Session sample rate at the top of the panel. 
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Below the session title, each channel type has its own setup row, which includes clear all and auto-route 

buttons, and a display of the current number of channels in the session. To adjust any of the channel 

allocations, touch on the associated channel count box, and either enter a number using the pop-up number 

keypad or adjust using the assigned touch turn controller. 

On some consoles, the matrix inputs, matrix outputs and control group allocations are fixed.  

For specific console model information, please refer to Configuring Session page in the Getting Started Section. 

Note: That processing channels are reserved for the master buss, talkback channel and stereo solos. 

 

The above figure shows the SD7 Session Structure Panel. Pressing the Default All button followed by the 

Restructure button will automatically configure a new session where the inputs from Audio I/O Port 1 are 

routed to input channels and the Master Buss is routed to Local outputs 1 & 2, also to Port 1 rack outputs 1 & 

2. All input channels will be routed to the Master Buss and the console headphones will be fed by the Master 

Buss when nothing else is soloed. 

If the clear all button is pressed, any non-default routing or processing (EQ, dynamics etc) will be cleared from 

the channels in the session when the Restructure button is pressed. This is especially useful when restructuring 

an existing session to make a new session. 
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The auto-route button automatically routes the physical inputs and outputs in the rack to the inputs and 

output channels in the session when the Restructure button is pressed, thus saving the operator from 

manually routing them in the channel Setup and Output displays. For example, auto-routing 48 inputs will 

route the first physical input (e.g. 1: Mic 1) to input channel 1, the second physical input (1: Mic 2) to input 

channel 2 until you either run out of inputs or channels. Auto-routes are as follows: 

- Input Channels auto-route with physical inputs 

- Aux, Group and Matrix Channels auto-route to physical outputs 

- Matrix Inputs auto-route with group outputs 

Note: Auto-routing can only be used in conjunction with the Clear All button and is not available for input 

channel direct outs. 

Important Note: Auto-routing overwrites any previous input and output routing. 

Note: The outputs of Aux, Group and Matrix channels are auto-routed in sequence: Aux outputs followed 

by Group outputs, followed by Matrix outputs. 

The send point for input channel direct outs can be set globally using the direct sends button toward the top 

right-hand corner of the display. The button is made active by touching the input channels Clear All button. The 

direct sends button then toggles between Post-Fader, Pre-Fader and Pre-Mute. 

Similarly, the send point for aux channel outputs can be set globally using the aux sends button to the left of 

the direct sends button. The button is made active by touching the aux busses Clear All button. The aux sends 

button then toggles between Post-Fader, Pre-Fader and Pre-Mute. 

Aux and Group Order 

By default, the aux and group channels are ordered with the stereo channels following the mono channels. 

These orders can be altered in the Order of Aux Busses and Order of Group Busses displays, accessed by 

pressing the Aux Order and Group Order buttons on the right-hand side of the display. 

Busses can be added using the buttons in the top-right of the display. To change a busses position or delete it, 

touch the buss in the display’s list and use the buttons in the bottom-right of the display. 

Note: that only the mono/stereo format of the Busses and their display within the input channel can be 

reordered in this display. Channel settings are not reordered. The console layout can be reordered using 

the Rebuild Banks function described below. 

(1272+) Channel Order As with aux and group order, channels can be reordered in the session structure panel 

where mono or stereo channels can be quickly added, deleted or moved.  

The Master buss is the first of the largest buss type (or first stereo buss on SD7/Q7), regardless of the order you 

place the busses in. 

The audio i/o and comms rows beneath the standard channel-type rows allow the settings of the audio io 

cards and talkback function to be reset. 

The clear snapshots and clear macros buttons towards the bottom-right of the window can be used to clear 

any existing snapshots and macros when making a new session. 
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Rebuild Banks: When changing the number of allocated channels in any section (input channels, busses etc), 

you can restructure the session without rebuilding banks, meaning that any additional channels you have 

allocated will not be “placed” on the worksurface, and need to be manually assigned to faders.  If, however, 

you restructure a session with Rebuild Banks (either Horizontally or Vertically) enabled, the worksurface will 

be built with all channels available on the worksurface in a default layout. Rebuilding horizontally will result in 

input channels being spread across the top layer of both sides of the console, using as many banks as required, 

with output channels being assigned to Layer 2. Rebuilding vertically will result in input channels being 

assigned to Layer 1 on the left side of the console, and output channels to Layer 1 on the right. See the Session 

Structure section of Chapter 3 for more details. 

Note: that when Rebuild Banks is used, any non-default configuration of the channel layout is lost. 

To implement changes in the Session Structure display, touch the Restructure button in the bottom right-hand 

corner. To exit the display without implementing the changes, touch Cancel, located below the Restructure 

button. 

To clear unimplemented changes from the display, touch REVERT, located in the top left-hand corner of the 

display. 

2.2.3  Load Session 

Touching this entry in the File menu opens the Load Session display. The left-hand column of the display shows 

the file directory. At the top of the directory are two buttons which switch the list of folders below them 

between the contents of the console computer’s internal d:\Projects folder and the contents of a removable 

USB drive. Each folder can be expanded by clicking the + symbol to its right. The list can be scrolled using the 

scroll bar to its right. 

When a folder or sub-folder in the left-hand directory is expanded, a list of the session files contained within it 

appears in the list in the centre of the screen. The list displays the Filename, creation Date & Time, and 

Description of the session. In addition, the list also displays the number of Inputs, Auxes (mono, stereo), 

Groups (mono, stereo) and Matrix channels (ins/outs). 

To load a session, touch the session in the list and press Load, located in the bottom right-hand corner of the 

display. To close the display without loading a session, press Cancel, located below the Load button and also 

found in the top right-hand corner of the display. 

Once a session is loaded, a summary of the currently loaded session is displayed in the Information Bar which 

is normally found on the Master screen. Once any changes have been made to the session, the File: indication 

in this display will only show the folder of the most recently saved session, not the file name. 

When active, keep old presets will add any existing console presets to the session being loaded.  When 

disabled, existing presets will be cleared before session load. 

Note: If any of the buttons in the right-hand column of the window are active, sessions cannot be selected 

for loading from the list. 
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Note: that column widths can be adjusted by dragging their borders within the title row. To return all 

columns to their default widths, press RESET WIDTHS, in the top left-hand corner of the window. 

Partial Load 

When a session file is selected from the list, the Partial Load button becomes available in the top right corner 

of the panel. Pressing this button opens the panel shown below where elements of the session can be selected 

for Partial Loading. Possible selections include ranges of Input channels, Matrix inputs, Matrix outputs and 

Graphic EQs, banks and layout, Presets and Macros. 

There are also options to Partial Load all or some of the Snapshots from the selected session. 

Replace Snapshots will remove the existing Snapshot list and replace it with the partially loaded one. 

Add Snapshots will open a Snapshot list where snapshots can be selected to be imported into the existing 

session. 

Note: that if Snapshots are imported that contain data that the existing session is not capable of recalling 

(e.g. channels that don't exist) then this data will be ignored when the Snapshot is recalled. 

The numbering of imported Snapshots will be the same as their original numbers so there may be 

duplication in Snapshot numbers after the import. 

Select a file File details 

Select Internal or 

removable USB, Internal 

files saved in D:\Projects  
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2.2.4  Save Session 

Touching this entry in the File menu saves the current session. Once the session has been saved, a confirmation 

pop-up appears displaying the location of the saved session file. 

Note: This function overwrites the most recently saved session. If you want to retain the most recently 

saved session, save the current session as a new session. 
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2.2.5  Save As New File 

Touching this entry in the File menu opens the Save Session display. At the top of the display are two text 

boxes showing a file name and session title. The file name will normally be ‘sessionxxx.ses’ where xxx is an 

auto-incrementing number and the session title is the same as the current session. If the session has not been 

changed since it was last saved, the file name will be the same as the current session. To edit the file name and 

session title, touch the relevant text box, enter the new name or title in the on-screen or external keyboard, 

and press OK. To overwrite another session, or to save the session in a new folder but with a previously used 

name, touch the session of that name and its name will appear in the file name box. 

The location of the session file to be saved is defined in the directory in the left-hand side of the display. At the 

top of the directory are two buttons which switch the list of folders below them between the contents of the 

console computer’s internal d:\Projects folder and the contents of a removable USB drive. Each folder can be 

expanded by clicking the + symbol to its right. The list can be scrolled using the scroll bar to its right. Touch the 

button and folder within which you want to save the session. 

To create a new folder, select the location for the folder in the way described above, touch the new folder 

button in the right-hand side of the display, type the folder’s name using the external keyboard and press the 

external keyboard’s return button. To rename a folder, touch the folder within the directory, touch the rename 

folder button in the right-hand side of the display, type the folder’s new name using the external keyboard and 

press the external keyboard’s return button. 

To delete a folder, touch the delete folder button in the right-hand side of the display, touch the folder to be 

deleted and touch Yes in the confirmation pop-up which appears. 

Note: This action cannot be undone. 

Once the session has been named and its save location has been selected, save the session by pressing Save, 

located in the bottom right-hand corner of the display. To close the display without saving, press Cancel, 

located below the Save button and also found in the top right-hand corner of the display. If you attempt to save 

the session under a file name which already exists within that folder, a pop-up appears, warning that 

continuing will cause the file with that name to be overwritten. Touch Yes to continue, No to cancel. 

Note: Overwriting the most recently saved session can be performed more quickly using the Save Session 

function described above. 

Once the session has been saved, a confirmation pop-up appears displaying the location of the saved session 

file. 

To rename a file, touch the file to be renamed followed by rename file, located in the right-hand side of the 

display, enter the new name into the on-screen or external keyboard and press OK. If rename file is pressed 

without a file being selected, the first file in the list will be automatically selected for renaming. 

Note: The file name is the only file element that can be edited once the file has been saved. 

To delete files, select the folder containing the files to be deleted and touch delete files. To delete all files in 

the folder, touch select all, followed by confirm delete. To delete one file or a selection of files, touch the files 

you wish to delete followed by confirm delete. To delete a consecutive range of files, touch select range, touch 

the first and last files included in the range to be deleted, and touch confirm delete.  To complete the deletion 

process, touch Yes in the confirmation pop-up which appears. 
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[V1455+] A Save as template option allows the user to save the entire session as a single template, the session 

template is saved into the templates folder, subsequent saves using the save session button or macro will save 

changes into the sessions folder not the templates folder. 

 

Note: Column widths can be adjusted by dragging their borders within the title row. To return all columns 

to their default widths, press RESET WIDTHS, in the top left-hand corner of the window. 

Set Backup 

Located on the right-hand side of both the Load Session and Save as new file panels, are the Set backup and 

Copy Backup Buttons.  The backup function enables batch copying of session files to and from a connected 

removable drive.  Press the set backup button and touch on the session files to copy to/from the removable 

drive. Once selected, an asterisk will appear in the "B" column of the panel.  Now press the copy backup 

button and after the confirmation stage, the selected session files will be copied to/from the removable drive. 

Note: The Copy Backup button will not be available until a valid removable drive has been connected to 

the console's USB port. 

  

Enter file name 

Select Internal or 

removable USB, Internal 

files saved in D:\Projects  

 Enter description  

Save As 

Template  
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2.2.6  Load Presets 

Touching this entry in the File menu opens the Load Presets display. This allows Channel, FX, Graphic EQ and 

Matrix presets created in other sessions to be imported into the current session. The left-hand column of the 

display shows the file directory. At the top of the directory are two buttons which switch the list of folders 

below them between the contents of the console computer’s internal d:\Projects folder and the contents of a 

removable USB drive. Each folder can be expanded by clicking the + symbol to its right. The list can be scrolled 

using the scroll bar to its right. 

When a folder or sub-folder in the left-hand directory is touched, a list of the Preset files contained within it 

appears in the list in the centre of the screen. The list displays the Filename, creation Date & Time, and 

Description of the preset file. In addition, the list also displays the number of Input, Out (fx), GrEQ (Graphic 

EQ) and Matrix presets contained within the preset file. 

To load a set of presets, touch the preset file in the list and press Load, located in the bottom right-hand corner 

of the display. To close the display without loading a session, press Cancel, located below the Load button, also 

found in the top right-hand corner of the display. 

Note: A session’s presets are also saved as part of the session file. 

Note: If any of the buttons in the right-hand column of the window are active, sessions cannot be selected 

for loading from the list. 

2.2.7  Save Presets 

Touching this entry in the File menu opens the Save Presets display. At the top of the display is a text box 

showing the file name of the most recently created presets file. It will normally be ‘presetsxxx.pre’ where xxx 

is an auto-incrementing number. To edit the file name, touch the text box, enter the new name or title in the 

on-screen or external keyboard, and press OK. To overwrite another file, or to save the file in a new folder but 

with a previously used name, touch the file of that name and its name will appear in the file name box. 

The location of the presets file to be saved is defined in the directory in the left-hand side of the display. At the 

top of the directory are two buttons which switch the list of folders below them between the contents of the 

console computer’s internal d:\Projects folder and the contents of a removable USB drive. Each folder can be 

expanded by clicking the + symbol to its right. The list can be scrolled using the scroll bar to its right. Touch the 

button and folder within which you want to save the session. 

Once the presets file has been named and its save location has been selected, save it by pressing Save, located 

in the bottom right-hand corner of the display. To close the display without saving, press Cancel, located below 

the Save button, also found in the top right-hand corner of the display. If you attempt to save the set of presets 

under a file name which already exists within that folder, a pop-up appears, warning that continuing will cause 

the file with that name to be overwritten. Touch Yes to continue, No to cancel. 

Note: A session’s presets are also saved as part of the session file. 
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2.2.8  Global Set to Defaults 

The Global Set to Defaults Panel, opened via the Files menu, allows certain settings to be applied globally to 

the console. Select the Channel type from the list on the left side of the panel, and then select the action from 

the list to the right. Most actions are self-explanatory, with the possible exception of the following: - blend LR 

only moves all the LR/LCR blend controls to LR.  

- blend LCR moves all the LR/LCR blend controls to LCR 

- groups off unroutes all sends to Groups 

Note: that multiple channel types can be selected simultaneously. 

 

The undo button in the top left undoes all changes since the panel was opened.  

Note: Once the panel is closed, changes cannot be undone. 
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2.2.9   Session Notes 

The File menu Session Notes button opens a panel in which can be used for saving any important session 

information: 

 

2.2.10 Session Report 

In the Files menu there is also a Session Report button.  This lists the session details on the master screen in an 

RTF compatible format. 

Across the top, the three include buttons can be used to define what optional extras are included in the report: 

channels, audio i/o and snapshots. 

The save to internal button at the top right of the panel will save the report in the D:\Projects as the session 

file name suffixed with .rtf. The save to removable will save the report to any USB drive insert in the consoles 

USB port. 
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2.3  Layout Menu 

2.3.1  Fader Banks 

Note: Not all the functions described in this section are available on all console models. The example 

below represents the full set of functions from an SD7. 

Touching on Fader Banks in the Layout menu brings up the Fader Banks display. This display allows the location 

of each fader bank to be altered. The bank buttons available within each layer of each section of the desk are 

displayed with their current fader set, with the left and right section banks on the left and right and the master 

banks down the middle. Towards the bottom of the display there are several grey function buttons which turn 

red to indicate that they have been selected. 

 

To swap the locations of two fader sets, touch one set’s bank so that it is highlighted in yellow, touch swap 

(located below the left fader bank’s layer 1) and touch the other set’s bank. 

To move a fader set to a new bank location, highlight the fader set you wish to move, touch move (located to 

the right of the swap button) and touch the bank to which you wish to move it. If there is currently a fader set 

in the destination bank, the current fader set will shift down one, as will any other sets below it until there is a 

blank bank which can be filled. If a fader set located in the lowest bank of a layer is shifted down, it will move 
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to the first bank of the next layer. If there are no spaces between the selected destination bank and the end of 

the console section, a pop-up appears indicating that the move cannot be completed. 

To copy a fader set to a new bank location, highlight the fader set you wish to copy, touch copy to (located to 

the right of the move button) and touch the bank to which you wish to copy it. If there is currently a fader set 

in the destination bank, it will be overwritten. 

To clear a bank, highlight the fader set you wish to copy, and touch clear (located below the copy to button). 

Banks can be protected from being accidentally cleared by locking them: Touch the bank you wish to lock and 

touch lock (located below the clear button). On SD7, the lock button will turn light grey whenever a locked 

bank is highlighted. All banks can be locked by pressing the lock button to the right of the all: legend, 

underneath the right fader banks in the display. 

Note: Locked banks can still be moved and overwritten. If a locked bank is moved, the lock function stays 

with the fader set, not the bank location. 

The labelling within the bank LCD buttons can be edited using the text boxes in the bottom left-hand corner of 

the display. By default, the top row of the button displays a short version of the channel type (Ch for input 

channels, Aux for aux channels, Grp for group channels, Matrix for matrix channels and CG for control group 

channels) followed by the channel number range, and the bottom row displays the channel type in full. To edit 

the either row, touch its text box, type in the new name using the onscreen or external keyboard and press OK. 

The keyboard symbol to the right also activates the naming function for the top row. 

Note: This label affects the bank button displays, not the channel faders within the bank. 

On an SD7, the colour of the bank LCD buttons can be altered using the button colour buttons in the bottom 

right-hand corner of the display. By default, the LCD buttons are coloured to match the colour of their channel 

type: Light blue for input channels, purple for aux channels, red for group channels, light-green for matrix 

channels and dark blue for control group channels. The arrow buttons either side of the button colour legend 

can be used to cycle through the available colours, and the current colour selection is displayed in between 

them. 

Note: All of the default channel type colours are available for all bank buttons. 

The SD7's upper and lower master meter bridge rows can be locked to any of the eight banks on the master 

screen. This is done by pressing the upper meters and/or lower meters button which appear in the lower right-

hand corner of the Fader Banks panel when a master bank button is selected. The master bank button will 

become outlined in red to indicate that it is locked to a row of the bridge. 

Fader layer names can be customised on SD12, Q2, Q3, and Q7.  These names will be displayed on the fader 

bank layer LCD displays.  



SD & Quantum Software Reference Manual  2.3 Layout Menu  

 

SD5, SD12 & Q3 re-assignable master faders 

In the fader banks display, the left and right master faders can be reassigned and un-assigned to any channel.  

2.3.2  The Overview Display 

A miniature graphic of each fader set can be displayed on the master screen, or on a separate screen 

connected to the Overview output on the back of the console. These graphics display the fader position, mute, 

solo status and insert status, and the meter for the channels within all displayed banks. The parameters 

displayed in this overview can also be adjusted on the overview screen using the external mouse. The on 

overview and on master buttons, located below the Fader Bank display’s master banks, are used to include 

and exclude fader banks from the external overview display and the master panel respectively. All banks can be 

included in the overview display by pressing the overview button to the right of the all: legend, underneath 

the right fader banks in the display. 

(1272+) A larger version of any bank overview graphic can be displayed on the master screen or an overview 

screen by pressing the large button under “view bank” after the bank has been selected. The standard size 

overview can still be displayed by pressing the small button. Faders and other controls on the large bank 

overview graphic can be controlled by touch.  

All banks can be displayed on an overview screen at either small or large size by pressing the respective 

buttons next to “all:”. Note that this will remove all bank overviews from the master screen. The small 

overview or large overview buttons will be lit red to indicate that all the banks are displayed in this size on an 

overview screen. To remove all bank overviews from an overview screen, press this button again.  

 

Type custom name in text box for 

each layer 
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2.3.3  Channel List 

Touching on Channel List in the Layout menu brings up the Channel List display, containing a complete list of 

all the input, aux, group, matrix and control group channels which exist within the session. The channel list for 

each channel type can be expanded and collapsed by touching anywhere in the channel type row. Channel 

type rows can be distinguished from the specific Channel rows by their slightly darker colour. 

 

If the Edit button at the base of the display is active (lighter), touching a channel will allow the name of that 

channel to be changed, the up/down arrows can be used to change multiple channels names in quick 

succession. Touching the main input, alt input, insert A, insert B, groups or outputs box for a channel will 

open up the appropriate Setup or Routing panel for that channel, allowing that routing to be edited. Touching 

the safe box will cause all of that channel's safes (and those of any linked channels) to be activated. 

If the Select button at the base of the panel is active, the display can be used for adjusting the bank 

assignments of the session’s channels. This function employs the ASSIGN FADERS LCD function mode. The 

channel's current assignment is shown in the layer/bank box: The surface (L or R; Master fader assignments are 

not shown), layer (L) and bank (B). 

Note: When new channels are added to a session, or when a session is created, all of the existing channels 

can be assigned to the worksurface using the rebuild banks function within the Session Structure display. 

In Select mode, the display can also be used for assigning a channel to the worksurface controls. This is done 

by touching a channel within the list and also results in the channel’s bank being displayed in the appropriate 

side section of the console. If the channel appears more than once within the session layout, the lowest bank 

in which it appears is the one which will appear on the worksurface. 
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With either Select or Edit active, touching in a channel's meter box will cause a small meter panel for the 

channel to be displayed in the Master screen. This is meter display remains active regardless of whether or not 

the channel itself is currently on the worksurface. It is possible to permanently display up to 12 channels in this 

way. Pressing the View button at the bottom of any of these meters also allows them to be snapped to a grid, 

sized to either large or small, removed, and moved between the Master screen and Overview screen. 

Touching channel can be used to change the name of channels. Using the up/down arrows on the keyboard, 

channels names can be changed in quick succession. 

(1272+) Channels can be scrolled up and down using the arrows on the Channel Setup and Outputs Panels.  

 

The most recent Preset used on the channel is also displayed, in the last preset box. 

2.3.4  Set Spill 

Touching on Set Spill in the Layout menu brings up the Set Spill display, where channel Sets can be configured 

and spilled onto the console. A Set is simply a group of channels selected from across the console's layers, 

which can be 'Spilled' onto the worksurface together. They can be made up of a mixture of channel types and 

need not have anything else in common. The main part of the display is navigated in the same way as the 

Channels List described above. 

To create a Set simply choose a Set column and touch the boxes in that column for each channel you wish to 

include, expanding the channel types as required. The boxes will all turn the same colour. The box in the 

channel type's parent rows will also turn the same colour, indicating that some channels of that type are 

included in the Set. the number of channels included in the Set is shown in the Set's Spill: box, above the 

channels display. Any channels which are included in a Gang are indicated by the Gang's colour being displayed 

on the right-hand edge of the channel's number box (at the left end of its row in the channel display). 

To rename a Set, touch on its Set Name: box, type a new name on the on-screen or external keyboard, and 

press OK. To add all channels from a Control Group, touch the Set's Add from CG: box and touch the 

appropriate CG button from the popup which appears. The Spill: number will increment to indicate how many 

channels have been added. To clear a Set, touch its Clear: box and touch Yes in the confirmation pop-up which 

appears. 

Sets can be spilt directly from this panel or assigned to a Macro. To spill a Set from this Panel, touch its Spill: 

box. A tick will appear by the spill number to indicate that the channels are spilt. To assign the Set Spill to a 

Macro, touch the Set's Assign Macro: box to bring up a display of the console's Macro controls; Now select a 

Macro button. The Macro's bank and position will be displayed in the Set's Assign Macro: box. 

The Set Spill Direction entry in the Faders tab of the Options menu defines how Sets are spilt onto the control 

surface. Sets can be unsplit by pressing their Macro or Assign Macro: box, or by pressing the Layer button for 

the console section where the set is shown. 
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      The SD7 Set Spill panel 

2.3.5  Aux to Faders 

This panel displays every aux buss in the current session and touching the buss will activate aux to faders. 

Macros are available for the additional panel controls. 

(1272+) The Aux selection can be cleared when this panel is closed by pressing the clear on close button.   

 

2.3.6  Aux Nodes  

See Chapter 1 

2.3.7  Join Groups      

Touching on Join Groups in the Layout menu brings up the Join Groups display, containing a list of channel sets 

and a list of groups. Selecting individual or multiple groups allows individual channels or sets of channels to be 

assigned to those groups. To assign channel sets select the desired set from the list of sets, to assign individual 

channels use the LCD buttons of the desired channels. 

(1272+) The join group function can be cancelled when this panel is closed by pressing the cancel on close 

button. 
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2.3.8 AMM Control (Consoles with DMI slots) 

The DMI-AMM card automatically manages live microphones in unpredictable dialogue situations. When one 

person speaks, that microphone’s gain level fades up instantly, while the other microphone gains are reduced. 

All microphone levels will adjust to medium gain to collectively match the level of one microphone at full gain. 

The resulting effect will be as if all speakers are sharing one microphone. When several people talk at once, the 

gain is shared.  

Access to the AMM Controls (Figure 1) can be found in the Audio I/O window after conforming the DMI card 

(Figure 2 & 3) or by using the Master Screen > Layout > AMM Control button 

The AMM Controls include a weight control and a group assign (Group A & Group B) for each AMM group for 64 

slots within the card. The Floor control imposes a lower limit on the level detector for all microphones in the 

relevant AMM group to prevent a noisy microphone capturing a disproportionate share of gain. The weight 

should be left at the default value of 0dB and floors should be left at -130dB for normal operation.  

 

There are two ways to route channels to/from the AMM. The first is from within the AMM Control window 

itself. Touch the white box below each of the slots, this will open the AMM Routing window (Figure 4). Here 

you can ripple route channels to the AMM. The AMM is automatically assigned a Post-Fade Insert B. The AMM 

routing/assignment can also be ripple cleared and this will also force all insert Bs back to pre-fader mode 

regardless of its state prior to AMM assignment. It can also be assigned using the Insert B routing window, 

available by touching the bottom of a channel strip (Figure 5).   

NOTE: The SD12 only provides a maximum of 32 Post-Fade Inserts but the AMM channels can also be routed via 

Pre-Fade Insert points if required. The Quantum 7 provides Post-Fade Insert options on all Input Channels. 

Figure 2: Conform AMM 
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Figure 3: Open AMM Control 

Figure 4: Routing Within AMM Control 

Figure 5: Routing via Insert B Routing Menu 
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When channels are routed to the AMM and assigned to AMM group A or B, a Share % bar is displayed in yellow 

on the right side of an AMM slot. This represents the gain Share that the channel is getting when the AMM is 

active. This meter is shown in terms of percentage, meaning that if 2 speakers are talking at the same time and 

at the same level then they will both get 50% of the gain share. The Weight control allows adjustment of the 

relative sensitivity on a per channel basis. When weighting controls are balanced (equal), each microphone has 

an equal opportunity to “take over” the system. Changing the weight will not have an effect on the overall level 

of the channel, just how easily it can take a share of the gain. Adding weight to one primary microphone ensures 

that the particular microphone (e.g. a chairperson) will get more of the share of gain (Figure 6).  

 

 

There are a set of master controls available at the bottom of the AMM Control window. These include a Floor 

control and a master group enable (active) switch for each AMM group within the card and a safe control. The 

Floor control imposes a lower limit on the level detector for all microphones in the relevant AMM group to 

prevent a noisy microphone capturing a disproportionate share of gain during quiet times. The Floor should be 

left at the default value of -130dB for normal operation. The safe option excludes these floor controls and the 

master group enables from snapshots. 

All AMM parameters (both master and channel specific) are saved on a per snapshot basis and can be safed or 

removed from the global and recall scopes. Only input channels can be added to the AMM. It can be safed 

globally via the Input Devices option in the Global Scope menu on the Snapshots window. This is NOT enabled 

by default.  

 

Figure 6: AMM Share Percentage and Weights 

Figure 7: AMM Master Controls 

Figure 8: Global Scope > Input Devices 
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2.3.9 Transport Control 

Touching on Transport Control in the Layout menu brings up a display of the transport control of an external 

playback device. Playback devices are controlled via the MIDI connector on the console's back panel. The 

incoming MTC is also displayed. 

 

Note: Control of external playback devices can be programmed within the Snapshots screen, as described 

later in this chapter. 

2.4  Snapshots Menu 
Any number of Snapshots of the entire current console settings can be stored and recalled using the Snapshots 

panel. (This is only limited by system memory) 

These Snapshots can be independent or grouped with other snapshots. 

The recall scope of the snapshot (how many controls it will affect when fired) can be set by controller or by 

channel. 

To display the Snapshots panel, touch the Snapshots button at the top of the Master Screen. 

Worksurface controls are detailed in Getting Started. 

 

Note: The current snapshot appears in the panel as the highlighted entry in the list. The snapshot name 

displayed in green indicates that it is the selected snapshot on the worksurface and its name is indicated 

in the display. The Fire button recalls this selected snapshot and highlights it in the screen list as the 

current snapshot. 

Inserts new snapshot after selected 

(Green) snapshot 
Duplicates selected (Green) 

Updates current (Highlighted)snapshot 

Updates all members of Snapshot Group 

Updates selected (Green)snapshot 

Edit multiple snapshots after selection 

Allows changing of order of snapshot list 

 Press and select snapshot to rename 

Press to open Renumber panel 

Press and select snapshot(s) to delete 

Fires previous snapshot in list 

Fires selected (Green) snapshot 

Fires next snapshot in list 

Undo firing of last snapshot 

Activate snapshot fire by touching list 

Activate snapshot Auto Update 

Group Update Mode 

Opens Global scope panel 

Opens snapshot notes panel 
Adds current snapshot to group 

Lock prevents snasphot update 

Snapshot under control of sequence 

duration in recall times panel 
Removes snapshot from prev/next control 

Shows individual snapshot option buttons 

Opens individual snapshot recall scope 
Opens group/auto-update scope 

panel Opens snapshot crossfades panel 
Opens snapshot recall times panel 

Opens snapshot MIDI list 
Opens snapshot MIDI program change 

panel Opens snapshot GPO panel 
Opens snapshot transport control panel 

Opens control by MIDI panel 
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Note: An “update Waves only” button appears below the Scope buttons when Waves is active. 

If the current snapshot shows an asterisk next to the number (e.g. 001*) this indicates that a controller has 

changed since the snapshot was fired. 

If a Snapshot name appears in black in the list, it is a standard Snapshot and if it appears in red or blue then it 

is a member of a group of snapshots 

2.4.1  Storing a Snapshot 

When a snapshot is stored all the console settings are saved but when the snapshot is recalled its effect can be 

limited to certain channels and controllers using the Global and Recall Scopes. 

To store a snapshot of the current state of all the console controls, touch the Snapshot panel or worksurface 

Insert New button and a new snapshot will be inserted below the currently selected (green) snapshot. 

Alternatively, if the Touch to Fire function is active, touch an unused button in the list and a new snapshot will 

be added to the end of the list, then type a name for the snapshot. 

Another method of creating a Snapshot is to press the Duplicate Selected button and this will create a copy of 

the selected (green) Snapshot below it. 

Note: If Duplicate Selected is used, the Snapshot that is stored may not reflect the current state of the 

console's controls - it will simply create a copy of the Snapshot that was selected when the button was 

pressed. 

2.4.2  Recalling a Snapshot 

There are several ways to recall a snapshot: 

1. Activate the Touch to Fire function using the button on the Snapshot panel and then touch the 

snapshot button you require. 

2. The buttons on the Worksurface provide Scroll Up/Down buttons to change the selected snapshot 

named in the worksurface display and listed on screen in green.  

The Fire button then recalls the assigned snapshot. 

3. The worksurface Previous and Next buttons can be used to step up and down the list firing snapshots 

in consecutive order. 

4. Snapshot firing can also be controlled by specific events on MIDI channel 16 (See Snapshots and MIDI). 

5. Assign a Macro button to fire the Snapshot. 

2.4.3  Replacing a Snapshot 

To update or change a snapshot, set the console controls as required and then touch the one of the Update 

buttons (Current, Selected or Group) 

Note: The Current snapshot is not necessarily the one whose name appears in the display on the 

worksurface, this is the Selected snapshot. For a snapshot to be Current it must have been the last one 

that was fired and be highlighted in the on-screen panel's list. 
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2.4.4  Editing Multiple Snapshots 

Individual controller changes can be written to several snapshots simultaneously using the Edit Range button. 

This does not replace all of the data associated with the snapshot, just the elements that are changed at the 

time. 

 

When the Edit Range button is pressed, a panel pops up allowing you to Select Range, Select All, or select 

individual Snapshots. You can now select the relevant snapshot(s) from the list. 

 

If you press the Select Range button, touching the first and last snapshots in a range will automatically select 

all the snapshots in that range. 

Once snapshots have been selected for editing, press the confirm button, or press cancel to cancel the Edit 

Range button. 

 

With the Edit Range button active, pressing the Snapshot buttons does not fire the snapshots; it only selects 

them for editing. The selection may be changed by pressing and releasing snapshot buttons at any time during 

the operation of the Edit command, so a variety of controllers or routes may be changed in a variety of 

snapshots before completing the operation by pressing the Confirm button. The Snapshots window may even 
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be closed to gain access to other editable functions - In this case, a warning message will appear to advise the 

user that they are still in snapshot edit mode. While any Snapshot is selected, changes to any snapshottable 

controller, routing changes, and any changes to the Snapshot Scope controls can be written to every selected 

Snapshot, overwriting the previous settings. Pressing the Confirm button keeps the changes. 

For example, if Snapshots 1 and 2 are selected and the input gain for channel 1 is changed, subsequent recall of 

Snapshots 1 or 2 will set channel 1’s input gain to the new value. 

Only channels which are altered while the Edit command is active will be affected and only in snapshots that 

are selected at the time. 

Note: Snapshot Scopes and Crossfade Times can also be edited for multiple Snapshots using the Edit 

Range function 

2.4.5  Moving a Snapshot 

If you wish the Snapshot list to appear in a specific order, you may change the order of the list by moving the 

entries. Touch the Move button and then touch the Snapshot that you wish to move. You then touch the point 

in the list where the snapshot should be moved to. 

2.4.6  Renaming a Snapshot 

To rename a snapshot, touch the Rename button, then the name that you wish to change and enter a new 

name using the keyboard. 

2.4.7  Renumbering Snapshots 

As snapshots can be inserted at any point in the list you may find that you wish to renumber part or all of the 

list. 

Press the Renumber button at the bottom of the snapshots panel and a new panel will open. Enter the range 

that you wish to renumber using the touch turn control or by touching the entry and typing and then enter the 

steps to renumber to (1.00 is the default value). Then press the OK button and the list will be adjusted 

accordingly. 

2.4.8  Deleting a Snapshot 

To delete snapshots, touch the Delete button and then Select Range or Select All. If you have pressed Select 

Range, touch the Snapshots in the list that you wish to delete and then press Confirm. If you have pressed 

Select All, the complete list of Snapshots will be highlighted and pressing Confirm will delete all Snapshots. 

Note: To cancel a Delete operation before it has been confirmed, press the Delete button again. 

2.4.9  Snapshot Undo 

When a snapshot is fired, a separate hidden snapshot of the complete console is stored before the fired 

snapshot has its effect. If the Undo button is pressed, the hidden snapshot is fired using the same scope as the 

previously fired snapshot to undo its effect. 
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2.4.10 Snapshot Groups 

A standard Snapshot (black entry in the list) is an independent snapshot of the current state of all the console 

controls. A Snapshot can also be a member of a Group (red or blue entry in the list). Making Snapshots 

members of a Group allows all members of that Group to be updated together according to the Group Update 

mode that is selected. To make a Snapshot a member of a group, first select the groups button on the left of 

the snapshots panel. Create a group by pushing the new group button and then select the change members 

button. While the change members button is toggled, snapshots can be added or removed from the group by 

selecting them from the main snapshots panel. Once of the desired snapshots have been added or removed 

from the group, untoggle the change members button. 

If a Snapshot is a member of a Group, the colour of its entry in the list is determined by the current setting of 

the Relative Groups button in the bottom right of the Snapshots panel. This determines how the Group of 

Snapshots will be updated when Update Group is pressed. 

Red entry in the list = Relative Update mode selected 

Blue entry in the list = Non-Relative Update mode selected. 

Relative Group Update Mode (Red entries in the list) 

If Update Group is pressed when the relative groups button is active, all dB controls such as faders and aux 

sends will be updated relatively. This means that if a fader is moved by +10dB in one snapshot, the same fader 

will be moved by +10dB in all Snapshots that are members of the same group, irrespective of the original level 

of that fader. So +10dB will be applied to the stored level of that fader in all of the Snapshots in the group. 

Non dB controls such as Dynamics times, EQ Frequency & Q and Pans will only be changed in members of the 

group that had the same value for that control before it was moved. So, if one channel pan is in the same 

position in all the members of a group of Snapshots and you change one of them and press Update Group in 

Relative mode then the same channel pan will change in the same way in all the other snapshots that are 

members of that group. If, however, any one of the Snapshots in the group has that channel pan in a different 

position to the current Snapshot then this one will not be changed when you press Update Group.  

Non Relative Group Update Mode (Blue entries in the list) 

If Update Group is pressed when the relative groups button is not active, then all controls behave in exactly 

the same way. Changes are only applied to the other Snapshots in the group if the controls that are being 

changed had the same value as the current Snapshot before the change was made. This is exactly the same 

behaviour as non-dB controllers in Relative mode but in this case all controls are included. 
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Group & Auto Update Scope 

The behaviour of the Group Update function explained above is also dependent on the Global Auto Scope and 

the Group and Auto Update Scope settings that can be set per Snapshot for different types of controls. 

Pressing the Global Scope button at the top left of the Snapshot panel opens the following display: 

 

Horizontal rows show the different sections of the console and the vertical rows show the Recall and Auto 

Update status for each of the different types of control. A red X indicates not included and a green tick 

indicates included. These settings can be changed individually by touching the X or tick symbols or by touching 

the name of a row or column to change all of its contents. 

Recall Scope is dealt with in the next section but the Auto scope columns determine which controls will be 

included in the automatic group update. Any elements that have a red X will not be updated in any snapshots 

when Update Group is pressed. 

In the picture above the Input Devices (rack and local input sockets) are not included in the Auto scope so none 

of their gains or phantom power can be updated using the Update Group function. All other elements are 

ticked and therefore can be included in the Update Group function. 

Note: If elements are included in the Global Auto Scope they can still be prevented from Group Updating 

by the individual Snapshot's Group and Auto Update Scope. 

Selecting a Snapshot in the list and pressing the Group & Auto Update Scope button opens the following 

panel: 
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The Global & auto update scope is similar to the Global Scope panel but represents the Group and Auto 

Update Scope for one individual snapshot which is indicated by its name and number at the top of the panel. 

The down arrows on the left of the panel can be clicked to expand the list to show and edit the status of 

individual sockets and channels for each Snapshot. 

Changes in Control Group membership and ganging can also be included or excluded using the tick boxes at the 

base of the panel. 

In the picture above the Audio Enhancer input trim has been excluded from the Group Update in this particular 

Snapshot. 

Note: When using Snapshot Groups, it is advisable to set the Global Auto Update scope before attempting 

to change the update settings for each individual Snapshot. Use of the Global Scope alone probably offers 

quite sufficient control for most common applications. 
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2.4.11 Global Recall Scope 

When a snapshot is stored all the console settings are saved but when the snapshot is recalled its effect can be 

limited to certain channels and controllers. 

Note: All elements of console channels and several other features such as Graphic EQ and Effects have 

their own SAFE settings. If any of these SAFE settings are active, then the relevant controls cannot be 

affected by any Snapshots. This is in addition to the Global Scope settings described here. 

Pressing the Global Scope button expands the panel to display and edit the scope for all snapshots. 

 

Horizontal rows show the different sections of the console and the vertical rows show the Recall and Auto 

Update status for each of the different types of control. A red X indicates not included and a green tick 

indicates included. These settings can be changed individually by touching the X or tick symbols or by touching 

the name of a row or column to change all of its contents. 

The Recall scope columns determine which controls will be included in the Snapshot recall. Any elements that 

have a red X will not be recalled in any snapshots. 

In the picture above the Input Devices (rack and local input sockets) are not included in the Recall scope so 

none of their gains or phantom power can be changed by firing Snapshots. All other elements are ticked and 

therefore can potentially be changed when a Snapshot is fired. 

Note: If elements are included in the Global Recall Scope, they can still be prevented from recall by the 

individual Snapshot's Recall Scope. 
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2.4.12 Individual Snapshot Recall Scope 

Selecting a Snapshot in the list and pressing the Recall Scope button opens the following panel: 

 

The controls that are included in each of the Recall Scope columns can be seen at the bottom of the panel 

when any of the entries are changed and are as follows: Controllers 

Input/Trim (Local I/O and Racks) - analogue gains, switches and phantom power 

Input/Trim (Input Channels) - input routes, digital trim, phase, channel name, Mustard input position 

Input/Trim (Aux Outputs/Group Outputs/Matrix Outputs) - digital trim, phase, delays, buss name and tubes  

Input/Trim (Matrix Inputs) - input routes, matrix input name and tubes. 

Delay (All channel types) - Channel delay 

Filters (All channel types) -  HPF and LPF 

EQ (All channel types) - all controllers except channel HPF and LPF. 

Dynamics (All channel types) - all controllers except stereo link. 

Inserts (All channel types) - Insert Send & Return routes and ON/OFF switch 

Sends (Input Channels) - Aux send levels, ON/OFF & PRE/POST switches and Aux pans 

Sends (Matrix Inputs) - Matrix send levels and switches Fader (All channel types) - channel fader. Mute (All 

channel types) - channel mute 

Panner (Input Channels) - channel pan 

To Groups (Input Channels) - Input Channel to Buss routing switches 
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To Groups (Group Channels) - Group to Group routing switches 

Outputs (Input Channels) - Direct output routes, direct gains and ON/OFF switches Outputs (Aux 

Outputs/Group Outputs/Matrix Outputs) - Output routes and gains 

Outputs (Local I/O and Racks) - analogue output 10dB pads and AES SRC switches. Misc 

External- All External Controllers and Generic OSC controls can be saved and recalled. 

Control Group Members - Control Group label and a complete list of each group’s members. 

Gangs - Channel gang members. 

Banks - Current assignment for all controllers and selected bank on the worksurface. 

Copy Recall Scope From - Entire recall scope can be copied from another snapshot. 

Note: that if Waves is active, a Waves scope button is also shown. 

The down arrows on the left of the panel can be clicked to expand the list to show and edit the status of 

individual sockets and channels for each Snapshot. 

2.4.13 Snapshot Recall Times 

In addition to being fired manually, snapshots can be timed to fire automatically in sequence. This is done in 

the Snapshot Recall Times panel, opened by pressing the scope>recall times button on the left-hand side of 

the Snapshots panel. 

Each snapshot can be given a recall at time (the timecode value at which the snapshot will fire) and a duration 

(the amount of time before moving onto the following snapshot). With the capture recall times button 

toggled, the recall at time of the next snapshot created will be set to the current timecode. Both the duration 

and recall times must be activated by ensuring that their Active column is ticked. The smallest time units can 

be switched between 1/100ths of a second and frames using the duration display buttons in the bottom right-

hand corner of the panel. 
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The first snapshot can be fired manually in the main Snapshot window, if no specific recall at time is set. When 

this snapshot is fired, the next snapshot in the list will automatically be fired after the set time has elapsed and 

a progress bar in the snapshot's entry in the Snapshots panel will show the time remaining until the snapshot 

is fired. Pressing the duration active button while the progress bar is moving will halt the process. The recall at 

time overrides any active duration time.  

Cancelling Crossfades 

Once a snapshot containing a crossfade has be fired, a cancel crossfade button will appear on the snapshots 

panel. Pressing the cancel crossfade button will skip the crossfade and the snapshot will be recalled instantly. 

 

2.4.14 Snapshot Crossfades 

A crossfade time which is measured in seconds and frames can be applied to different controls in a Snapshot by 

adjusting the Crossfade Time in the Cross Fades panel. This crossfade occurs as you go into the Snapshot. 

Select an individual time by touching it or select a column or row by touching its heading. Then enter a time in 

the Secs/Frames boxes at the bottom of the panel. Either touch and type or use the Touch Turn rotary to enter 

a figure. 

Different Crossfade times can be applied to input trims, filters, EQs, dynamics, sends, faders and pans. 

The down arrows on the left of the panel can be clicked to expand the list to show and edit the status of 

individual channels for each Snapshot so different Crossfade times can be applied to different channels as well. 

A value of zero switches it off. 

The faders & panners wait time field located in the crossfades times panel is used to insert a wait time before 

the crossfade begins. 
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2.4.15 Snapshots and MIDI 

There are two separate areas of MIDI control: 

1. A snapshot can have a MIDI Message attached to it and will output that MIDI when fired. The MIDI 

message must be created in either the Scope>MIDI Program panel or the Scope>MIDI List panel. 

2. The firing of snapshots can be controlled by incoming MIDI messages on channel 16 and can cause 

these same messages to be output in addition to any MIDI List data contained in the snapshot. 

The specific MIDI messages that are being responded to can be edited in the Snapshot Control By MIDI panel, 

accessed via the Control By MIDI button. 

To change the default message for any particular snapshot, select the snapshot and press the Change button to 

select a specific available controller number. The Clear button will remove the existing message completely. 

The MIDI Received Fires Snapshots button allows the Snapshot system to respond by default to the following 

incoming MIDI messages: 

General Purpose Controller 16; Values 1 to 127 will fire snapshots 1 to 127 General Purpose Controller 17; 

Values 0 to 127 will fire snapshots 128 to 255 

General Purpose Controller 18; Values 0 to 127 will fire snapshots 256 to 383. 

General Purpose Controller 19; Values 0 to 125 will fire snapshots 384 to 509. 

General Purpose Controller 19; Value 126 will fire the previous snapshot in list. 

General Purpose Controller 19; Value 127 will fire the next snapshot in list. 

When active, the Fire Snapshot Sends MIDI button causes the above messages 1 to 509 (or customised 

versions - see below) to be sent whenever a snapshot button is pressed.  Previous and Next buttons do not 

output MIDI messages of their own. 
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2.4.16 MIDI Devices 

If you intend to send MIDI to external devices, it is advisable to first define your receiving devices - this will 

make the programming of MIDI messages in Snapshots easier to achieve. 

Press either the Scope>MIDI Program or the Scope>MIDI List button and then press the Devices button - the 

following panel will open: 

 

The SD and Quantum Console's built in MIDI port is referred to as Port A in the Port column. Set the receiving 

MIDI channel and name for each of your receiving devices and set 1 or 0 in the PC column according to 

whether the device uses 0-127 (0) or 1-128 (1) for its data values. If you don't know this piece of information, 

then leave the setting as 1. 

The column marked Chng determines whether Program Changes are only sent when they are different to the 

last sent message (Y) or whether they are always sent irrespective of the last message sent. This would be 

useful if there was no need to change the program on the receiving device and if you did this it might interrupt 

the signal passing through the receiving device as its program changes. 

The Clear PC button at the bottom of the panel ensures that the next message will be sent. 

This has defined your devices for later use and the panel can now be closed. 
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2.4.17 MIDI Program and MIDI List 

The Snapshot MIDI Program Changes panel, accessed via the midi program button has a column for each of 

the 16 MIDI channels on Port A and a row for each existing Snapshot. Touch and type, use the value up/down 

buttons or enter a value using the Touch Turn rotary control for each program change that you wish to send 

with each snapshot and ensure that the act (active) box is ticked for each relevant Snapshot. With the ripple 

down button active, entries will be copied to all consecutive following Snapshots that have the same value as 

the one which was changed or have no value. Once entered, this MIDI information will be sent when the 

Snapshot is fired. 

 

If MIDI program change messages have been entered in this way, they will also appear in the Scope>MIDI List 

panel which allows entry and editing of other types of MIDI message. 

There are columns for the midi device name (mentioned in the last section), the MIDI Port, MIDI Channel, type 

of command and two data values. 

Note: If you have already defined MIDI Devices, selecting one of these in the MIDI Device column will 

automatically enter the Port and MIDI channel that you have previously entered for that device. 
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If you want to send multiple MIDI messages with a single Snapshot, use the Insert button to add extra lines for 

message entry. You can then configure the message by editing each column using the value controls to the 

right of the list. Below the value controls is a key for the command column. To test the MIDI message without 

firing the Snapshot, press the Send button - the display at the bottom right of the panel shows the presence of 

incoming and outgoing MIDI messages. The move up/down buttons allow MIDI messages to be moved 

up/down within a snapshot. The edit hex button option can be used to quickly edit the entire messages 

parameters at once. MIDI messages can also be automatically entered into the list by generating the required 

message from the external MIDI device, sending this to the console's MIDI In and pressing the Capture button. 

2.4.18 Snapshot GPO Relays 

The Snapshot GPO relays panel allows the state of each GPO to be set when a snapshot is fired. 

The Global Recall scope for each GPO can be set by touching the appropriate box at the top of the column. 

 

2.4.19 Surface Offline & Snapshot Editing (Not SD11) 

In the Snapshot section of the console worksurface there are 2 buttons labelled Surface Offline and RTN To 

Audio. When pressed and held, the Surface Offline button stops the communication between the worksurface 

controls and the audio engine - this means that anything that is done on the surface of the console will have no 

effect on the audio passing through the console. 

Pressing the RTN To Audio button will reconnect the surface controls to the audio engine ignoring any 

worksurface changes that have been made since the surface was put Offline and returning the console to its 

state before the Surface was put Offline. 

Important Note: if the Surface Offline button is pressed, worksurface changes are made and the Surface 

Offline button is pressed a second time, the changes that have been made on the worksurface will 

immediately applied to the current audio - be careful with this function...! 

The main purpose of the Surface Offline and RTN To Audio buttons is to enable Snapshots to be edited with 

the worksurface offline so that any Snapshot can be previewed, adjusted and updated without affecting the 

current audio. 

While Surface Offline is active, any of the Snapshot functions already described can be used. 
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For example, if you are currently in Snapshot number one and wish to check or edit Snapshot number two you 

should: 

Press and hold the Surface Offline button and the audio will continue normally. 

Scroll down and fire Snapshot two to see its settings on the worksurface. 

Edit the settings for Snapshot two and Update either Current or Selected according to requirements. 

Press the RTN to Audio button to automatically put the surface back online and back in Snapshot one. 

Alternatively, pressing the Surface Offline button again applies the current state of the console to the audio, 

causing any changes made with the surface offline to be applied to the audio. 

2.4.20 Auto Update 

The Auto Update button in the Snapshots panel activates automatic updating of the current Snapshot 

whenever a control is adjusted. The current Snapshot will be updated without using the Update Current, 

Selected or Group functions. While auto update is enabled, the background of the snapshots panel will be 

highlighted. The elements of the Snapshot that are automatically updated is dictated by the Group and Auto 

Update Scope settings that are described in the Group Snapshots section of this chapter. 

Note: In view of the potential for changing Snapshots without active manual intervention, it is probably 

advisable to leave this function OFF unless you are absolutely certain that you require it. 
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2.4.21 Snapshots & MTC ................................................................ 

Snapshots can also be programmed to send MMC messages, allowing control of external playback devices. 

Within the snapshot scope section, press the transport control button. This opens the Snapshot Transport 

Control panel. The panel lists all current session snapshots and allows entry, per snapshot, of the following 

MMC commands. 

PLAY: Basic Play command. External device will play from 

current location 

play from: External device will play from specified time value 

play to: External device will stop when the specified time is 

reached. 

locate to: External device will Locate to specified time. 

STOP: Basic Stop command. External device will stop. 

Commands can be sent via MIDI, selected at the bottom of this panel. 

Note: Correct MMC operation relies on a correctly configured MIDI system, with MTC from the external 

device connected to the console MIDI Input. If this MTC connection is not present, the MMC snapshot 

system will not work. 

A Transport Control panel is also provided in the Layout Menu. This provides a MTC readout of incoming MTC 

and allows direct control of the external device. 
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2.4.21 Snapshot Notes 

Pressing the notes button (towards the top left-hand corner of the main Snapshots panel) opens a notes panel, 

displaying any notes associated with the current Snapshot. This panel stays open whenever the notes button is 

active, switching to the next Snapshot when it is fired. The selected and next snapshots are shown below the 

text box. 

 

To add notes, simply touch inside the notes space in the centre of the window and type your notes. To clear 

the text, touch the clear button in the top left-hand corner of the panel. 

To format the text or background, touch the style button (next to the clear button) to open the Notes Style 

panel: 

 

The text can be formatted using the text size controller and bold, italic and underline buttons in the left side of 

the panel. To change the colour of the text or background, select either the text colour or background button 

in the left side of the panel, touch inside the colour palette in the centre of the panel, and adjust the brightness 

using the brightness controller. The selected colour is displayed above the brightness controller. 

Note: that text defaults to minimum brightness (black), and the background to maximum (white). You 

may need to move the brightness controller towards the middle to see the colour content. 
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You can save your selected colour as one of the twelve custom colours in the right of the panel. To do this, 

simply select the add colour button and touch inside the desired custom colour box. 

You can also copy styles from other snapshots using the copy from snapshot controls beneath the main colour 

palette. Use the up and down arrows to move through the snapshot list – the snapshot whose style is currently 

displayed is shown in the copy from snapshot text box. 

Note: that copying a style from another snapshot will overwrite the current style. 

2.4.22 Snapshot Locked 

Note: Only available on non-Theatre software versions 

To lock a Snapshot and prevent it from being updated, select the Snapshot and then press the Locked button 

on the right of the panel. It can be unlocked in a similar way. 

When a Snapshot is Locked, it cannot be updated using update selected/current or deleted. 
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2.5  Options 
The Options menu includes a variety of SD and Quantum system preferences, grouped into ten tabs. Most 

functions are described fully within the display. Each function’s button displays purple to indicate that it is 

active or grey to indicate that it is inactive. 

2.5.1  Surface 

The Surface tab includes settings related to the console screen, buttons and encoders: 

 

Touch Keyboard 

This option defines whether or not the on-screen keyboard appears when a name box is touched. It is active by 

default. 

Large LCD Names 

This option allows the names in the LCD displays to be displayed in a larger font, either with the gain value and 

solo buss (with dBs) or as the channel only (name only). It is inactive by default. 

Round to whole dBs 

Fractional dB values are rounded to the nearest integer value. 

Auto Expand EQ 

This option defines if the EQ display opens when an EQ is adjusted. It is active by default. 

Auto Expand Dynamics 

This option defines if the dynamics display opens when dynamics is adjusted. It is active by default. 

Auto Expand Time 

This control, located to the right of the Auto Expand EQ and Dynamics options, defines how long the EQ and 

dynamics displays remain open after the parameters within them are adjusted. The current setting is displayed 

in seconds, below the control. Touching the control assigns it to the Touch-Turn encoder. 
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The Auto-Expand Exclude Off option prevents dynamics and EQ from auto-expanding when being turned off. 

Panner Type 

Type 1 is the original SD console implementation. The new Type 2 panning applies a new interpretation of the 

Sine/Cosine Panning rules - Improved spatial positioning of channels within the stereo image.  

Note: This setting is global for all channels on the console. 

Aux to Masters (SD7/Q7 Only) 

This option allows all of the aux send levels for one channel to be assigned to the Lower Master faders by 

pressing that channel’s lower aux button (the button in the third row of aux encoders below the Channel 

strip panel). This is useful if, for example, all of the fold-back sends from one channel need to be adjusted. 

The function is inactive by default. If there are more than twelve auxes in the session, the Lower master 

bank buttons are used to move between banks of twelve auxes. 

Note: If the number of auxes is not divisible by twelve, some faders within the last bank half banks will 

retain their original function, as indicated by their LCD buttons. 

Selected 4 Aux Rotary Assignment (SD7/Q7 only) 

This option defines whether the vertical four aux rotary controls stay assigned to the current four auxes within 

a gang/bank/layer/surface/all. 

EX-007 Touch Turn (EX-007 only) 

This option allows the first of the four rotary controls to act as the Touch/Turn control when the Master Screen 

is visible. 

Display Snapshots Overview 

This option allows a floating copy of the Snapshots list to be displayed in the overview screen, for the viewing 

or triggering of Snapshots. 

Global Quick Select (SD5, SD9, SD11, SD12, Q3, Q5) 

This option defines whether the Quick Select selection will be the same for every bank on a Surface.   

Note: On the SD5/Q5, the selection will be different between the left and right surface. 

Global 2nd Function 

This option defines whether the 2nd function button affects just the current surface (no) or all surfaces on the 

console (yes). 

Auto-cancel 2nd Function 

This option defines whether or not active 2nd Function buttons are cancelled after the time defined in the 

auto-cancel time pot to its right. It is inactive by default. Touching the pot assigns it to the Touch-Turn encoder. 

Note: Both the auto-expand time and auto-cancel time values are set on the console and are not saved as 

part of the session file. 
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(1272+) Auto-revert LCD Menu to Solo 

When this option is turned on, after the set amount of time the LCD function menu will be cancelled and the 

LCDs will revert to Solo function. The number of seconds for the LCD function menu to display is set using the 

auto-revert time rotary.  

Engine A/B Switches Audio (SD7/Q7/Q8 Only) 

This option concerns the Engine button in the top left-hand corner of the SD7's master section, shown below, 

which is used for switching the SD7 to the redundant engine. When this function is inactive, the Engine button 

switches just the console controls; when this function is active, the Engine button also switches the audio 

processing. This function is inactive by default. 

 

2.5.2  Faders 

 

Fader Assigns Channel 

This option allows a channel to be assigned to the worksurface channel controls whenever its fader is touched. 

It is inactive by default. 

Note: When this option is active, accidentally touching a fader will assign it to the worksurface controls. 

Fader 0dB Detent 

This option defines which controls have a detent at 0dB. Options are Inputs, Outputs, Graphic EQ (default) and 

CGs. 

  

Note: Function replaced in 

v1445+ - see below 



SD & Quantum Software Reference Manual  2.5 Options  

Fader Touch Control 

This option defines whether or not a fader moves when it doesn't detect a touch. Options are Free (fader 

moves freely) and Protected (fader is protected from moving without touch). 

Note: This setting is set on the console and is not saved as part of the session file. 

CG Faders Control Aux Sends  

Note: This function has been removed in V1445+ in favour of selectable control on each CG – see CG Aux 

Send Enable in CG section of the manual. 

If this option is set to Yes, whenever 'Aux to Faders' is activated (by any means), the Control Group faders jump 

to the middle and become +/-18dB trims for the selected aux send, on all channels which are members of the 

Group. The fader for Control Groups which have no members will simply close and do nothing. CG Mutes and 

Solos continue to operate as normal.  

(V1455+) Fader Response During Snapshot Recall option 

A new option has been added in Options>Fader tab called Fader Response During Snapshot Recall. The option 

has a Standard and a Fast setting. When set to Fast the console avoids delaying the fader input when recalling 

snapshots/cues.     

 

Set Spill Direction (on relevant consoles) 

This option defines the way in which Sets are spilled onto the worksurface: L Vert places them on the left side, 

creating as many banks as are required to spill all the channels in the Set; R Vert does the same on the right 

side; Horiz places the first 24 channels across both sides of the console before creating as many banks across 

both sides as are required to spill all the channels. 

  

To avoid delaying fader input 

when recalling Snapshots/Cues 

select Fast option.  
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2.5.3  Solo 

The Solo tab includes settings related to the console’s solo functions: 

 

Solo Displays Inserts and Outputs 

This option defines whether or not to display any internal FX or Graphic EQ on the inserts of direct outs of a 

channel when that channel’s solo button is pressed. The Graphic EQ panel can only be displayed on the Master 

screen. It is active by default. 

Solo Assigns Aux to Faders 

This option defines whether or not the send levels to an aux channel are assigned to the channel faders when 

that aux channel’s solo button is pressed. It is active by default. 

Solo Assigns Aux to Rotaries 

This option defines whether or not the send levels to an aux channel are assigned to the top row of aux 

encoders when that aux channel’s solo button is pressed. It is active by default. 

Aux to Faders includes Pans 

This Option defines whether or not the pan assignment for the under-screen rotaries will become the stereo 

aux pan when a stereo aux is soloed if Solo Assigns Aux to Faders is active. 

Solo Assigns Channel 

This option defines whether or not a channel is automatically assigned to the channel worksurface controls 

when that channel’s solo button is pressed. It is active by default. 

Solo Assigns Channel also Assigns Screen (consoles with master screen button) 

When a channel is selected using its solo button, the bank it’s on is assigned to the screen.  
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Solo Reverts to Output 

This option defines what happens if an output channel solo is active when an input channel solo is then 

activated and deactivated. When this option is active, deactivating the input channel solo will return the solo 

buss to the output previously in solo mode. When this function is inactive, deactivating the input channel solo 

will leave all solos inactive. 

The option is only available if the solo buss is in single mode. The option is inactive by default. 

Solo Displays Aux Nodal Processing (Quantum Only) / KLANG 

If a channel is selected and an Aux Master that has a corresponding Klang or Nodal Processing (Quantum only) 

node is soloed, the expanded view of that node is displayed. 

Line Check Listen 

This option changes which solo bus line check is routed to when listening to input sockets in the Audio I/O 

page. 

Outputs AFL Only 

This option restricts the Solo PFL/AFL choice to input channels only, all outputs being fixed on AFL. 

2.5.4  Gangs 

The Gangs tab allows gang scopes to be specified for each channel type. Selecting/deselecting the controls 

under each of the channel types will dictate whether those controls will be altered by a gang. 

 

2.5.5  Delays 

This tab is used for defining the delay units used in the Setup panel of Input channels, Output channels and fx 

channels (fx units). The options are seconds (default), feet, metres, bpm and frames. 

Note that these options are also displayed to the right of the numeric keypad opened by pressing the 

delay's keypad symbol. 
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2.5.6  Disable 

This tab is used for disabling worksurface buttons, to prevent accidental changes if they are not being used. 

This function does not affect on-screen operation of the functions:  If the Panel will show the options relevant 

to your console. 

 

2.5.7  Brightness 

The Brightness tab is used for adjusting the brightness of the console’s bridge, led lights, screens and surface 

LEDs. Touching each pot assigns it to the Touch-Turn encoder. 

 

The SD5 and SD7 console’s LCD buttons are not controlled by the surface LEDs pot but by the Dim LCD buttons 

and Invert LCD Image options towards the bottom of the screen.  

Note: The dimming option only dims the brighter LCD colours. 

2.5.8  Meters 

The Meters tab includes settings related to the console meters: 

 

The four pots across the middle of the panel affect the attack and release reaction time (attack rate and 

release rate), the peak hold time and the overs hold time. The current setting for each is displayed in either 

milliseconds or seconds, below each pot. Touching each pot assigns it to the Touch-Turn encoder. The row of 
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buttons above the pots provide access to preset meter configurations, including the SD default and a number 

of PPM formats. The second row of buttons allows the system to compensate for changes in operating levels 

when viewing PPM meters so that all PPM meters are referenced to 0dBu. The default operating level for SD 

Series consoles and racks is set to +22dBu. 

Note: When the overs hold time is set to 0, the hold time is set to infinite, not 0. The overs lights will 

therefore remain lit until they are manually cleared. 

Note: If you activate a metering preset and then edit it, the button for the preset on which the setting is 

based will still appear selected. 

The point being metered within the channel is set using the eight buttons in bottom left of the display. The 

input channel meters are adjusted using the buttons on the left, and the output channels are adjusted on the 

right. The options for each are pre-trim, post-trim (pre-processing), pre-fader (post-processing) and post 

fader. The default setting is post-trim for input channels, and post-fader for output channels. The currently 

selected button is displayed in purple. 

The Overview area in the bottom right of the display allows the size of Input and Output Meters to be set: 

small or large. 

Note: The settings in the bottom half of the display affect the meters on the worksurface, not the 

onscreen meters. 

2.5.9  Console 

The Console tab includes settings related to the console’s start up procedure: 

 

Load Startup Session 

This option allows the startup session to be automatically loaded on system start up. When not selected, the 

desk will always start up in the default state. 
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Save Startup Session 

This option allows the startup session to be automatically saved when quitting. When not selected, the desk 

will always start up in the same state. 

Auto-Save Recovery Session 

This option enables an auto-save function, which saves the active .ses file regularly, in case it needs to be 

recovered. The time between auto-saves is defined using the save every pot to the right of the option's button. 

Default Positions 

This option allows all windows to be set to their default positions on next launch. 

Enable External Waves 

This option enables Waves features. Waves is an optional extra which provides a set of Waves plug-ins in 

addition to the console's own fx units.  

For SuperRack SoundGrid V14.30+ (Legacy & ProLink) 

DiGiCo console software V1742 for SD and Quantum series consoles will support both Legacy & ProLink modes 

After applying the DiGiCo software update, the console will launch with Legacy console remote mode selected. 

How to set up ProLink: 

1. On the console, go to Master screen > Options > Console. 

2. Make sure Enable External Waves is set to Yes and that the console network port is selected. 

3. The default selected mode is Legacy. Click on ProLink and power cycle the console. 

 

4. Launch SuperRack SoundGrid. 

5. In the Controllers pane, add ProLink Console Remote. 

https://test.waves.com/
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6. If you have previously used the console remote module, you will see Legacy Console Remote assigned 

in the Controllers pane. If that’s the case, you will first need to remove it, then assign ProLink Console 

Remote. 

The correct network port is selected automatically. 

 

7. Checkmark ‘Assign’ – status will change to ‘Connected’. 

 

A session load command will pass from the console to SuperRack. If there is no matching session in 

SuperRack’s integrated sessions folder, SuperRack will load an empty session. 

SuperRack SoundGrid Integrated session folder location: 

Windows: C:\Users\Public\Waves Audio\SuperRack SoundGrid\Integrated Sessions 

Mac: Mac HD > Users > Shared > Waves Audio > SuperRack SoundGrid SoundGrid > Integrated Sessions 

https://test.waves.com/
https://test.waves.com/
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ProLink features: 

• Automated discovery 

• Sync to console global tempo 

• Console unattended mode sync with SuperRack 

To learn more about DiGiCo remote control integration features and console support, please refer to Waves’ 

DiGiCo Remote Control Integration and Mirroring article. 

 

We strongly advise Waves users to read the MultiRack for DiGiCo SD console user guide.pdf explaining the 

requirements to use Waves MultiRack/Superrack on an external PC and ensuring that all of the necessary 

equipment and licences are in place to do this. 

 

Please visit http://www.waves.com/downloads/digico for more information 

Need further assistance? Contact Waves Technical Support. 

Enable Fourier Integration  

See Section 2.6 

Enable Fourier Sessions and Snapshot Control 

See Section 2.6 

Enable Optocore 

This option allows Optocore connections to be switched off if not in use. You can have both Optocore loops 

OFF, or you can enable Loop 1, Loop 2 or Both. 

Enable Console Network 

This option activates networking for remote control PCs and consoles and is explained in the Network and 

Mirroring section 

Note: Enable External Waves and Enable Console Network both require a restart for changes to take 

effect. 

Mirroring Mode 

This option defines the way control is assigned between networked consoles and is explained in the Network 

and Mirroring section. 

Single Engine Only (SD7 Only) 

When active, this option allows two SD7's with only one engine to be mirrored together. 

  

https://www.waves.com/support/digico-remote-control-integration-and-mirroring
https://test.waves.com/support/digico-remote-control-integration-and-mirroring
https://test.waves.com/support/digico-remote-control-integration-and-mirroring
https://test.waves.com/support/digico-remote-control-integration-and-mirroring
https://test.waves.com/support/digico-remote-control-integration-and-mirroring
https://www.waves.com/contact-us
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2.5.10  Status 

The Status tab defines whether console status notifications are displayed. All functions are active by default. 

 

Display System Status Indicators 

This option defines whether or not the Status display is open. This display provides constant monitoring of 

various elements of the console’s systems. The indication box to the right of each element displays a green OK 

when that element is running correctly, a red error when that element is malfunctioning, and a blank grey box 

when that element is not relevant. Touching any indication box will bring up the appropriate Diagnostics page, 

if there is one. 

SD7 Dual engines 

The status display on an SD7 will have two columns listing the same elements. Each column represents one of 

the SD7s engines, local being the currently viewed engine and the other being the other engine.  
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Display System Alerts 

This option defines whether or not system warnings are displayed. The time for which alerts are displayed is 

adjusted via the message display time pot, located towards the bottom of the window. The current setting is 

displayed in seconds, below the pot. Touching the pot assigns it to the Touch-Turn encoder. 

Display Overs Alerts 

With this option active, whenever an input or output over-indicator comes on, the Signal Overs panel is 

displayed showing details of the signals involved and their channels. Touching an entry in the Signal Overs list 

brings the channel to the surface to be adjusted. The Signal Overs panel also duplicates the Clear Over 

Indicators button. 

Note: The Signal Overs panel can also be opened using the Signal Over Indicators option in the System 

menu. 

Display Messages until acknowledged 

With this option active, any system alert will remain on the screen until cancelled by the user. 
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2.6  FX & Processors 

2.6.1  The Master FX Display 

Selecting the fx menu button in the master screen opens the master fx display, which displays all of the 

currently assigned fx units in a single rack. Touching any control in this display allows adjustments to be made 

using the worksurface Touch Turn controls. 

 

It is also possible to create and delete modules from this display: 

To create a new module, click on the New button in the top left-hand corner of the fx window to bring up the 

fx Presets display, then select the appropriate preset in the usual way. Routing to fx modules is then performed 

in the channel Outputs display. To delete a module, click on the fx presets button on the module, and deselect 

the preset in the fx Presets display which appears. 

Factory presets are provided, and these provide the basis for any user-adjusted presets. Factory presets are 

indicated by the presence of a red padlock in the lock column on the right and are described below. These 

include stereo FPGA reverbs and other effects such as delays, choruses, pitch shifters and audio enhancers. 

Once an effects preset has been adjusted, it can be saved, either as a new preset or as an updated version of 

the preset that has already been created. 

To lock a preset, activate the edit name button and touch the preset’s lock column. A grey padlock appears, 

indicating that the preset is now locked. Touching the lock again with edit name active unlocks the preset. All 

master presets are locked and cannot be unlocked. Master presets can be distinguished from user presets by 

the red colour of their padlocks. 

Note: Factory preset group names can be edited, even though the presets themselves cannot. 
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Once an effects preset has been assigned, the fx output button in the channel strip recalls the preset’s 

controller display. In the case of Input channels, once an effects preset has been assigned, the preset’s display 

can be recalled by touching the pan area of the channel strip. The fx Presets display can then be recalled by 

pressing the fx presets button within the controller display. 

Each fx unit can be safed by pressing the safe button at the top of its display. The channel’s name and 

output are also shown at the top of the display, and each effect displays its input and output levels in 

meters in the left-hand side of the controller. 

(1272+) Global Tap Tempo 

Delay effects can now join a global tap tempo so that a single controller can change the delay amount on all 

delays in the group. Delays can be set to different scalers. For example, if a delay unit was set to ‘delay x 2’, the 

delay amount would be set to double the current global tap amount. The options are: off (default, not part of 

the global tap), x 0.25, x 0.5, x 1, x 2, x 3, x 4.  

The global tap can be set using the new macro command type ‘Global Tap Tempo’.  

 

The Global Tap value can be entered manually by touching the keypad icon in the Delay FX panel and typing a 

number. 

FX Graphs 

All reverbs are editable via a graphical display, with each of the coloured adjustable sliders on the graph 

representing the rotaries on the fx unit below. 

 

Press to cycle 

through the 

options for 

global tap at 

various scalers.  
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2.6.2  The Spice Rack (Quantum Engines only) 

Spice Rack is the new audio processing rack on Quantum engines. It was released with the Chilli 6 Multiband 

Compressor and also now includes a 6 band Dynamic EQ called Naga 6.  

The Spice Rack can be accessed by touching the Master Screen > Processors then Spice Rack. 

Soloing a channel with a Spice Rack processor inserted will bring up the Spice Rack and the relevant slot. 

2.6.3 Chilli & Naga 6 Overview 
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The Naga 6 can be accessed by selecting a Chilli 6 unit and pressing the type button, then choosing Naga 6.  

 

Chilli 6 is a classic multiband compressor with four flat top filter type bands with shared crossover slope and 

two separate parametric bands. The Naga 6 is a Multiband Dynamic EQ with six parametric bands and no flat 

top filters.  They both allow frequency specific dynamic control with compression or expansion applied to 

audio above a set threshold. When stereo channels are routed to the Spice Rack, two consecutive slots are 

automatically set to stereo, therefore ganged together. They can be set back to mono to allow the units to have 

different parameters. Before units can be stereo linked the pair of units have to be set to the same type, Chilli 6 

or Naga 6. Pairs must be neighbouring units such as 1 and 2 ,3 and 4, 5 and 6 etc. Note that 2 and 3, 4 and 5 etc 

cannot be made into a stereo pair. 

The green line represents the frequency response of the processed audio and reflects the compression or 

expansion applied in real time. 

The Release Shape is used to alter the release characteristic with curve type exponential (0) through linear 

(0.5) to inverse exponential (1). Inverse exponential is a new feature which reduces sharp decays between 

peaks in signal, whilst maintaining the same overall decay time.  
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Dynamic Angle affects how far above the threshold the signal needs to be before the full range of EQ is 

applied, similar to a ratio with a smooth transition through the threshold. This can be set anywhere between 1 

(default) equivalent to a higher ratio and 0, a lower ratio. Also similar to a knee, when the Dynamic Angle is set 

to a value less than 1, gain reduction will be applied to signal below the threshold however will always 

maintain a soft curve. 

Parametric (Bell) Filters. The six bands on the Naga 6 and two of the bands (P1 and P2) on the Chilli 6, are 

parametric EQ type filters, which have a centre frequency range of 20Hz – 20kHz and Q of 0.35 – 60. When the 

band is set to “Split” mode, these bands also have their own independent flat top filter bands, which are used 

only on the side chain dynamic control and as isolating filters when soloing the band. The centre frequency of 

these bands follow the frequency control of their main parametric filter, and the width adjusts in sympathy 

with the main ”Q” control. Setting the band to “Wide” bypasses the flat top filter in the dynamic side chain 

control such that the side chain is fed directly from the input signal, although these filters remain active as 

isolating filter when soloing.  

Flat top filters. On the Chilli 6 only, bands 1 – 4 have three crossover filters which are used to position the 

bands over the desired spectrum. A global Crossover Slope adjusts the filter slope between second order (0) 

and true fourth order (1). When a band is set to split mode, the side chain control signal is fed post the filter 

and will respond only to audio within the band, but when set to “Wide” the side chain is fed directly from the 

input and will respond to the whole spectrum. Soloed signals will always pass through the filter regardless of 

the “Split”/”Wide” state. 

Gain acts as a level adjustment for each band.  

Range determines the limits of compression or expansion applied to a particular band. When activated, the 

dynamic range is shown by a blue highlight either above (expansion) or below (compression) the current gain 

in the graphical display.  

External Side Chain. Pressing the “Side Chain Source Route” will allow you to select an external source to be 

used as a side chain. Each band can be set to use this one signal as its side chain source independently by 

pressing the “Int” / “Ext” buttons. Any band not using Ext reverts to using self (the input signal) as its source. 

“Ext” cannot be selected if no external route has been set up. 

Soloing Bands. Only one band can be soloed at a time, by pressing the “listen” button in the band. With listen 

Source set to “Band” the solo will monitor the input signal passing through the bands filter controlled by the 

dynamics, and in the case of parametric filter bands, the signal will also be passed through a side chain 

isolating flat top filter. This is so that when notch filters (Bell cut) are used, the affected audio region will be 

isolated. When Listen source is set to “S/C Listen” the external S/C signal (if set to external) or the input signal, 

will be passed through its own flat top side chain filter. This filter will not be controlled by the dynamics as it is 

monitoring the source that is controlling the dynamics. 

Listen/Solo Destination. The soloed band can be sent to the “Solo 1” buss, the “Solo2” buss, or both, without 

altering the normal signal going through the spice rack (non-destructive). Alternatively, Pressing the 

“Destructive” button will make the soloed band replace the spice racks normal output with the soloed signal. 

These controls are global to all the units in the spice rack.  

Attack and Release determine the speed at which the compression or expansion acts on the signal.  

Threshold sets the point where compression or expansion is applied. 

There is an overall Output fader which can be used to make-up or reduce a post-effect gain difference.  
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Any of the bands can be set to Bypass which sets the gain and range for that band to 0dB, maintaining the 

overall phase. Bypass All applies a blanket bypass across all bands which keeps the state of the individual 

bypasses. 

2.6.4  User interaction options 

1. Faders 

Parameters can be touched on screen to determine which row of controls are assigned to the upper master 

faders (Q7) or centre section faders (Q3/Q5). Mute buttons act as bypass and solos act as listen in this option. 

2. Touch turn 

Each parameter can be pressed individually to be controlled by the touch turn rotary. The touch turn button 

toggles the bypass state when on-screen rotaries for that band are selected and listen state when the on-

screen faders are selected.  

2.6.5  Presets 

 

Presets allow the ability to recall and save parameters for a particular setup of a Spice Rack effect. New will 

create a preset with the current parameters in the effect, this will be stored under a group. Default will recall 

the default settings for the effect in the current slot.  

When edit name is selected, the group name, preset name and notes can be altered. Factory presets are 

locked and cannot be altered or deleted. 

A variety of factory presets are available as starting points for use on different audio sources.  

2.6.6 Fourier transform.engine - Control Integration (V20xx) 

The Fourier transform.engine can be controlled from Quantum consoles (Q8/Q7/Q5/Q3/Q2). 

There are 2 aspects to the control integration. 

• Transform Plugin Teleporting and control. 

• Transform Session and Snapshot integration. 
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Teleporting is enabled with the console Enable Fourier Integration option and, if this is enabled, the Enable 
Sessions and Snapshot Control option is also displayed as an option. 
Note that Fourier and Waves integration cannot both be enabled at the same time. 
 
To enable this integration:  
 

• Connect the console ethernet port to the transform.engine Control port with an ethernet cable. 

• In the console Options > Console tab, set Enable Fourier Integration to Yes. 
Then press the Settings button to open the configuration panel. 

• Enter the IP address of the Control Port on the transform.engine and specify the console network 
adaptor which is used for the ethernet connection.  The console must be power cycled after any 
change of IP address. 
Note that the transform.engine must be in the same subnet as the console. 

• Select the Audio IO port which will be used for the Transform audio interface which typically will be 
either a DMI-Dante 64@96 card or an internal Fourier Interface Card. A Fourier Audio logo will appear 
next to the selected port in the Audio I/O panel. 
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2.6.7 Fourier transform.engine - Session and Snapshot integration (V20xx) 

Note that on the transform.engine, there will be 2 versions of the showfile related to a particular console 

session. 

One has the suffix _autosave and the other does not. 

The version of the showfile labelled “session name_autosave” is automatically created on the transform.engine 

when it performs an autosave and is continuously updated as changes are made. 

The version simply labelled “session name” is saved whenever the console itself saves a session provided that 

the console Option > Console > Enable Fourier Sessions and Snapshot Control is set to Yes 

If you wish to save the Transform showfile on a removable USB drive for backup/transfer to another 

transform.engine, please ensure that you Export the version of the showfile without the _autosave suffix. This 

will then be associated with the console session that has the same name. 

In the transform.client application running on the standalone computer, navigate to System, select a showfile 

from the list, press Export Showfile, select a destination and confirm. 

The following situations should be considered: 

If you don’t have either an existing console session or a Transform showfile 
Assuming that the console has had a Default All Session Restructure, before saving the new console session, 
the Transform engine will create a blank showfile named “_default”. 
When the session is saved on the console, the Transform engine will also save a file of the same name and 
make that its current showfile. The displayed showfile name will be “sessionname_autosave”. 
 
If you have a console session but no matching Transform showfile 
If a console session is loaded and the transform.engine does not have a showfile with the same name then it 
will create a default showfile on the transform engine with the same name as the console session, and create a 
DiGiCo Cuelist. This cuelist will be populated with snapshots to match the snapshots in the console session file.  
 
If you have a console session on the console or removable drive and a matching Transform showfile 
Import the transform showfile onto the transform.engine. Make sure that the showfile name exactly matches 
the name of the console session file. If it does not, then this must be changed using Rename Showfile within 
the transform.client, not in a standard file browser. Note that if the showfile has previously been used with 
DiGiCo console integration and gained the “_autosave” suffix, this will need to be removed from the showfile 
name in order to synchronise with the console again. Once it has been imported to the transform.client and 
the session names have been checked, load the session on the console. When the session is loaded onto the 
console, it will look for the transform showfile of the same name and load this onto the transform.engine. 
 
Note that for console sessions made with Fourier Integration turned off, if it is subsequently enabled then by 
default, console individual Snapshot Recall Scope is not active for the Fourier Transform until the user chooses 
to enable it. This can be quickly enabled for all snapshots by using the Edit Range function in the Snapshots 
panel. 
 
Since it is possible to load different sessions and make changes to the snapshot list on the transform.engine 
from the transform.client, it is possible to get out of sync between the console and the transform.engine. If the 
console detects that the transform.engine session and snapshots are no longer in sync with the console, it will 
pause the session and snapshot integration. When paused, a message will appear at the top of the Fourier 
panel. To resync and resume session and snapshot integration, the console session must be reloaded or the Re-
synchronise Snapshots button in Fourier > Settings must be pressed. 
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2.6.8 Adjusting plugin parameters from the console interface 

For plugin teleporting (display and control of the plugin interface on the console), the routed console 
Transform audio interface socket numbers (typically Dante audio) are associated with the same numbered 
sockets used with the Transform plugin chain. Note that patching to and from the transform.engine in Dante 
Controller must be done 1:1. 
 
If, for example, console channel 1 has insert send and return routing assigned to the Transform interface 
sockets input 1 and output 1, selecting/soloing this channel will display the Transform plugin chain with the 
same numbered socket routes. By default, this would be plugin chain 1. 
 
Once all routing to and from the transform.engine has been set up, the Fourier panel can be opened in 3 ways.  

• Press Processors > Fourier to open the Fourier panel.  

• Tap the insert routed to the transform engine on the channel strip 

• Solo a channel that has an insert or output routed to the transform.engine. Note that this will depend 

on the Solo Displays Insert and Output option found in Options > Solo. 

Plugin parameters can be controlled by the touchscreen or a mouse connected to the console. For compatible 
plugins, control can also be achieved by touching a control in the console Fourier plugin interface and using the 
console worksurface touch turn encoder. If a plugin is not touch turn compatible, this will be indicated at the 
top of the console plugin list display. In this case, controls should generally still be controllable with on screen 
touch. 
 
Along the left side of the panel is a list of all of the plugins in the chain. Tap on a plugin to display it. Icons may 

appear next to plugins in the list to show different states such as bypassed or reloading.  

The plugin list on the left can be collapsed and expanded using the Collapse or Expand button at the bottom. 

This increases the size of the plugin viewer and therefore the size of the plugin. 

 

 

 

 Displays the plugin chain which is routed from the selected channel 
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2.6.9 Sharing a transform.engine between multiple consoles 

It is possible for multiple consoles to connect to the same transform.engine.  If one transform.engine is being 
shared by multiple consoles (for example FOH and Monitors each using their own chains) then only one of the 
consoles should be in charge of sessions and snapshots on the transform.engine. This console should have 
Option > Console > Enable Fourier Sessions and Snapshot Control set to Yes. All other consoles should have 
this option set to No. 
 
If a mirrored set of consoles or engines (for example engine A and B in a Quantum7 or Quantum852) are 
connecting to the same transform.engine, then both consoles or engines can have Enable Fourier Sessions and 
Snapshot Control set to Yes. In this setup, the transform.engine will listen to the audio master for session and 
snapshot commands. If one of these engines can no longer talk to the transform.engine then it will listen to the 
only console connected, regardless of audio master status. 

2.7  Matrix Menu 

2.7.1  The Matrix Panel 

Touching the Matrix menu opens the Matrix Inputs panel, which allows matrix inputs to be selected and the 

level of each input to each output to be set. Each column of the display represents an input to the matrix, and 

each row represents an output. Each pot within the display trims the signal coming from the input for that 

column, going to the output for that row. 

The SD12, SD/Quantum 5 and SD/Quantum 7 Matrix panel includes buttons on the top left which can be used 

to set which surface screen the Matrix is viewed on.  

 

 

Enter required level 

via text 
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The top of each input column displays the input’s name, and the label above each trim pot displays the pot’s 

output. Touching any trim pot assigns it to the Touch-Turn encoder; pots lighten and are ringed green to 

indicate that they have been assigned. Multiple pots can be assigned simultaneously, in which case the 

encoder alters all assigned pots by the same amount, regardless of each pot’s position. The value of each pot is 

displayed in dB to its right. Sends are switched on using the Touch Turn control's button; the display shows OFF 

in grey when it is off, and ON in red when switched on. Turning a pot automatically switches it on. There are 

three Touch-turn assignment buttons at the bottom of the display. The all button assigns all the trim pots to 

the Touch-Turn encoder; individual pots can then be deselected by touching them. The clear button clears all 

the pots from the Touch-turn encoder. Activating the single button prevents multiple trim pots from being 

assigned to the encoder simultaneously.  

Note: The all function can still be triggered when the single function is active.  

The Enter Gain Value field allows the gain of single or multiple matrix nodes to be set via the on-screen or 

physical keyboard. 

[V1455+] When entering a gain value into the text box at the bottom of the panel, the value now defaults to a 

negative value. Two new options have also been added to the panel: 

Abs: enter the numerical value in the box using a keyboard or the on-screen numpad, all selected “knobs” will 

have their gain set to that value. 

Rel: the value entered in the text box will increase or decrease the level of all selected “knobs” by the entered 

amount. 

Matrix input signals are selected in the Setup display, accessed by touching the text box at the top of each 

matrix input column. At the top of the Setup display, there is a text box which can be used for renaming the 

matrix input. Below that, there is a matrix input routing button which opens up a routing display. Routing 

displays are described in the Getting Started Section. 

Below the routing button, there is a scrollable list of buttons displaying the names of all the other matrix 

inputs, under the heading copy settings from, used to copy matrix settings between input columns. To copy 

the level and on/off status of each send from one column to another, simply touch the button for the input 

column from which you want to copy settings. 
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The Matrix Input Presets panel is opened using the presets button located at the bottom of a matrix input 

Setup display and at the bottom of the Matrix panel. Preset panels are described in full in the Getting Started 

section. To include input routes in the preset recall, make sure the input route button at the base of the screen 

is active. To include trim pot levels and on/off buttons, make sure the sends button at the base of the screen is 

active. The chs column of the display indicates the number of channels included in the preset, and presets can 

be named – by default, Presets are named after input signal 1. 

 

The safe button at the bottom of the Matrix panel protects the matrix settings from being overwritten by a 

snapshot recall. Similarly, the safe button in an individual matrix channel’s setup panel will safe that particular 

channel. 
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2.7.2 Matrix Output Copy  

There is a Copy Setting function in matrix output channels in Matrix Setup panel. Pressing Copy Settings will 

display a list of other matrix outputs, selecting one will copy mix settings. Default 0db and Off settings have 

been included at the beginning of the Copy Settings list.  

 

  

Copy Settings button 

opens the Matrix list.  
Matrices list opens as 

a drop-down menu 

underneath the Copy 

Settings button.  
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2.8  Graphic EQ Panel  
The left-hand side of the expanded display includes metering of the EQ’s IN and OUT signals, a ±12dB gain trim 

pot with value indication to its right, and an on button which is ringed red to indicate that the EQ is on. Touch 

the trim pot to assign it to the Touch-Turn encoder. To the right of these controls, the 32 EQ band faders are 

displayed. The label located beneath each fader indicates the frequency of each band in Hertz, and the gain 

scale associated with each line on the display is indicated to the left of the lowest band. Each band can also be 

altered within the miniature display (using a mouse). 

The display consists of miniature representations of all available graphic EQ’s, one of which is also shown 

expanded in the bottom of the display: 

 

The settings on each graphic EQ are accessed via the expanded display, though some settings can also be 

adjusted in the miniature display. Touch any of the graphic EQs to assign it to the expanded display. The EQ 

assigned to the expanded display can also be scrolled using the scroll bar to the right of the expanded display. 

The EQ currently assigned to the expanded display is indicated in the top left-hand corner of the expanded 

display, along with indication of the EQ’s source. The miniature display can be opened and closed by pressing 

the expand button (a down-arrow when opened, and an up-arrow when closed) to the left of the expanded EQ 

close button. 

The left-hand side of the expanded display includes metering of the EQ’s IN and OUT signals, a ±18dB gain trim 

pot with value indication to its right, and an on button which is ringed red to indicate that the EQ is on. Touch 

the trim pot to assign it to the Touch-Turn encoder. To the right of these controls, the 32 EQ band faders are 

displayed. The label located beneath each fader indicates the frequency of each band in Hertz, and the gain 

scale associated with each line on the display is indicated to the left of the lowest band. Each band can also be 

altered within the miniature display. 

Note: For Q8 only, there is an additional Touch to adjust option available which allows the faders on the 

expanded display to be adjusted by dragging on screen. 
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2.8.1 A Ganging Graphic EQs 

The grey GANG and build gang buttons above the band faders are used for ganging together different graphic 

EQ’s. When EQs are ganged, their band faders, on buttons and trim pots are locked together. 

Note: Ganging of faders is relative: EQs can have different shapes when they are ganged, and each EQ 

will move by the same amount when a band is adjusted. 

Note: If faders are moved within the miniature display, any other EQs ganged to them will also move. 

When a set of Graphic EQs are inserted on a stereo or surround channel, those EQ units are automatically 

ganged together and are then automatically un-ganged when the insert route is removed. 

Note: It is the Insert Return routing, not the Insert Send routing, which gangs EQ units. 

To start building a gang manually, touch one of the graphic EQs to be included in the gang to assign it to the 

expanded display, and touch build gang. The button turns red to indicate that it is active. The GANG button to 

its left will also become coloured, indicating that it is included in the gang being built. To add further EQs to the 

gang, touch the relevant small Graphic EQ display on the other Graphic EQs to be included, and they will 

change colour to match the expanded EQ’s GANG button. To deselect any EQs from the gang, touch their 

GANG buttons again and they will return to grey. Touch the build gang button to complete the ganging process. 

EQ gang assignments can be adjusted by reselecting the build gang button. 

Note: To temporarily isolate a Graphic EQ band from a gang, press and hold the mute button above the 

band's fader and then make the adjustment to that fader - this move will only be made to that band on 

the Graphic EQ that you are currently adjusting. 

2.8.2  Graphic EQ ALL Button 

To adjust all graphic EQs at once, select the all button to the right of the build gang button. It turns red to 

indicate that it is active. Adjusting any band in the expanded EQ will cause that band in all EQs to jump to that 

position 

Note: The all function is absolute: Once a band is altered, any variations on that band between the EQs is 

eliminated. 

Note: The all function does not affect the normal operation of faders in the miniature display - they still 

operate independently. 

To return all 32 bands within one EQ to 0dB, touch the flat button to the right of the all button, and touch Yes 

in the confirmation pop-up which appears. 

Note: that the flat function affects any EQs which are ganged to the expanded EQ. 

Activating the safe button, to the right of the flat button, protects the graphic EQ settings from being 

overwritten by a snapshot recall. 

2.8.3  Graphic EQ Presets 

Touching the preset button, to the right of the safe button, opens the Graphic EQ Presets display in which 

current settings can be saved and pre-created settings imported. The positions of the trim pot, on button and 

all 32 faders are included in an EQ preset. To reset the channel to the default settings, press default.  
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2.9  Control Groups 

2.9.1  The Master Control Groups Display 

An overview of all the Control Groups within a session can be access via the Control Groups menu button in 

the master panel. 

 

This display contains basic channel strips for each Control Group. Each channel strip includes a list of 

channels that are assigned to that control group and few basic controls that can be adjusted from within the 

control group view, including spill, join/leave, clear and all mute. The Control Group naming controls are 

also available within the display’s channel strips. 

Any number of input channels and output channels can be assigned to one or more of the Control Groups. 

Channels assigned can all be adjusted from a single worksurface control assigned to that control group. This 

means that changes to the Control Group fader, mute or solo will be applied to all of the channels assigned to 

that Control Group. 

There are 2 methods to set up Control Groups: 

1) Press the LCD Function button on the CG fader bank followed by the JOIN CG button, then press the 

channel select button for the CG that you want to use, then press the channel select buttons for each of 

the channels to be included in the CG, finally deselect the JOIN CG button: 

 

Press LCD function 

button, then join CG 

Press LCD function 

button, then join CG 

Select Control 

Group to join 

Press channel LCD buttons to 

assign members  
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2) Press the on-screen JOIN/LEAVE button for the required CG channel; 

Press the channel select buttons for each of the channels that you want to make members of the CG; 

Release the JOIN/LEAVE button: 

 

A list of all the connected channels and their names is displayed above each Control Group display. 

You can also clear all the channels from a Control Group by pressing Clear. 

When a channel is a member of a Control Group, its own controls can still be adjusted independently of the 

other Group members. Adjustments to fader levels are transmitted to the Group members as dB changes, so 

that a level increase of 2dB on the Group fader will increase all the member levels by 2dB, irrespective of the 

relative levels of the individual channel faders. 

Note: Control Group channels function completely differently from Group channels: Group channels mix 

together the audio from any channels routed to them, whereas Control Group channels simply move the 

channel faders of any channels assigned to them, irrespective of any audio routing. 

The number of control groups available is defined in the console Session Structure. Control Groups can be 

named using the standard naming tools. The safe button, located at the bottom of the on-screen channel strip, 

can be used to protect the assignments and settings of the Control Group from being changed if a new 

Snapshot is fired. 

All of the Control Groups to which an input or output channel belongs to are displayed immediately above the 

GANG and SAFE buttons in the Channel strip panel. 

Note: Only the first two to three Control Group assignments within a channel can be displayed in the 

channel strip. 

Press join/leave button on required CG channel 

Press channel LCD buttons to assign members 

List of members  
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All of the channels included in a Control Group are listed in the top half of the Control Group channel strip 

display. To clear all of the channels currently assigned to a Control Group, touch the Control Group’s clear 

button, located below the join/ leave button, and press Yes in the warning display that appears. 

2.9.2  Control Group Fader Modes 

There are three modes in which the Control Group fader can interact with the faders of the channels assigned 

to it, and the button below the clear button in the channel strip display toggles between them: 

In moving fader mode, all assigned faders will move to replicate any Control Group fader movements. 

Note: It is the level change associated with the fader movement which is replicated, not the physical 

distance the fader is moved. 

In VCA style mode, moving the Control Group fader affects the output level of all assigned channels without 

moving their faders. In mute only mode, the Control Group only controls the mute buttons of assigned 

channels, not the output level. 

Note: In all three modes, moving the fader of a channel assigned to a group does not impact the output 

levels of other channels within the group. 

2.9.3  Control Group Mute Functions 

The mute buttons within a Control Group interact in the same way, regardless of the current fader mode: 

The mute button above the LCD display on a Control Group fader can be used to mute all of its assigned 

channels. Its function is duplicated by the all mute button below the channel’s scribble strip. When a channel is 

muted by its Control Group mute button, the channel's mute button lights in the normal way. The channel's CG 

mute button goes blue to indicate that the Control Group mute button (rather than the channel mute button) 

is responsible for the mute. When deactivated, the Control Group mute button returns all assigned channels to 

their mute state before the Control Group mute button was activated. 

CG Mutes are treated as “in series” where a channel is a member of more than one group. All CG mutes must 

be off for a channel to be unmuted; any CG muted always mutes all of its members. 

If a channel is CG muted by single or multiple CGs, the worksurface channel mute button will override all CG 

mutes for that channel. The channel will not however be removed from CG membership so if the relevant CG is 

muted again, the channel will also be muted. 

The auto-mute function, activated by touching the auto-mute button located above the Control Group name in 

the Channel Strip panel, automatically mutes any channel which is removed from that Control Group and 

unmutes any channel that joins the Control Group. 
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2.9.4  Control Group Spill (1272+) 

Members of a control group can be spilled directly rather than adding them to a spill set. They can be spilled by 

using the Spill button on the CG channel strip and the Control Groups panel, or by firing a “Spill Control Group” 

macro under the Layout command type. 

 

2.9.5 Control Group Aux Send Enable (v1445+) 

The aux sends button in the Control Group channel strip allows individual CG faders to control Aux send levels 

when the Aux to fader function is active. The Control Group fader acts as a trim for all Aux sends on the 

selected (soloed) Aux buss. 

An Aux Send Enable macro is included in Setup>Macros under the Control Group command type.  

 

Note that the CG Fader Controls Aux Send global setting in Options>Faders has been removed in V1445.  

  

Spill members of the CG 

Include/exclude CG 

from CG controls Aux 

Sends. 
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2.10 Solos Menu 

2.10.1 The Solo Panel 

Touching the Solos menu opens the Solo 1 and Solo 2 displays. These displays are used for configuring the 

console’s solo busses. Solo buss 1 is configured in the left-hand display, and solo buss 2 in the right. Both 

displays function in exactly the same way: 

 

Note: The in-channel solo functions are described in the Channel Types Chapter 

At the top of each display is a black box containing the solo meter(s), three buttons, and an input trim encoder. 

These controls are duplicated on the console worksurface. The first button selects which point in the channel 

feeds the buss, and toggles between PFL and AFL, as indicated by the pfl or afl labelling above the button 

turning green. The button is also ringed green on the worksurface when afl is selected. 

The second button toggles the two solo button modes: multi in which multiple channels can feed the solo buss 

at once, or single in which only one channel can feed the buss. In single mode, when a channel is feeding the 

solo buss, pressing the solo button on a different channel will cause the originally selected channel to be 

deselected from the solo buss. The solo button mode is indicated by the multi or single labelling above the 

button turning red. The button is also ringed red on the worksurface when single is selected. 

All feeds to the solo buss can also be cleared by pressing the clear button. When there is a feed to that solo 

buss somewhere on the console, the button is ringed blue on the worksurface. 

pfl / afl solo mode 

multi / single solo mode 

Clear 

Floating Meter 

activation 

Solo Delay 

Solo Trim 
Solo Level Meter 

Buss Format 

Switch 

No solo source 

select 

Insert Routing 

Direct Out  

routing 

Headphones  

On / Off Direct Out Level 

Fader Assignment  

Direct Out Level 
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The level of the solo buss can be adjusted using the trim encoder on the worksurface. The on-screen trim pot is 

always assigned to this worksurface encoder, as indicated by the presence the green ring around it. The signal 

can be trimmed by ±18dB, and the trim value is indicated to the right of the on-screen trim pot. 

In the centre of the Solo 1 or Solo 2 display, there is an auto solo area which lists all the channels which are 

selected for the auto solo function. This function automatically routes selected channels to that solo bus 

whenever another channel is soloed, and the selected channels can be scrolled if necessary, using the scroll bar 

on the right of the list. The auto solo channels are selected in the Channel Setup display. This auto solo 

function is enabled and disabled by touching the left-hand blue button below the auto solo list. The button 

label displays whether the auto solo function is enabled or disabled. The channels in the auto solo list can all 

be removed by touching the clear all button below the auto solo list. 

Tip: If you are using effects returns, selecting auto solo will allow soloed tracks to be auditioned with their 

effects returns - this function only works in Multi-Solo mode. 

The solo buss signal can be delayed using the delay pot to the right of the auto solo area. Switch the delay on 

using the on button below the pot. Touch the pot to assign it to the Touch-Turn encoder. The delay value has a 

range of 0 to 2.7 seconds and is displayed above and to the right of the delay pot. 

The mono, stereo and surround buttons to the left of the auto solo area select the size of the solo buss. Each 

button is red when selected and grey when not selected. The selected format is also indicated by the number 

of meters displayed in the top left corner of each display. 

2.10.2 The No Solo Setup Display 

Below the mono, stereo and surround buttons, is a button marked no solo. This button defines what signal (if 

any) is present on the buss when no channel solo is active. By default, the master buss is selected as the no 

solo source. Pressing this button opens the No Solo Setup display: 

 

At the top of the display, there is a text box which can be used for renaming the solo buss. Touch the box or the 

keyboard symbol to its right, type the new name on the on-screen or external keyboard and press OK. The 

Channel Name display containing commonly used words for quick insertion can be accessed for buss naming 

by touching the down arrow immediately to the right of the text box. The solo buss name will then appear at 

the top of its master solo display, and in any solo-assigned master faders (See below for details). 
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Below the naming area, there are two columns of buttons used for selecting the audio source for the no solo 

function from among the group, aux and matrix channels. The left-hand column contains the following 

buttons: the groups buttons (mono or stereo), the auxes buttons (mono or stereo) and the Matrix button 

(mono). Touching one of these buttons causes it to lighten to indicate that it is selected, and results in a list of 

those channels appearing in the right-hand column. A scroll bar appears in the right of the display if the 

channel list is too long for the window. Touching one of these signal buttons assigns it to the no solo function, 

as indicated by the lightening of the signal’s button and by the labelling immediately beneath the no solo 

button displaying the signal name. If a stereo signal is selected here, only the left-hand signal is displayed 

beneath the button. Signals can be deselected by touching them again. When no signal is selected for the no 

solo function, the labelling beneath the button displays none. 

To close the No Solo Setup display, press the CLOSE button in the top right-hand corner. 

The area below the auto solo area concerns the solo buss outputs. In the centre of the output area, there is an 

output level pot. Touch the pot to assign it to the Touch-Turn encoder. The buss output level trim ranges from 

OFF to +10dB, as indicated to the right of the pot. 

2.10.3 Assigning Solo Busses to Faders 

The solo buss output level can also be assigned to the master fader(s) by pressing the assign level to master 

button(s) to the right of the level pot. Each button is highlighted in gold when it is selected. When a solo buss is 

assigned to a master fader, the master fader LCD button displays green, and the button lightens to indicate 

when any channels are assigned to the solo buss. 

The top half of the LCD buttons displays the solo buss number along with any name given to it in the No Solo 

Setup display. When the fader is moved, the bottom half of the LCD button displays the fader level. 

When a solo buss is assigned to a master fader, the fader’s LCD button becomes a solo clear button, as 

indicated by CLEAR being displayed in the bottom half of the button when the fader is stationary. 

Solo Busses can also be assigned to channel faders by using the LCD Function>assign faders and selecting the 

solo channels from the channel list. 

2.10.4 Solo Outputs Routing 

Each solo buss includes an insert send and return, and a direct output, both of which are routed in the Solo 

Outputs display. This display is accessed by touching the insert button below the no solo button, or the direct 

outs button in the top left of the solo buss output area. 

This insert point only applies to the Solo buss Direct Output, not to the headphone signal. 

At the top of the Solo Outputs display, the buss naming function described above is duplicated. Towards the 

bottom of the display, there are two buttons marked output and insert A. Selecting one of these buttons 

assigns that send (or send and return) to the signal routing area above it: When the insert is assigned, the ins A 

send routing button appears in the left-hand column, and the ins A return routing button in the right-hand 

column; When the output is assigned, the outputs routing button appears in the left-hand column and the 

right-hand column is left blank. Pressing any of these routing buttons opens a routing display. Insert and output 

routing can then be routed as described in the Getting Started section. 

An extra button labelled send+return is included above the ports list in the Insert Send Route display button. 

When this button is activated, the send and return routing is linked for all signals within the INTERNAL port: If 

the Graphic 1 input is assigned to the insert send, the Graphic 1 output is automatically assigned to that insert 
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return. Similarly, if it is the return which is manually assigned, the send automatically copies that send 

assignment. The send+return button is grey when inactive and brown when active. 

Once the insert send and return signals have been selected, level trim pots appear in the bottom half of the 

Solo Outputs display. To the left of both pots there is a meter (or pair of meters, in the case of stereo channels) 

displaying the send or return level, and to the right of both pots there is a numeric display of the level trim in 

dB. Below the send level trim there is an on button which switches the send on and off. Below the return level 

trim there is a reverse phase button which inverts the phase of the returning signal. Both of these buttons 

become ringed in red to indicate that they are on. 

Once any insert or direct out has been routed, the route is displayed below the button in the Solo 1 or Solo 2 

display. 

2.10.5 Headphone Outputs 

Touching the headphone button in the bottom left-hand corner of the display sends the solo buss signal to the 

headphone socket(s). The button turns blue to indicate that it is active. 

The headphone output(s) receive both solo buss signals, and the headphones will be silent when neither buss 

is routed to them, unless a no solo signal has been assigned. 

The headphone level is controlled by the output level pot in the output area, and also by the headphone level 

encoder located on the surface. The headphone signal can be muted by pressing the mute button next to the 

worksurface headphone level encoder, and the button is ringed red to indicate that the headphone send is 

muted. 

2.10.6 Solo Meters 

Solo meters can be displayed on the Master or Overview screen by pressing the floating meters button below 

the solo delay area in either side of the Solo panel. 

Note: Floating meters are described in the Channel List section of this chapter. 

2.10.7 Solo as an Input Source 

Both Solo 1 and Solo 2 are available as input sources for all channel types.  A warning confirmation will appear 

on screen before the route is made. 

WARNING:  Soloing a channel that has a solo buss as its source will result in a feedback loop being created 

and dangerously high audio levels at any output routed from the solo buss or channel 
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2.11 Network and Mirroring 

2.11.1 Network Configuration 

Any two SD Series consoles of the same type can be mirrored together to provide a fully redundant audio 

system. The SD7. Q7 and Q8 consoles are fitted with two separate engines, and as such, offer built in 

redundancy. 

In order to take advantage of this redundancy, you need to verify the console networking is working and 

synchronise your session between the two consoles/engines. 

Before the consoles/engines can be mirrored, you should ensure that a standard crossover network (Ethernet) 

cable is connected between the two consoles/engines (a standard network cable will also work with Quantum 

consoles). Without this connection, the two consoles/engines will not “talk” to each other. To open the 

Network window, touch the Network button at the top of the Master Screen. The following window will open… 

 

2.11.2 Mirroring for the first time 

If the consoles are physically connected, but do not see each other, then you may need to enable Networking. 

There is an option in the OPTIONS/CONSOLE tab to ENABLE CONSOLE NETWORK (YES/NO).  This must be set 

to YES on both Engines.  After doing this, shutdown and restart both consoles/engines and when the sessions 

are loaded go to the NETWORK window and you should see yellow OK lights against A & B. This indicates that 

the network has connected the two consoles/engines, but they are not yet mirrored. 

To mirror the two consoles/engines, they need to be running the same session. The way to achieve this is to 

load the session into the A console/engine, then transfer it to the B console/engine using this Network window. 

Once synchronised, 

session details for both 

Engines will match 

Optocore ID 

When highlighted in 

orange the Audio Master 

button indicates this 

audio engine is currently 

active 

Press the Select button to choose which device 

to send to or receive a session from  

Press here to send a 

session to the selected 

device 

Press here to receive a 

session from the selected 

device 

Press here to mirror to or from 

the selected device 



SD & Quantum Software Reference Manual  2.11 Network and Mirroring  

1. Ensure you are switched to the A console/engine. 

2. Load your session into console/engine A 

3. Open the Network Window 

4. Press the Select button for console/engine B and then press the Send Session to Selected button. 

This will copy your current console/engine A session and load it into the B console/engine.  Once this is done, 

the console/engine B detail section will change to reflect the new loaded session. 

You can now press the Mirror button. The Mirror buttons will turn green, and the console is now mirrored.  

Audio mastership can be switched between console/engine A and console/engine B using the Audio Master 

button and, if the racks are correctly connected, you will not hear the switch of between the two engines. 

There is also an option to Receive Session from Selected which allows a session file to be brought into one 

engine from another. 

When the Mirror from Selected or Mirror to Selected buttons are pressed, the current worksurface mix 

settings like fader positions are transferred from one device to another. If you have sent or received a session 

and then made some simple changes, the additional adjustments are normally transferred when you activate 

the Mirror mode. If there is a significant difference between the two devices' settings at that point, you will be 

prompted to resync the session. 

On an SD7, the ENGINE A/B switch at the top of the centre worksurface will switch the entire worksurface from 

one engine’s control computer to another. It will not (by default) switch the audio processing from one engine 

to the other. This is achieved by pressing the relevant Audio Master button in the network window on either 

engine. When the button is orange, the engine is active. There is an option in OPTIONS/SURFACE tab that 

enables the switching of both control computer and audio mastership at the same time with the worksurface 

ENGINE A/B switch. When first configuring the system, we do not recommend running in this mode. 

2.11.3 Mirroring Mode 

This option determines how the console will behave when Mirrored via a network to another console, engine 

or Offline PC. This option is saved for console not in the individual session. 

There are 4 modes of operation: 

Full Mirror - all functions mirrored from one device to the other - this mode should be used on both engines in 

an SD7. 

Expander - intended for use with an SD7 console and an EX007 Expander unit. The second device mirrors most 

functions from the first device but, significantly, allows different banks to be selected on the different devices. 

Remote - intended for use with a PC being used as a Remote Control for a console. Allows different banks to be 

selected and different setup options on each device. 

One Way - this mode is intended for remote monitoring of what another device is doing. If a device is in this 

mode, it can "see" what the other mirrored device is doing but cannot control the other device. This mode is 

only likely to be used in exceptional circumstances. 

When mirroring 2 single engine consoles, the correct mirroring mode will depend on the operational 

requirements of the system. 
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2.11.4 Mirroring with a laptop PC 

Any SD or Quantum Series console can also be connected to a laptop PC running the Windows operating 

system in similar way to achieve remote control of the console. 

When running SD or Quantum software on a PC, the software will appear in a number of "floating" windows, 

each of which represent a console section. A screen touch on the console is simulated by a right click with the 

PC mouse. To switch between console sections, use the small toolbar buttons that also appear on the screen 

marked Master\Left\Right etc. 

The DiGiCo website has downloads available for all current versions of "Offline" software. 

The SD and Quantum software on the PC is identical in operation to the console software and the USB key that 

is provided with the console will contain the offline software installation package. 

Run the Installer from the USB Key.  It will create folders in the root directory of your PC's C:\ drive and place a 

shortcut to the Offline Software on the desktop. 

IMPORTANT NOTE: When mirroring a console to a PC you are required to set a static IP address on your PC 

which is in the same subnet as the console itself. The console's subnet mask is 255.255.0.0  255.255.255.0 (SD7 

only) and its IP address can be seen next to its entry in the Network panel - in the picture above it is 

192.168.2.146 for Engine A. 

The IP address of the PC must start with 192.168.2.xxx. and must be different to that of the console. 

The setup of network addresses on a PC may differ from one operating system to another so if you are in 

doubt, please consult the documentation for your PC's operating system before proceeding. 

As an example, on Windows 10, the IP address and subnet mask can be changed by:  
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1) Opening the Control Panel>Network and Internet>Network and Sharing Centre. 

2) Left click on Change adapter settings in the side panel. 

3) Double click on the on connection that is connected to the same network as the console.  

4) Double Click on Internet Protocol (TCP/IP) from the list to show its properties.  

5) Set the radio button to Use the following IP address  

6) Type the IP Address and Subnet Mask as detailed above  

7) Confirm the changes and restart the computer 

2.12 Setup Menu 

2.12.1 Audio I/O 

The Audio I/O display is used to configure the physical I/O connected to the SD/Quantum console, including 

identifying and naming the sockets of the option cards installed in racks, and the setting of pads and phantom 

power. 

 

  

Select the port to be configured Edit the Port Name here E.g. 

Stage Rack 

Copy Rack Audio to MADI 

Auto Conforming for all 

ports, individual racks, or 

individual cards. 

Select the contents of the 

bottom-right 

corner of the Audio IO 

Select Card Type manually 

or using Auto-Conform 

function and edit Group 

Name 

Selected Socket Properties 

Edit Name and Socket options 

Sets the selected 

racks gains, pads, 

SRCs and phantom 

power to default. 
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2.12.2 Port Selection 

Each port relates to a set of physical audio connections: 

Local I/O The I/O installed in the rear of the console. 

Rack  A remote I/O rack connected via MADI or Optocore. 

Con  A separate console connected using MADI or Optocore. 

To select which port is currently being configured, touch the name of desired port under the Audio I/O port 

column in the top left corner of the window. Once a port has been selected, the connections contained within 

it are displayed in the socket’s graphic. 

New ports can be added to the session by touching the add port button, below the Audio I/O port column. A 

drop-down list of predefined port configurations will appear, allowing you to select the appropriate device. 

These user created ports can be deleted by pressing the remove port button, below the add port button. 

Copying Audio and Listening to Copied Audio (MADI Recorder Setup) 

Any incoming MADI or Optocore connected rack stream can be copied to any other MADI Output by selecting 

the incoming port in the ports list and using the Copy Audio To drop down menu. For example, if you want to 

copy Rack 1's Audio Inputs to a MADI equipped recorder connected on port 2, select port 1 in the ports list and 

then select MADI 2 from the Copy Audio To drop down menu. The console will send the 56 or 64 channel 

MADI stream to MADI Output 2 and it can be recorded as necessary. In addition, by connecting the recorder's 

MADI Output to the console's MADI 2 Input, the playback can be monitored in the same channels as the 

original source material. Just press the Listen To Copied Audio button to monitor playback and press it again to 

return to monitoring the live sources from the rack. When Listen to Copied Audio is active, "Listening to Copied 

Audio" is displayed in the session status panel of the master screen. 

Note: More complex inter port routing is possible using the Copy Audio Panel, please see the COPY AUDIO 

section of this manual. 

Note: KLANG Konduktor has been added as port and device type in v1528 

2.12.3 Port Hardware Configuration 

The port is named automatically according to its connection type, as displayed to the right of the ports 

selection area. However, the name can be edited by touching the Port Name box or the keyboard symbol to its 

right, typing the new name into the QWERTY keyboard which appears, and pressing OK. The type of device 

connected to the port can be altered by touching the down arrow next to the Device Type box, located next to 

the Port Name box, and selecting the appropriate device from the drop-down list that appears. The physical 

port being used to connect the device can be altered by touching the down arrow next to the Connection box, 

to the right of the Device Type box, and selecting the appropriate connection port from the drop-down list that 

appears. The status of the connection is displayed below the Connection box as either connected (in green) or 

not connected (in red). 

Note: The configuration of the Local I/O port is fixed, so no hardware changes are possible. You can, 

however, change the Port Name, the Group Names (relating to the name of each physical card) and the 

Socket Names (the name of each physical connector on a card). 
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2.12.4 Port Control 

Normally, the input gain, phantom power and pad of each DiGiCo Rack input is controlled remotely from the 

SD/Quantum console. However, in multi-console systems where Racks are shared between two DiGiCo 

consoles with MADI Connections, only one of the consoles can remotely control these rack settings. With 

Optocore connections any console can have control. Therefore, the level of control given to each console must 

be defined. Control options are displayed in the bottom-right area of the Audio I/O panel when the Splits & 

Sharing button towards the base of the panel is pressed: 

 

There are three levels of control:  

isolate: The SD/Quantum console will not exchange any control data with the rack. This means that the console 

will neither be able to adjust rack settings, nor adjust its own settings according to returning control data. 

receive only: The SD/Quantum console will receive the rack’s existing settings but not send control data back. 

This means that the console will not be able to adjust rack settings but will be able to adjust its own settings 

according to returning control data. 

full control: The SD/Quantum console will receive the rack’s existing settings and will send control data back. 

This means that the console will be able to adjust the rack’s settings and receive tallies back from the rack 

Under the Selected Rack column, control can be defined as shared by pressing the Shared button. Individual 

racks can also be controlled using the isolate, receive only and full control buttons beneath the Shared button 

- these buttons will only affect the selected port. 

2.12.5 The Socket Display 

When a port has been selected from the ports list on the left, the individual connections within that port are 

displayed in the Sockets graphic, which makes up most of the rest of the Audio IO display. For Rack or Console 

ports, each column in the graphic represents an IO card, and the type of IO card is displayed at the bottom of 

each column. For the Local I/O port, each row represents a type of I/O socket. 

Each individual socket displays the following information: the current socket name is across the middle, and the 

socket number within the card is in the top left-hand corner. 

For analogue input sockets, the current gain is at the bottom, and the top right-hand corner displays a red 48 

symbol if the socket’s phantom power is switched on. For analogue rack output sockets, there is a -10 symbol 

in the top right-hand corner which is yellow to indicate that the 10dB pad is switched in, and white to indicate 

that no pad is present. 

For digital inputs the status of Sample Rate Conversion On/Off is displayed. 

Touching a socket within the graphic assigns that socket and its card to the area below the graphic for 

configuration, as described below. The number in the top left corner of an output socket will change colour if 

the socket is being used by the Copy Audio Function. 
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2.12.6 Socket Conforming 

In order to use a rack, the on-screen contents of the rack must match the cards physically installed in the 

connected rack. There are two ways of achieving this: 

Manual Conforming 

Select each card (column) and manually select the appropriate card in the Card/Slot Type drop down menu in 

the lower section of the window. Once the correct card type is selected, the card type name at the bottom of 

the selected card will turn green, indicating the card type matches the card installed in the rack. If there is a 

mismatch, the card type name will be red, and the error should be corrected by selecting the correct card type. 

Automatic Conforming 

The audio I/O can be automatically conformed for the whole console (using the Conform All Ports button in 

the bottom left of the panel) or the currently selected rack (using the conform rack button below the socket 

display). Pressing these buttons will correctly select the correct card for each slot. Once complete, all of the 

card labels beneath each slot should turn green. 

The default rack button below the socket’s graphic can be used to reset the gains, pads, SRCs and phantom 

power settings for the selected port. 

It is also possible to auto-conform on a card-by-card basis: With a single card selected (by touching any of the 

sockets on that card), press the Cards & Sockets button towards the base of the screen, followed by the 

conform card button which appears in the area to its right. 

2.12.7 Group and Socket Names 

Cards and sockets are named automatically, according to the Device Type, Card/Slot Type and their position 

within the port. To edit these names, press the Cards & Sockets button towards the base of the Audio I/O 

panel to bring up the Card Setup and Socket Setup displays to its right: 

 

Touch either the Group Name or the Socket Name box (or the keyboard symbols to their right), type the new 

name into the QWERTY keyboard which appears and press OK. Touching the down arrow in between the 

Socket Name box and keyboard symbol opens the Channel Name display which enables commonly used words 

to be inserted quickly without the use of the keyboard. 

A range of sockets can be named with the same label and an incrementing number by using the auto-name 

function below the Socket Name box: To define how many sockets will be auto-named, touch the numeric 

display, turn the Touch-Turn encoder to the right of the screen until the numeric display below the keyboard 

symbol displays the correct number. Alternatively, touch the numeric display, type in the number of sockets to 

auto-name into the keypad that appears, and press OK. Once the number of sockets has been defined, the 

auto-name button becomes active. Pressing it will cause the name of the assigned socket to be replicated for 

all the sockets selected for auto-naming. If the assigned socket’s name does not end in a number, a ‘1’ will be 

added to it and incremented for the remaining sockets. If the assigned socket’s name already ends in a number, 

that number will be incremented for the remaining sockets. 
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2.12.8 Socket Options 

Depending on the socket type, further Socket Options are displayed below the Socket Name area. E.g. if an 

input card is selected, and option for phantom would appear. 

Line Check 

When line check mode is active, any input connected to the console whether it is routed into a channel or not, 

can have its socket parameters adjusted.  Touching any input socket will show the available controls in the 

socket setup area.  Gain is controlled via the touch turn control. When listen is pressed, any audio from the 

selected socket will be sent to the solo assigned to Line Check, this can be changed in the solo tab in the 

options panel. There is also a drop-down list of inputs using this socket. 

 

2.12.9 Copy Audio 

The Copy Audio Matrix, located in the Setup Menu, has been designed to serve 2 purposes: - 

• To provide a flexible system for routing input sources from multiple racks to a recording system. 

• To route inputs from one rack to the outputs of another rack without using up console processing 

resources. 

Any input socket connected to a console port can be copied multiple times to any output port socket.  One of 

these “copies” can be nominated as your “Listen Source” for when Listen to Copied Audio is activated. 

It is also possible to place a copied input socket in “Listen Safe” so that when Listen to Copy Audio is activated; 

the original source will be heard rather than the copy source. 

Copy Audio settings are not snapshottable and remain constant throughout a session unless they are manually 

changed by the user. 
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Setting up the system 

In Audio IO, conform all your ports, make any required Optocore output allocations and map your system. 

 

Open the Master Screen / Setup / Copy Audio panel and you will see the collapsed matrix with input ports 

listed down the left side and output ports across the top. 

The input port list on the left shows all available input ports that have been configured in Audio IO including 

Local IO, MADI and Optocore connections. Touching on any of these ports will expand the list to show the 

individual sockets. If a socket has been routed into an input channel, the channel name will be shown in the 

“Channel” column. 

The output port list across the top shows all available output ports that have been configured in Audio IO.  

When expanded, any output socket that is already in use or is not allocated to your console is shown in blue 

and its column highlighted.  Existing routes from channels/busses cannot be overwritten in Copy Audio. 

If a port is expanded, touching anywhere in the sockets list will collapse that port. 

To make a copy route, expand an input port and output port and touch/drag on the grid.  You will see the 

selected cells turn red. This first copy, by default, is defined as your Listen Source.  Any subsequent copies of 

the same input socket are shown as orange cells.  You may copy an input socket to as many locations as you 

wish but only one can be defined as your listen source. You can change the defined Listen Source by first 

pressing the “Set Listen Source” button in the top left corner of the panel and then touching on cell in the 

matrix.  This cell will turn red, and any previously selected listen source cell will turn orange. 

If you have used the “Copy Audio To” function in the Audio IO Panel and the open the relevant ports in the 

Copy Audio panel, you will see a diagonal line of red cells between the source port and the destination port. 

If an output socket is being used as a copy destination, this will be indicated in the Audio IO page by card 

socket number showing red (for a Listen Source) or orange (for a copy). You will also see a red/orange square 

next to any sockets in use in any channel/ buss output routing panel.  Please note the copy routes CAN be 

overwritten by output routes. 

 

Set Listen Source 

Expanded view of rack 

inputs Orange square indicates 

copied but not set as 

listen source  

Red tick indicates 

socket is in listen 

safe mode  Red square indicates 

socket is set as the 

listen source 

Expanded view of rack 

outputs 
Indicates output socket 

unavailable  
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Listen Safe 

Listen safe is designed to allow the user to “Safe” a channel from the “Listen to Copied Audio” selection. This 

means that when listen to copy audio is toggled on, sockets that are safed will be excluded. This can be 

activated from the Copy Audio Panel, the Channel List (when in Edit mode) or any Input Channel Setup Panel.  

When active, the Input Channel Name box will turn red. As the Listen safe is associated with the input socket, 

Main and Alt inputs have independent listen safes. 

 Copy Audio Presets, Move and Copy Outputs functions 

 

The move outputs, copy outputs, and presets buttons can be found at the top of the copy audio panel, which 

can be accessed from Setup > Copy Audio.  

 

Move outputs allows the output routing to be moved from one place to another. For example, there is a 

selection of channels sent to the local IO in copy audio, but instead these need to be sent to a rack output. 

Press move outputs, select the source output device and then select the destination output device and the 

copy audio routing will be moved. 

Copy outputs allows the copy audio routing from one output device to be copied to another output device.   
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Press copy outputs, select the source output device and then select the destination device and a copy of the 

copy audio routing will be created. 

Presets can be used to save routing made in Copy Audio, saving time. 

 

In the presets panel, presets can be created and updated, their names can be edited and presets that are no 

longer wanted can be deleted. All presets can also be cleared. 

2.12.10 Audio Sync 

Selecting Audio Sync from the Setup menu opens the Audio Sync display. This is where the clock source is 

selected: 
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An SD/Quantum console will operate at Sample Rates of either 48000Hz (48kHz) or 96000Hz (96kHz), as 

configured in the Session Structure panel. 

By default, the console will be set to clock internally (master). The console can also be clocked to external 

sources including: Word Clock, AES/EBU, Video Reference (SD/Q5, SD/Q7), MADI & Optocore.  

Note: The Audio sync settings of a console are saved to the session file. 

Note: When a valid clock is detected on an external sync input, the corresponding Green OK box will light, 

even if that input is not selected as the clock source for the console. 

In standard operation, all Optocore connected console engines should be set to Audio Sync = Optocore. In this 

situation the Optocore device with the lowest Optocore ID will automatically become the Master Sync source 

for the Optocore system. An Optocore system can be synced to an external Word Clock sync source by 

connecting that Word Clock source to any SD/Quantum engine Word Clock Input and selecting Word Clock as 

the Sync source in the Setup/Audio Sync panel. 

Note: If 2 SD engines have Word Clock connected to them, the system will sync to the Word Clocked 

engine with the lowest Optocore ID 

An Optocore system can also be synced to a Word Clock source connected to the Word Clock input on any SD 

Rack. Connecting the Word Clock to the rack automatically sets this as the Master Sync Source. If any SD engine 

has a Word Clock sync source and is set to Word Clock sync, this will be used as the Master Sync Source instead 

of the SD rack. 
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2.12.11 Timecode & Transport 

 

When the SD/Quantum console is used in typical live sound applications there will often be no time related 

control systems (timecode) or motion control (tape transport) connected. Synchronisation and machine 

control does not need to be considered. 

This panel can be accessed by touching the Setup button on the Master screen and then touching the 

Transport & Timecode button. 

Frame Rate 

This must be set up for the frame rate used by your other equipment. You can select from four different basic 

frame rates, with a drop-frame option available for 29.97 and 30fps. 

Timecode Source 

You can choose the Console option to make the console generate the master timecode for the setup, or you 

can choose to make the console "chase" timecode which arrives at one of the external sockets - SMPTE (LTC) 

(SD/Q7 & Q8 Only), MIDI (MTC), or 9-pin. These external sockets are located on the console rear panel. 

The 9-pin Eavesdrop option requires a special 9-pin cable. The option is provided for installations where the 9-

pin connection runs between two other pieces of equipment (for example, a video machine and DAW), but the 

console is required to chase this timecode. 9-pin does not normally allow more than a single direct connection 

between two machines, but using the Eavesdrop cable, you can make the console "listen" to the timecode 

passing between two other machines, and to sync to and display this timecode on the worksurface. 

Note: If you are using 9-Pin Eavesdrop mode, you cannot use any of the options for direct 9-pin 

connection. 
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Timecode Output Enable 

Whether the console is operating as timecode master or deriving its timecode from another device, you can 

choose to route a timecode signal out from the MIDI (MTC) and/or SMPTE (LTC) sockets. If timecode is being 

received from another device, it is regenerated before being routed to the output. 

Machine Control Enable 

The console can only send Control signals if you have enabled a Machine Control output.  This can be MIDI 

Machine Control (MMC) and/or 9-pin Disk or Tape.  Note that you cannot output 9-pin control if you are using 

the Eavesdrop option to read timecode. MIDI Machine Control has limited transport features, supporting only 

the Play, Record, FF, Rewind, Stop and Locate functions. 9-pin control supports Shuttle and Jog functions.  

Off-line Buttons 

The configuration panel allows you to temporarily disable all timecode and transport control to any 

combination of outputs. The ALL button disables all timecode and machine control output - this is especially 

useful to prevent external machines trying to chase the console timecode. 

2.12.12  Macros 

Selecting Macros from the Setup menu opens the Macros display. This display is also opened by pressing the 

assign button in the macros area of the worksurface. 

 

This is where macro commands can be assigned to the smart keys or Macro buttons in the macros area of the 

console surface, as well as to the function (F) buttons on the external keyboard and to the console’s GPIs. 

Macros can also be fired directly from this list by touching the macro when none of the right-hand buttons is 

active. 

The macros area has capacity for either 8 or 40 macros, arranged in one bank of eight, four banks of 10 or eight 

banks of five depending on the console. If the console has bank buttons, pressing any of the bank buttons 

across the top of the macros area assigns the smart keys below them to that bank. The bank currently assigned 

to the smart keys is indicated by its button being ringed green. 
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The Macros display includes a list of all the macro commands which have been created, along with the button 

to which they have been assigned, if this has been selected. The list is scrollable using the scroll bar to the right 

of the list. Note that this list therefore includes macros which have been created but have no trigger. 

Pressing the Transport Button will automatically assign the console transport controls to the macro buttons 

overwriting any existing assignments. 

On SD8,9,11, pressing the floating labels button opens a panel on the console's master screen that shows the 

worksurface macro buttons and their name label if macros have been assigned to them.  Touching either the 

button or the label will fire the macro. 

 

To create a new macro, touch the new button, in the top right-hand corner of the display. To create a macro 

based one that already exists, touch the duplicate button below the new button, followed by the macro you 

wish to duplicate. When either button is touched, a macro is created with the default name macro n where n is 

an auto-incrementing number, and the Macro Editor display (described below) is opened. A duplicate macro 

will contain all of the settings of its parent, apart from the name. 

To edit a macro, touch the editor button below the duplicate button, followed by the macro you wish to edit. 

The Macro Editor display (described below) will then open. 

Macros can be assigned from the main Macros display without opening the Macro Editor by touching the 

assign button below the editor button, touching the macro you wish to assign, and then pressing the button to 

which you wish to assign the macro. 

Macros can be deleted by touching delete files. To delete all the macros in the list, touch select all, followed by 

confirm. To delete one macro or a selection of macros, touch the macros you wish to delete followed by 

confirm. To delete a consecutive range of macros, touch select range, touch the first and last macros included 

in the range to be deleted, and touch confirm. 
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2.12.13 The Macro Editor 

The Macro Editor is where macros are defined, including the commands included in them and the control used 

to trigger them. Virtually any command within the console can be assigned to a macro, ranging from opening 

master panels to adjusting in-channel signal processing. 

Note: that fx parameters are only available once fx units are in use in the session. 

 

The name of the macro being edited is shown at the top of the display. To switch to a different macro in the list, 

touch the new macro in the Macro display list (You may need to move the displays around the panel to access 

the list). To rename the macro, touch the macro name text box, type the new name using the on-screen or 

external keyboard, and touch OK. This name will be used in the Macros display and also in the LCD display 

within a smart key assigned to that macro. 

Note: A line break can be inserted into the smart key macro name by typing a comma within the macro 

name text. 

The list beneath the macro name text box, lists the commands currently included in the macro. When there 

are multiple commands in the included commands list, they are triggered in the order in which they are listed. 

New commands are added to the selected row in the list, overwriting any command previously in that row. To 

insert a row for a new command in between two adjacent commands, touch the row above which you want to 

insert the command, then touch the insert button to the right of the included commands list. 

There are two ways of adding a command to the included commands list: 

1. Touch the row in the list in which you want the command to appear, then touch the capture button, 

located in the top righthand corner of the display. The button turns light blue to indicate that it is active. Any 

commands now actioned on the console will then be added to the included commands list. Once all the 

desired commands have been actioned, deselect the capture button. 
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2. Touch the row in the list in which you want the command to appear, then touch one of the command 

types in the scrollable command types list to the left of the display. This brings up a list of the commands 

within that command type in the scrollable commands list in the lower half of the display. Touch the desired 

command to bring it into the included commands list. 

For commands associated with worksurface controls (all command types above System in the command types 

list), the included commands list displays the command type (in the channel type column), the scope of 

channels included in the command where appropriate (in the from and to columns), the command’s name 

(controller) and any value associated with the command. For command types associated with the master panel 

(from System down), the included commands list displays the command, along with any filename or value 

associated with it. The list can be scrolled if necessary, using the scroll bar to its right. 

The values in the from, to and value columns can be adjusted by using the Touch-Turn encoder and value + and 

value- buttons to the right of the included commands list. Touch the box to be adjusted to assign it to the 

encoder and value buttons. The present value is shown in the display in between the value buttons. If the value 

column displays something other than numeric values, the options are cycled using the Touch-Turn encoder 

and value + and value - buttons (cycling for example, between on, off and toggle). Values can also be typed in 

by touching the value box, typing the new value using the external or on-screen keyboard, and touching OK. 

To remove a command from the list, touch the command to be removed and touch the remove button to the 

right of the included commands list. 

The bottom-right of the Macro Editor is used to define what triggers the macro. The action buttons below the 

smart keys / macro buttons are used to define whether pressing the button triggers a macro on or off 

command. Selecting a new trigger for a macro automatically deselects any old trigger than might have been 

assigned. 

On SD7, SD5, SD10 and SD12 and Quantum consoles, Smart keys are selected by touching one of the bank 

buttons (the number of bank buttons will depend on the console) below the assigned to legend (causing the 

button’s ring to light green, indicating that it is selected) followed by one of its smart keys. The smart key will 

then display the first command from the included commands list. The colour of the smart key can be chosen 

using the arrow buttons in the colour area below the smart keys. The selected colour is displayed between the 

arrow keys. 

On SD8, SD9 and SD11, Macros are assigned in a similar way but directly to one of the 8 Macro buttons. 

Whenever a macro button is pressed, it performs an ‘On’ action. This is the first press of the macro button. The 

next press of the same macro performs an Off action.  

These On and Off actions can be the inverse of each other, so instead of having alternative presses of the 

macro button just toggle the state of a controller, the macro can be programmed so that first press is always a 

mute on command and the 2nd press of the macro button is always a mute off command.  

This has the advantage of being able to provide an indicator on the Macro button of the state of the controller. 

On and Off states can have different colours and different text. 

Macros can be tested by touching the fire macro button, located in the top left-hand corner of the display. 

Once the macro has been fully configured, close the Macro Editor display. 
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2.12.14 Advanced Macro Triggers (V19xx+) 

The Macro Editor has been expanded to include new options for triggering Macros. 

Existing options have been retained but laid out slightly differently on screen in tabbed sections. 

Macros can now also be triggered as part of Snapshot recall. 

Note – only one trigger type can be selected for each Macro. 

The selected, displayed tab will be underlined in orange and the active trigger will be displayed with a green 

circle. 

Smart Keys 

The smart keys tab allows assignment of the Macro trigger to the console’s worksurface Macro buttons. 

Where relevant, select a Macro bank number and then the required button in that bank. 

The Macro can be assigned to the ON or OFF action of the button and a background colour selected. 

 

External 

The external tab allows assignment of the Macro trigger to a GPI, an incoming OSC command or a MIDI 

Program change message. Other relevant options are displayed when the external device type is selected. 
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Snapshots 

A console snapshot can also be defined as a Macro trigger by pressing the edit button in the snapshots tab 

which displays a list of available snapshots. Single or multiple snapshots can be added to the list of triggers for 

any particular Macro. 

 

Note - Any snapshot can only trigger a single Macro so, if a snapshot is required to trigger more Macro 

functions than those included in the existing Macros, create a new Macro which includes all of the required 

commands for that specific purpose. 

 

Other 

The other tab allows assignment of the Macro trigger to keyboard F keys, the console Audio Mastership 

switch A or B and the worksurface prev and next snapshot buttons. 
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Advanced 

The advanced tab allows conditional triggers for Macros whereby the status of certain channel controls and 

meters can be used to trigger a Macro. 

Single or multiple triggers can be specified for one or many channels. 

Required channels can be chosen by touching the ADD button and selecting from the channel list.  

Each channel touched will be added to the list. Channels can be removed from the list by selecting them from 

the list and touching REMOVE. 

If multiple channels are selected, the Macro can be triggered when either ANY or ALL conditions have been 

met. 

 

Choose the required trigger and state for each of the entries in the list. 

Options for potential triggers are fader level, mute state, solo state and meter level. 

For mute and solo, either on or off states can be selected. 

For faders, a value can be set and the trigger assigned to a level greater than or less than that value. 

When the relevant fader passes through that value, the condition will be met. 

For meters, first select the required meter position from pre-trim, post-trim, pre-fader or post-fader and then 

enter a value and a state in a similar way to faders. 

To change the meter position, touch the current selection to display the meter position choices again. 

Note – for meters, a value of sp represents “signal present”. 

For any given channel, each trigger and state combination can only be used once. 

For example, for Channel 1, a fader greater than state can only be used once but fader greater than and fader 

less than is a valid combination.  

If the same trigger/state combination is entered twice for the same channel the following warning will be 

displayed. 
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OSC Macros 

There is also a Macro type called MacroOSC which allows a Macro to transmit an OSC message via the 

console’s ethernet port. 

In the Master Screen > Setup > External Control panel, a new Device Type is used to define the details of the 

external device which will receive the OSC commands. 

Touch the add device button and select Macro OSC from the list of device types, enter an IP address for the 

receiving device and a Send port number. 

Multiple Macro OSC devices can be defined and each should have a unique DevID automatically assigned by 

the console. 

 

In the Macro Editor, there is a command type called MacroOSC which offers options of Integer, Float, String 

and Address Only (no data value required) OSC commands. 

Define the required OSC command and data value and then, using the value +/- buttons, specify a destination 

Device ID in the right-hand column. 
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Macro list search function 

The Macro command list for each command type can be searched by entering text in the commands search 

box at the top of the list. A search can be performed for whole or parts of words. 

 

  

Select Command Type - MacroOSC 

Select Command – Integer/Float/String/Address Only Type OSC Command Enter Data value Specify Device ID 
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2.12.15 Talkback 

The Talkback display, where the talkback busses can be configured, is opened by selecting Talkback from the 

Setup menu. 

 

In the right-hand side of the Talkback display, there is a mic input gain pot which is always assigned to the gain 

encoder in the worksurface talkback area. The pot’s gain value is indicated in the box above the pot. The 

talkback signal level is shown in the meter to its right. Touching the white box below the gain pot opens the 

Talkback Input display which consists of an input route button. The current route is displayed below the 

button. Pressing the button opens the TB Input Route display, which functions in the same way as all other 

input routing panels. 

To the left of the input section of the display, there are talk buttons with text boxes beneath them. Touching 

each button enables and disables the corresponding talkback button on the worksurface. The button rings red 

to indicate that the buss is active. Touching the text box beneath the button opens the TB Outputs display for 

that talk bus. This consists of a naming area and an outputs button. The first output currently selected is 

displayed below the button. 

Pressing the button opens the TB Output Routes display which functions in the normal way. The first selected 

route appears in the text box below the talk button. 
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The three blue coloured text boxes above the buttons provide access to a panel allowing the selection aux 

busses. Once selected, the Talkback button will automatically activate the talk To Aux functions on those 

busses. This enables you to talk to multiple Auxes of your choice at the press of a single button. 

Talk to Auxes 

To talk to individual or multiple of Aux outputs there is an assignable row of controls on Aux channels, 

controllable independently or from the Talkback panel which has a Talk to Aux Setup list for each Talk button. 

This is implemented as a Talkback Input channel which uses a single engine processing channel to provide the 

aux sends. This channel appears, in a default session, on its own in the last bank on the left of the console. 

 

On the Aux Output channels, hold one of the Assign buttons next to the row of assignable controls and then 

touch the talk area of the screen. This will assign the selected rotary control and switch to the talk level and 

talk on/off. These are used to switch Talk to Aux On/Off, control the level of talkback signal and set the level of 

dim when the talk is active. A dim function is available for reducing the level of aux programme while the talk 

function is active. This is set using the 2nd Function of the assigned controls. 

The worksurface talk buttons can also be programmed to activate the Talk function on single or multiple user 

defined channels. Open the Setup/Talkback panel and touch the label above the talk button, then select any 

combination of Mono and Stereo Auxes to activate with that button. 

2.12.16 Text Chat 

Text messages can be sent from console to console on any MADI Port that is defined as "Console". This 

definition uses the last 8 audio inputs and outputs on the port to send text or video communications. The 

default setup of the SD/Q7 defines MADI Port 4 as "Console". With MADI connections from one SD/Q7's Port 4 

In/Out to another SD/Q7's Port 4 In/Out, open the Setup>Text Chat panel, press the 4:Con button to activate 

the link on that port and then type a message. When you press the keyboard Enter key, the message will be 

transmitted and will appear in the other console's Text Chat panel. This process is bidirectional meaning the 

other console can send messages back in a similar way.  This communication can also be achieved across an 

Optocore connection. 
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2.12.17 Video Link (SD7 & Quantum 7 Only) 

The Setup>Video Link panel allows the routing of one of several different video signals to the console video 

screen. The worksurface buttons to select between these 3 sources can be found at the top of the console's 

centre section and are duplicated at the top of the on-screen panel. There is also a Self button to send the 

console's own camera signal to the screen. 

 

 

 

To define the source associated with each button, touch the white label box below the on-screen label and a 

drop-down menu will appear. 

Potential sources include the console's two external video inputs (Ext 1 & Ext 2) located on the back panel and 

any Optocore equipped SD7 engines that are connected. Optocore engines are identified by their Optocore 

Loop number (normally 1) and their Optocore ID which can be seen and set at the top of the console's 

Network panel). 

The lower part of the Video Link panel determines which video source is fed from the console to the video 

network. Only one source can be sent at one time and this is done by pressing the Feed button beneath the 

required source. 

Select the appropriate video format using the NTSC and PAL buttons, ensuring that all connected consoles are 

using the same format. 

The console's camera feed can also be sent as a Mirror image using the on-screen buttons. 

  

Local video source 

selection 

Local to send to other 

consoles 

Activate 

feed 
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2.13 External Control 

2.13.1 iPad Control 
The DiGiCo SD/Quantum app allows remote, wireless control of any DiGiCo SD or Quantum mixing console 

from your Apple iPad. 

To activate iPad Control: 

1. Navigate to Setup > External Control from the menu on the main screen 

2. Enable External Control by pressing the button at the top of the panel - please disable this function 

when External Control is not required  

3. Press the Add Device button and select DiGiCo Pad 

4. Enter a Device Name (user choice) for the device and then enter the IP Address of the iPad 4)  

5. Enter Send and Receive Port numbers for the console e.g. Send = 9000 and Receive = 8000 Note: If you 

enter multiple devices in this panel, they must all have unique Send and Receive ports. 

6. Tick the Enable column for this device. 

7. Press the Load button in the bottom right corner of the panel and select the commands button for the 

relevant console. There are several different sets of commands, one for SD8, SD9, SD11 and SD12 

another for SD5, SD7 and SD10 and others which are specific to Quantum console models.  

NOTE: Only one set of commands should be loaded at one time and if in doubt about which one is loaded, 

please press the Clear All button and then reload the relevant commands for your console. 

8. Take note of the console Local IP Address at the bottom of the panel as this information will have to be 

entered on the Connect page of the DiGiCo iPad App.  
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Enable External 

Control 

Add device type – 

DiGiCo Pad 

Enter iPad details 

Load iPad 

commands for 

relevant console 

(only required on 

first setup) 
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2.13.2 Generic OSC 

This feature allows any device that can transmit and receive OSC messages to be connected a desk. The 

Generic OSC control has 8 rotary and 8 switch controllers that can have their names, values and operating 

ranges defined in the Generic OSC customise section of the External Control panel. 

To activate Generic OSC Control: 

1. Navigate to Setup > External Control from the menu on the main screen. 

2. Enable External Control by pressing the button at the top of the panel - please disable this function 

when External Control is not required. 

3. Press the Add Device button and select Generic OSC Device. 

4. Change the Input Channel Controller to OSC Generic. 

5. Select Other OSC from the drop-down list and then enter a device name, the IP address and 

Send/Receive ports for the Generic OSC device. 

Note: If you enter multiple devices in this panel, they must all have unique Send and Receive. 

6. Tick the Enable column for this device. 

7. Press the Customise button and enter a label, required OSC message, min, max and default values for 

the relevant control. Press rotaries or switches to view the settings for the 2 sets of 8 controls. 

Note: The first four rotaries can be controlled by the graphical touch controls within the expanded panel. 

8. OSC messages should contain an asterisk (*) to represent the channel number Eg. 

/MyDevice/MyParameter/* 
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2.13.3 L’Acoustics L-ISA 

External Control for an L’Acoustics L-ISA system can be added via this menu, this allows OSC commands to be 

sent to L-ISA from channel strip controls.  

To activate L-ISA Control: 

1. Navigate to Setup > External Control from the menu on the main screen. 

2. Enable External Control by pressing the button at the top of the panel - please disable this function 

when External Control is not required. 

3. Change the Input Controller to L-ISA. 

4. Press the Add Device button and select L-ISA. 

5. Select Other OSC from the drop-down list and then enter a device name, the IP address and 

Send/Receive ports for the L-ISA device. 

Note: If you enter multiple devices in this panel, they must all have unique Send and Receive 

L-ISA control can be activated on a channel by pressing ‘L-ISA Control’ at the bottom of the output panel. This 

will display a small plot of L-ISA pan position on the channel strip itself, this area can be pressed to open L-ISA 

Source Control panel (right) where L-ISA parameters can be adjusted. This can be hidden by pressing the ‘view’ 

button.  
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Stereo channels can also have L-ISA control, in which they gain another row of rotary controls on the Source 

Control panel, plus ‘pan spread rotary’ and’ ‘link’ button.  

 

L-ISA groups can be pressed in the ‘L-ISA groups’ selection to allow them to be controlled from the L-ISA panel.  

  

Link the left and right leg 

controls together 

Adjust the 

distance 

between 

the left and 

right leg of 

the 

channel in 

L-ISA 

Control L-ISA 

groups from this 

panel 
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Selection Sync can be activated in L-ISA controller so that when a channel is selected on the console, it is also 

selected in L-ISA controller and vice versa.  

 

Channel faders can be linked with the L-ISA master fader so that the output of L-ISA can be adjusted without 

leaving the console surface. This is assigned in the ‘External Control’ panel.  

 

  

Have channel selection on desk and L-ISA 

follow each other 

Select the fader to 

link to the L-ISA 

master fader 
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2.13.4 d&b Soundscape Control 

Bi-directional control of d&b Soundscape is also available. For remote control to work, a DS100, a computer 

running d&b ArrayCalc/R1 and a computer running En-Bridge are required. 

There is a d&b button in Setup>External Control.  Adding an other osc device will allow communication. 

                                           

Once enabled in the External Control panel, d&B Control and view buttons will appear in the bottom of Input 

Channel and Group Output Output Setup Panels.  When activated for a specific channel, the buttons will have 

a red background and a Soundscape control will replace the standard channel Pan controller.  When the 

Soundscape control on the channel strip or the d&b button on a group is pressed, the Soundscape Control 

panel will open. 

               

The controls are:- 

• Sound Object x Position (rotary) 

• Sound Object y Position (rotary) 

• Sound Object Spread factor (rotary) 

• Sound Object En-Space Send Gain (rotary) 

• Sound Object Delay Mode (3 toggle buttons) 

• Touch the small x/y position display in the expanded view to further expand the display. 

• Touch on the Object Number button to select which sound object that the channel strip shall control. 

• Touch on the Mapping button to select which mapping area shall be targeted from the channel strip's 

controls. 

Full details of the integration can be found at www.dbaudio.com  

http://www.dbaudio.com/
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2.13.5 KLANG Control 

 

The KLANG automated setup process can be automated to some extent - Please follow this link for more 

information - https://www.klang.com/product/console-integration/ 

2.13.6 Spacemap Go control (V17xx+) 

DiGiCo and Meyer Sound Laboratories, Incorporated have worked in partnership to provide integrated control 

of a Spacemap Go immersive loudspeaker system from the console interface. Spacemap Go Channels can be 

associated with console Channels or Groups, with full control of: 

Spacemap Go Panner, Crossfade, Spread and Trajectory transport controls are available from the console for 

each Spacemap Go Channel. The control view also provides the Channel name, both Spacemap names, and 

the trajectory name if active. 

The Spacemap Server runs on the GALAXY network platform processor, and the Spacemap Go iPad app, as well 

as all external controllers are connected as clients to the server. 

This feature is available when using the following software and firmware versions, or more recent releases: 

• DiGiCo Console software V1742 

• Meyer Sound Compass version 4.13.1, which includes Meyer Sound GALAXY firmware version 2.8.1 

Enable 

KLANG 

control and 

nodes 

Enter the 

details of 

the KLANG 

controller 

Bypass all KLANG 

nodes – 

temporarily 

reverted to normal 

aux sends 

Transmit all 

stored 

KLANG 

parameters 

to the 

controller on 

session load 

The KLANG level and aux send level 

will be stored as the same value (if 

KLANG is bypassed or disabled, the 

aux send level will be the KLANG 

level).  

https://www.klang.com/product/console-integration/
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• Meyer Sound Spacemap Go version 1.2.2, available at the Apple App Store 

Spacemap Go Control will be configured in the DiGiCo console’s EXTERNAL CONTROL options tab (MASTER 

SCREEN > SETUP > OPTIONS). In the Channel Controllers panel, select SpaceMap. 

Select Add device and other OSC, then enter the required IP Address and Send/Rcv port numbers as required. 

Confirm by pressing in the Enabled column. 

 

Control of a Spacemap Go Channel can be enabled on any of the console’s Channel or Groups. Navigate to the 

channel and open the Controller view by tapping on CHANNEL > OUTPUT SETUP, at the bottom of the popover 

window enable Spacemap Controller, then View. Close the popover and touch on the 2D XY Panner, the 

external controls will appear.  

 

The assigned Spacemap Go channel can be changed by clicking on the blue box with the currently assigned 

Spacemap channel in white. 



SD & Quantum Software Reference Manual  2.13 External Control  

 

Available Controls from the Console Channel or Group.  

When the Spacemap Go Control is enabled on a Channel or Group, the path’s SPACEMAP CONTROL VIEW of 

each Channel or Group presents the Spacemap Go control interface. This provides control of the following 

parameters for the associated Spacemap Go Channel: 

• X/Y of Spacemap Panner 

• Crossfade 

• Spread 

• Trajectory Rate 

• Trajectory Transport Controls 

A 2D panning interface is provided for touch control of the X/Y position of the Spacemap Panner for the 

assigned Spacemap Go Channel that can be expanded to reveal all of the details. 

 

For more information and connections details please visit https://spacemap-go-

help.meyersound.com/digico/  

https://spacemap-go-help.meyersound.com/digico/
https://spacemap-go-help.meyersound.com/digico/
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2.13.7 Adamson AFM control (V17xx+) 

Bi-directional control of Adamson’s FletcherMachine is also available. This connects via ethernet to the 
computer running the FletcherMachine Remote. 
 
External Control of an Adamson’s FletcherMachine can be added via this menu, this allows OSC commands to 

be sent to the AFM from channel strip controls.  

Select AFM Channel Controller in Setup>External Control. Select XY (cartesian) or DA (polar) coordinate mode. 
Select Master: choose a console fader to control the engine’s master fader and mute (optional). Select the 
additional Layer that can be controlled from the AFM control panel. Choose whether you want Layer Recall 
with session.  
 
Add other OSC device (5321 and 5001 are the default Send and Rcv ports respectively) and make sure the IP 
address is correct (and in the same subnet as the console) and it is Enabled to allow communication. 
 

 
 
When enabled, AFM Control and view buttons are available in the Channel and Group output setup panels.  

 

When activated, the FletcherMachine Controller will replace the regular pan controller. Touch the trackpad on 
a channel or the AFM button on a group to open the FletcherMachine Controller, with an expanded view 
available when touching the trackpad in the controller.    
 
The following controls are available: 
 

- Object X and Y position (rotaries) – XY mode only 
- Center object X and Y position (buttons) – XY mode only 
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- Object Distance and Azimuth values (rotaries) – DA mode only 
- Zero object Distance and Azimuth values (buttons) – DA mode only 
- Object Amplitude Width factor (rotary) 
- Object rendering Mode (3-way toggle button: MIN, FULL, NONE) 
- Additional Layer Send Gain (rotary) 
- Additional Layer Send On (button) 
- FletcherMachine Reverb Send Gain (rotary) 
- FletcherMachine Reverb Send On (button) 

 
The following additional controls are available from the expanded controller panel: 

- Object number selection (touch) 
- Rendering Space selection (touch) 

 
The following additional controls are available for stereo channels and groups: 

- Pair (button) to link/unlink object positions of the stereo pair 
- Spread factor (rotary) for linked object positions of the stereo pair 

 

For further details please visit www.adamson-fletcher-machine.com. Please email 

fmsupport@adamson.ai in case of questions and/or support requests. 

2.13.8 Sound Devices Astral Control (V20xx+) 

The Sound Devices transmitters have an innovative set of control options, with magnetic switches on their A20 

TX beltpacks and various control rings for the new A20-Handheld transmitter. With the Astral External control 

device option, Macros can be programmed to be triggered directly from the transmitter, no matter which of 

the three receivers are in use.  

To configure an Astral controller on the console, first navigate to external control, then select add device -> 

Astral 

http://www.adamson-fletcher-machine.com/
mailto:fmsupport@adamson.ai
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Check the IP addresses of the Sound Devices hardware and the console. 

You can see console IP in the External Control panel, and the Astral IP in Network menu, under the Control IP 

header. 

In console External Control, input your IP Address. Note that Send and Receive ports are fixed when using 

Astral integration. 

 

On the Astral device, enter your Console IP(s). 

This can be done by navigating through: 

Menu -> System -> Macros -> DiGiCo Console List 

Next, set your Device ID. You can have up to 5 pairs of redundant boxes, or 15 single boxes on your network. 

For example, in a system with two Nexus boxes and two consoles/engines, configure the relevant IP addresses 

on all devices, and set each Nexus box to 1-A and 1-B on both consoles. 
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Once your IP address has been set on all devices, enable the device(s) in External Control. 

When macros have been set up on your Astral device, you are able to select both the Device and Command ID. 

The Command ID will need to match the OSC ID of the relevant macro on the Astral, while the Device simply 

matches the DevID set in External Control. 

2.13.9 Additional Buttons 

HUI Sensing (Not implemented) 

Suppress OSC Retransmit 

This button blocks the same OSC message from being sent until a new command is sent. 

Bundles  

Selecting Bundles in External Devices will enable the transmission of OSC bundles. 
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Chapter 3: Connections & Multiple Console Setups 
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3.1  Console Audio Connections 
SD/Quantum console external audio connections can be made using either BNC MADI (AES10), Optocore or 

the DiGiCo Cat5e Connection. There are 2 types of MADI connection available.  A DiGiCo Stage rack can be 

connected to a console via a bi-directional MADI connection will have up to 112 channels (56 in, 56out) of 

audio plus the control data for the Rack (located on CH57).  A Bidirectional standard MADI stream will contain 

up to 128 channels of Audio (64in, 64out) and can be connected to any 3rd party device that has MADI 

connection. 

A DiGiCo Cat5e connection is a Bidirectional up to 64 Channel l/O interface that uses STP Cat5e Cable with 

interference suppressors fitted on each end used to connect D-Racks and SD9 and SD11 Consoles, along with 

MADI-C DMI cards. 

3.1.1  Optocore V221 

 

System Overview 

The V221 DiGiCo Optocore fibre system provides users with a highly flexible system. For correct and safe 

operation of the system, the basic principles need to be understood. 

A DiGiCo fibre loop supports up to 10 SD Engines (5 Redundant Consoles) and 14 Racks. These are identified as 

follows. 

Note: For more information on Dual Loop Optocore systems please refer to the relevant section of this 

document 

SD Engines are allocated ID’s between 1 and 10. SD/Quantum consoles with 2 Engines are allocated ID’s in 

consecutive pairs; 1&2, 3&4 etc. Consoles with only one engine such as the SD8 only have a single ID. If 2 SD8s 

are to be configured as a redundant pair, then their ID’s should be allocated consecutively, in the same way 

that SD/Quantum redundant Engines are paired. 

SD Racks (and Optocore enabled D-Racks) are allocated ID’s between 11 and 24 

Card status for Optocore: 

Green tick = this console 

Red cross = available 

Red cross greyed out = unavailable 

Prevents changes to 

Optocore settings on all 

consoles in the system 

Select setup Optocore to view 

the Optocore settings. 

Optocore remap button- should be 

used if a message appears 

indicating “remap required” 

Indicates card type 

and which Optocore 

ID has ownership of 

output cards.  

Assign or disable all 

Optocore inputs or 

outputs on selected 

rack for this console 
Remaps inputs to 

local console only  
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Note: SD Racks can be set to Optocore IDs 1 to 10 but the racks will not work on the Optocore loop if set 

to these values. These values are used for factory testing only. 

As with previous Optocore systems, each device must have a unique ID. Additionally, each device must also be 

set to run at the same speed. The previous Optocore system was fixed at 1G. The default speed for the 

Optocore V221 system is 2G. 

Each Optocore loop (running at 2G) is capable of 504 channels of audio at either 48k or 96k.  On an SD7, up to 

2 loops can be operated, providing up to 1008 channels of Optocore I/O 

The Optocore Interface card (between Optocore connected devices and the SD/Quantum Engine) supports 496 

Input and 496 Outputs. Inter-console IO is also catered for, allowing the transmission of Audio and Video 

between SD Engines. 

This Optocore system allows for many more channels of audio than can be simultaneously routed into and out 

of the console. The limit of simultaneously routed signals is 384 inputs and 384 outputs, including routing to 

local IO and MADI connected devices. 

The V221 Optocore implementation provides additional functionality and features over the original Optocore 

system, as follows. 

All inputs (to racks) are available to all consoles. However, it is possible for any console to opt-out of inputs, on 

a per-input card basis. This means that when the channel routing panel is then opened, only the relevant 

inputs are accessible. This is particularly in a larger shared system. 

Output cards can be allocated / assigned to individual consoles. In practice, this means multiple consoles 

sharing a single SD Rack to have an output card each. 

The Optocore system can be “locked” by any console and reconfiguring of the system is then not possible until 

all consoles have been placed in an unlocked state. Within a large shared system, this protection mechanism 

ensures that audio cannot be disrupted by another console on the loop. 

To configure these allocations, the Optocore system must be mapped. This map tells each device on the loop 

which fibre channels it is accessing – Racks insert audio onto the loop and consoles extract audio from the loop 

or vice versa. For this to operate correctly, a map is built telling each device where it inserts signals onto the 

loop, and where it extracts audio from the loop. 

The process of building this map has been made as simple as possible and can be reduced to a few basic steps. 

Connect the Consoles and Racks together, as required. 

Input cards on the racks must be installed in a single block with no gaps between input cards. (So, if your SD 

Rack only needs 5 input cards, they must occupy the first 5 slots in the rack) 

On every console (SD/Quantum Engine), open Audio IO and press the “Conform All Ports”. This then will 

populate the Audio IO panel with all the connected devices. Every console must have the same Audio IO panel 

configuration. 

Allocate Rack output cards to consoles as required. 

Press the “Remap All Optocore” button. 
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3.1.2 FOH & Mons sharing a Stage Rack (MADI) 

It is possible for 2 SD/Quantum consoles to share the inputs from a remote rack by using the 2 sets of MADI 

ports on the rack. In this situation, only one of the consoles can control the rack functions such as the analogue 

gain of the mic pre-amp and the phantom power switching.  

The suggested setup for two SD/Q7 consoles which are sharing the same racks is as follows: 

 

FOH & MONITORS 
WITH DIGIRACKS 

 USING MADI ONLY 

MONITORS 
Audio Sync = MADI IN ON PORT 1 

Uni-Directional Gain Tracking 
FOH has control of the Analogue Gains 

and Monitors can track this 

OPTIONAL 
LOCAL RACK 

SHARED 
STAGE RACK 

OPTIONAL 
LOCAL RACK 

AUX MADI 
IN/OUT 

AUX MADI 
IN/OUT 

AUX MADI 
IN/OUT 

MADI 
SPLIT 

MADI 
SPLIT 

ENGINE B 
MADI PORT 1 

IN/OUT 

ENGINE A 
MADI PORT 1 

IN/OUT 

ENGINE A 
MADI PORT 1 

IN 

ENGINE B 
MADI PORT 1 

IN 

ENGINE A 
MADI PORT 2 

IN/OUT 

ENGINE A 
MADI PORT 2 

IN/OUT 

ENGINE B 
MADI PORT 2 

IN/OUT 

ENGINE B 
M ADI PORT 2 

IN/OUT 

MAIN MADI 
IN/OUT 

MAIN MADI 
IN/OUT 

MAIN MADI 
IN/OUT 

FOH 
Audio Sync = MASTER 
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When using racks on MADI, because each SD/Q7 & Q8 has 2 engines there is a requirement to split the rack's 

MAIN and AUX MADI OUT signals to feed the second console's MADI IN ports. 

The recommended connection between the Monitor console and Stage Rack is a single MADI OUT from the 

Stage Rack's AUX MADI connected to the console's MADI 1 IN. 

The FOH (Master console) is connected via MADI IN and OUT to the stage rack. 

A similar method can be used if the Monitor console requires gain control and the FOH console will track the 

gain changes. 

MADI OUT from the Stage Rack's AUX MADI connected to the FOH console's MADI 1 IN. 

The Monitor (Master console) is connected via MADI IN and OUT to the stage rack. 

1. Open the Setup>Audio I/O panel, select the shared rack port from the port's list (eg Port 1) and then 

press the Shared button for that rack. Do this on both consoles and the rack control functions 

Isolate/Receive Only/Full Control will become available. 

2. One console should be fully connected to the racks using the Setup>Audio I/O panel's Full Control 

button for the Shared racks. 

3. The operators should agree on and set a level of analogue gain that provides enough headroom for 

the required application. 

4. The second console should connect to the Shared racks in Receive Only mode 

5. Gain Tracking (the Track buttons at the top of the Input channel screen) can be switched on for the 

console that is in Receive Only mode for all the channels that are being shared. 

6. When an analogue gain control is changed on the "Master" console, the "Slave" console's analogue 

gain should reflect the changes and the digital trim control should compensate for this change by 

moving by the same amount in the opposite direction.  

Relative Gain-Tracking - Snapshot Recalls Total Gain 

“Relative Gain-Tracking” is implemented as a “Snapshot Recalls Total Gain” option at the bottom of the 

Snapshot Global Scope panel.  When a snapshot recalls an input channel trim, it compares the snapshot’s 

stored analogue gain against the current gain on the channel’s input socket.  If there’s a difference it offsets the 

value recalled by the trim. This only happens when the socket’s rack is in Receive Only, or the analogue gain is 

not in Recall Scope. 

3.1.3 FOH & Mons sharing a stage SD Series Rack (MADI) 

When using SD Racks, the setup is very similar, but the rack split from an SD Rack can be achieved without an 

external splitter. The SD rack has two built in split outputs which can each provide a 56 channel MADI stream at 

48KHz. The added advantage of the SD rack split is that it can be set to provide an automatically gain tracked 

MADI stream. This can be set on the rack itself or from the Audio I/O panel on the console. This means that the 

receiving console does not need to provide the gain tracking facility. 

Note: The console that is controlling the gains should be set to setup/audio sync = Master and the console 

that is tracking should be set to setup/audio sync = MADI 1. 
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3.1.4  FOH & Mons sharing DiGiRacks (Optocore V220) 

If 2 SD7's and DiGiRacks are connected via optical fibre, a similar setup can be achieved in the following way: 

 

 

In this setup, you are limited by Optocore firmware Version 220 to four SD7 engines (2 consoles) and four 

Optocore connected racks. The system can only run at a sample rate of 48KHz. 

Only one of these consoles will be able to use the outputs on Optocore connected racks and this console must 

be set to Optocore ID1 (Engine A) and ID2 (Engine B), The other console should be set to ID3 (Engine A) and ID4 

(Engine B). 

These IDs are set from the Network panel in the Master screen. 

The four racks can have any Optocore ID in the range ID30 to ID33. In the above example they have ID30 and 

ID32. These IDs are set on the racks themselves. 

The connections that should be made are shown in the diagram, as follows: 

The fibre optic cables connect between each device on the optic loop and connect an “A Port” to a “B Port”. 

You should not connect the optic cables in A-A or B-B configurations. The cables connect between each device 

to form a closed loop. This is necessary for the redundant loop to operate correctly. 

CONNECTION WITH OPTICAL FIBRE 

USING DiGiRacks on Optocore V220 

MONITORS 

Audio Sync = Optocore 
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The diagram also shows each console having a local MADI connected DiGiRack using BNC MADI cables. 

The DiGiRack Main MADI Port is connected to one of the MADI Ports on Engine A and the Aux MADI Port is 

connected to the same numbered port on Engine B. 

Open the Setup > Audio Sync panel and set the Sync source to be Optocore. Do this on both engines of both 

consoles. Save and Send the Session from the A engine on each console to its B engine and Mirror each pair of 

engines. 

Now open the Setup > Audio IO panel on the A engine of both consoles and press the Conform All Ports 

button in the bottom left corner. The console will “look” down the connected optical fibre cables and auto 

discover and conform all the racks it can find. In this example, they will find 2 optic stage racks. This function 

will be automatically mirrored to the B engine on each console. 

In its default setup, none of the Optocore connected DiGiRacks will be defined as shared. This means that 

either console will be able to control the rack and adjust Mic Amp Gain, Phantom Power, output pads etc. 

If you are happy for either desk to control the racks, then you can leave the sessions with these default 

settings. Making changes to this default state allows you to define the shared status of each rack. If you set a 

rack to be in full control, then that console will have full control of the rack. 

If you set a rack to be in receive only mode, then that console will not be able to make changes to mic amp gain 

etc but will “see” the changes made by the other console. This is necessary for Gain Tracking to function. The 

third option is isolate, and when in this mode, the console will not be able to make changes, nor see changes 

made by someone else. Gain tracking will not work if the rack is set in isolate mode. 

To set a console as the master controller for the racks: In the Audio IO Panel, select the appropriate stage rack. 

Press the Splits and Sharing button. In the section titled Selected Rack, press the shared button. It will default 

to the Isolate setting. Then press the full control button. A warning will remind you that going into full control 

may affect the live audio. then press Yes. If required, repeat this process for the second stage rack. 

To set racks to be in receive only mode: In the Audio IO Panel, select the appropriate stage rack. Press the 

Splits and Sharing button. In the section titled Selected Rack, press the shared button. It will default to the 

Isolate setting. Then press the receive only button. A warning will remind you that your session will change to 

correctly reflect the actual settings on the rack. then press Yes. If required, repeat this process for the second 

stage rack. 
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3.1.5 FOH & Mons sharing SD Series Racks (Optocore V221) 

 

It is possible for up to 5 DiGiCo consoles to share the inputs from remote stage SD Racks using optical fibre 

cables. It is also possible for the output cards in the SD Racks to be allocated to the consoles on a card by card 

basis. 

The following example describes how to set up 2 consoles with a pair of stage racks in a Front of House & 

Monitors configuration.  The connections that should be made are shown in the diagram, as follows. 

The fibre optic cables connect between each device on the optic loop and connect an “A Port” to a “B Port”. 

You should not connect the optic cables in A-A or B-B configurations. The cables connect between each device 

to form a closed loop. This is necessary for the redundant loop to operate correctly. 

The diagram also shows each console having a local MADI connected SD Rack. These are connected using pairs 

of BNC MADI Cables between one of the MADI ports on the console and the Main MADI ports on the SD Racks. 

Additional redundant MADI cables can be used, connected the redundant MADI ports on the console to the 

Aux MADI Ports on the SD Rack. 

CONNECTION WITH OPTICAL FIBRE using SD 

Racks on Optocore V221 
MONITORS 

OPTO ID 3 and 4 

Audio Sync = Optocore 
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Console Setup & Operation 

To ensure correct operation of this system, it is necessary to ensure that the console and session settings are 

correct. 

Each optically connected device must have a unique ID. On each console, open the Network panel on the 

Master Screen. From the drop-down list at the top of the panel, set the ID of each console. We would 

recommend setting the FOH console to ID1 and ID2 and the monitor console to ID3 and ID4. Even numbered 

IDs are used for Redundant engines in Mirrored engine setups therefore if you were mirroring two single 

engine consoles, they should be set as ID1 for the FOH console and ID3 as the Monitor console. 

Similarly, each SD Rack should have its ID set. Rack ID’s start from 11; this example uses Optocore ID’s 11 & 12 

for the 2 connected racks. 

On each console, ensure that the session sample rates are the same. The sample rate is set in the Files > 

Session Structure panel. Open the Setup > Audio Sync panel and set the Sync source to be Optocore. Do this 

on both engines of both consoles. Save and Send the Session from the A engine on each console to its B engine 

and Mirror each pair of engines. Then open the Setup > Audio IO panel on the A engine of both consoles and 

press the Conform All Ports button in the bottom left corner. The console will “look” down the connected 

optical fibre cables and auto discover and conform all the racks it can find. In this example, they will find 2 optic 

stage racks.  

If the conformed racks in each of the engine's Audio IO panels do not match the other console, then the 

system will not map correctly.  Before the system is mapped, you should allocate any SD Rack output cards. 

Press the Setup Optocore button select / deselect output cards as required. Once this is complete, press the 

Remap All Optocore button. 

[For more detailed information on the Optocore Setup, please refer to Optocore_221_User_D.pdf which is 

available for download from the Support section of the DiGiCo website). 

In its default setup, none of the Optocore connected SD Racks will be defined as shared. This means that either 

console will be able to control the rack and adjust Mic Amp Gain, Phantom Power, output pads etc. 

If you are happy for either desk to control the racks, then you can leave the sessions with these default 

settings. Making changes to this default state allows you to define the shared status of each rack. If you set a 

rack to be in full control, then that console will have full control of the rack. If you set a rack to be in receive 

only mode, then that console will not be able to make changes to mic amp gain etc but will “see” the changes 

made by the other console. This is necessary for Gain Tracking to function. The third option is isolate, and when 

in this mode, the console will not be able to make changes, nor see changes made by someone else. Gain 

tracking will not work if the rack is set in isolate mode. 

To set a console as the master controller for the racks: In the Audio IO Panel, select the appropriate stage rack. 

Press the Splits and Sharing button. In the section titled Selected Rack, press the shared button. It will default 

to the Isolate setting. Then press the full control button. A warning will remind you that going into full control 

may affect the live audio. then press Yes. If required, repeat this process for the second stage rack. 

To set racks to be in receive only mode: In the Audio IO Panel, select the appropriate stage rack. Press the 

Splits and Sharing button. In the section titled Selected Rack, press the shared button. It will default to the 

Isolate setting. Then press the receive only button. A warning will remind you that your session will change to 

correctly reflect the actual settings on the rack. then press Yes. If required, repeat this process for the second 

stage rack. 
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To set racks to be in receive only mode: In the Audio IO Panel, select the appropriate stage rack. Press the 

Splits and Sharing button. In the section titled Selected Rack, press the shared button. It will default to the 

Isolate setting. Then press the receive only button. A warning will remind you that your session will change to 

correctly reflect the actual settings on the rack. then press Yes. If required, repeat this process for the second 

stage rack. 

3.1.6  4REA4 I/O Control (Optocore V221 and MADI) 

An SD/Quantum console can control the IO of a DiGiCo 4REA4 over either MADI or Optocore.  

This enables a 4REA4 to be used similarly to a Rack, and as part of an Optocore loop configuration. 

NOTE: In this configuration the SD/Quantum console must be running at 96KHz to match the sample rate 

of the 4REA4 

Connect any SD/Quantum console to a 4REA4 with MADI or Optocore and have Rack audio and parameter 

control of up to 64 IO sockets on Racks connected to the 4REA4. 

With an external Rack connected via MADI to the 4REA4, the MADI Mode Selection should be set to “Rack 

Control” and Rack Control Mode to “Full Control” in order to send control data to the connected Rack.  

This is found under the relevant DMI port I/O settings in Engine -> Audio on the 4REA4 controller. A168 Racks 

can also be controlled in this manner when connected to the 4REA4 via an A3232 port.  

 

With an SD/Quantum console connected via Optocore to the 4REA4, the Input Channel Count and Output 

Channel Count should be set to the number of channels that need to be controlled. The SD/Quantum console 

can also be connected via MADI to the 4REA4 with the MADI Mode Selection set to “SD console.” 
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Tie Lines connecting the MADI Rack inputs to the Optocore outputs, Tie Lines can be set up in the other 

direction to allow output socket control. This creates a link for audio and control data. The whole IO or specific 

sockets can be tie lined up to a total of 64 

 

Once the 4REA4 has been set up with the correct DMI card settings and Tie Lines are in place, in the 

SD/Quantum console Audio IO window, a “4REA4 Port” can be added from the Add Port drop down menu and 

then using the Conform Port function or by using the Conform All Ports function. 
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This will populate that port with the relevant socket types that have been declared and “tie-lined” in the 

4REA4. 

When 4REA4 Rack input sockets are subsequently routed into channels on the SD/Quantum console, the 

relevant analogue gain and +48V controls will be available in those channels. For output sockets, the output 

pads can be toggled (if applicable) and SRC can be turned on or off on AES outputs.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Create a 

4REA4 

port 
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3.1.7 MADI DMI (SRC) (for consoles with DMI slots) 

Sample rate conversion (SRC) is available for DMI MADI cards running V167+. The settings for this are managed 

in the audio I/O panel. 

Three sample rates are available to select - 48kHz, 96kHz smux and 96kHz hispeed.  

The selected sample rate must match the sample rate of the connected device.  There is no auto SRC function. 

The internal console sample rate and the sample rate of the connected device will determine the SRC state 

shown.  It will either show as SRC active or SRC inactive. 
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3.1.8 Dante 64@96 (for consoles with DMI slots) 

The Dante 64@96 DMI card allows the console to route 64 channels to and 64 channels from a Dante network 

at either 48kHz or 96kHz. The console can have a different internal sample rate to the Dante network by 

turning ‘Auto SRC’ on. This feature will automatically detect a difference in sample rate (either 48kHz or 96kHz) 

and activate sample rate conversion.  

 

Clocking 

All control and configuration of the Dante interface is done externally by the Dante controller software. A 

separate control computer must be provided to do this.  

The Dante network can be set to use the console as the network system clock (in the Dante Controller 

software) or the Dante card can be selected as the console clock source. 

In the picture below, the Dante Controller software displays a Dante 64@96 DMI card and an A168D rack.  

In the Dante Device Config tab, the A168D rack must be set to match the Dante 64@96 DMI card sample rate 

at 48kHz or 96kHz. 

  

Toggle 

Auto SRC 

on and off 

Sate of Sample 

Rate 

Conversion 

The current 

sample rate of 

the Dante 

network and 

console 
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Example 1 - Console is Master clock for Dante Network  

In the Dante Clock Status tab, the Dante 64@96 DMI card is set to “Sync To External” and “Preferred Master”. 

This setup enables the DMI card to take its Audio Sync Source from the console itself and in turn provide sync 

to the rest of the Dante network. The console would typically be set to sync MASTER. 

 

 

 

 

 

 

Example 2 - Dante Network is Master clock for console  

If the console is required to use the Dante network as its sync source the following settings should be applied.  

Enable Sync to External = OFF  

Display Preferred Master 

& 

Sync To External 

Set Preferred Master 

& 

Sync To External 

Sample 

Rate 

Sync To 

External = OFF 



SD & Quantum Software Reference Manual  3.1 Console Audio Connections  

Dante IO (V1280+) 

Socket parameters on A168D and A164D IO racks can be controlled in the same way as other DiGiCo I/O racks 

when connected to a Dante 64@96 DMI card and routed in Audinate’s “Dante Controller” software.  

With a Dante DMI 64@96 card installed in a console, access to 64 channels of IO to/from the Dante network is 

provided. 

A Dante IO box can provide a specific number of IO on the Dante network according to the rack’s capability. 

168D = 16 analogue In and 8 Analogue Out 

Any Dante network may have many more devices on it than just a single console and rack. 

There might be multiple Dante equipped consoles, multiple racks and other Dante devices. 

When a console has a Dante DMI fitted, it “sees” that DMI as a 64 channel interface device to/from the Dante 

network. 

The source device of the audio signals it is receiving across that interface and the destination device of any 

signals that it is sending out across that interface are generally “unknown” to the console. 

The critical component in determining where the audio is going to/from is the Dante network controller which 

is responsible for setting up audio paths (routing) on the network. 

As an example, using just a single console and a single rack, the console could use its Dante DMI channel 1 as 

an input signal to its own console Input Channel 1 but the audio signal which appeared on that DMI Dante 

channel could be any signal from the Dante IO rack and is determined by the routing in the Dante Controller. 

With the following routing in place, a console that selects any of the DMI card channels 1-16 as an input source 

will receive the signal from the same numbered Rack Input socket – this is a logical setup. 
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3.1.9  DQ-Rack (for consoles with DMI cards) [V1455+] 

PLEASE NOTE that for the connection and use of the DQ-Rack, there is a requirement for the following 

firmware updates to the Dante 64@96 DMI card:  

1. DMI Dante 64@96 firmware update (v103) which is included in the update package.  

2. A Dante firmware update (4.0.20) for the DMI card which can be updated using Dante Updater in 

Dante Controller.  

Socket parameters on the DQ-Rack can be controlled in the same way as other DiGiCo I/O racks when 

connected to a Dante 64@96 DMI card and routed in Audinate’s “Dante Controller” software.  

With a DMI Dante 64@96 card installed in a console, access to 64 channels of IO to/from the Dante network is 

provided. 

DQ-Rack can provide access to 48 analogue Inputs and 24 analogue outputs.   

If the DQ-Rack AES outputs are active, these are accessed using Dante Channels 49-56. 

 

Select DMI DANTE64 device 

type. 

48 analogue Ins. 
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Dante Controller & Routing 

Dante Rack 

Inputs 

Network Switch 

                           Console 1 DMI 64@96 is a Receiver in this case. 

Each channel receives the same numbered input 

socket from the rack 

A168D Rack is a Transmitter in this case. 

Each of the 16 Rack input sockets are routed to the same numbered 

DMI 64@96 channel 
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In this example, a console that routes signal to DMI card output channels 1-8 will be sending them to the same 

numbered Rack Output socket. 

 

  

Dante Controller & Routing 

Console 1 – DMI Outputs 

Dante Rack 

 

Network Switch 

Console 1 DMI is a Transmitter in this case. 

Each of the DMI 64@96 outputs 1-8 are routed to same numbered Rack output sockets 
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3.1.10 MQ-Rack [V1528+] 

Socket parameters on the MQ-Rack can be controlled in the same way as other DIGiCo I/O racks when 

connected to local console MADI or DMI MADI card.  

MQ-Rack can provide access to 48 analogue Inputs and 24 analogue outputs.  

MQ-Rack provides interchangeable AES outputs on output sockets: 6, 12, 18 and 24. Output sockets can be 

changed to AES Outs in Audio I/O panel found in Setup>Audio I/O. Changing an analogue socket to AES will 

give access to two 2 AES Outs. Changing socket type makes the other type inactive. Audio can be routed to an 

inactive socket, but no audio will pass until socket type is active. 

     

                 

Note analogue and AES outputs are switchable from the Audio I/O panel on SD/Quantum consoles as of 

the V1528 release.  

Select MQ-Rack 

device type. 48 Analogue Ins. 

Inactive outputs are 

blanked out. 

Line Out/AES 

switch. 

Inactive outputs 

are “greyed out” 

in channel output 

routing view.  
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Chapter 4: Q8 Specific Features 
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4.2  Q8 Specific Features 

4.2.1 Channel Macros (Q8 Only) 

    

 

Above every channel LCD on the three lower sections of the console, there are two buttons labelled ‘a’ and ‘b’.  

These trigger channel macros, which are macros that can be triggered from specific channels. To create a 

channel macro, go to Master Screen > Setup > Channel Macros. This will open the ‘Channel Macro Editor’.  

Add a new channel macro from the top left corner of the panel and use the list of commands in the middle to 

define the functionality of the channel macro. This can also be done by using the ‘capture’ command in the top 

right corner of the panel. On a new channel macro, toggle ‘capture’, manually carry out the process that the 

channel macro is meant to trigger, then toggle ‘capture’ again to complete the process. Make sure that the 

range of channels that the channel macro effects is correct before assigning it to a channel. 

To assign a channel macro, select the desired channel, then tap one of the black rectangles labelled ‘a’, ‘b’, ‘c’, 

and ‘d’ in the Channel Macro Editor panel. These represent the available slots for channel macro assignment. 

The selected slot will turn the colour of the assigned channel macro and will display its name. Tapping the 

same slot again will unassign the channel macro. It is possible to assign the same channel macro to all four 

slots on a single channel, and to slots on different channels. The name of the selected channel is displayed 

clearly in the middle of the Channel Macro Editor panel.  

There are two ways to trigger channel macros. The worksurface buttons above channel LCDs will trigger any 

channel macros assigned to slots ‘a’ and ‘b’ on that channel and are thus labelled. To trigger channel macros in 

slots ‘c’ and ‘d’, select ‘Macros’ from the display options in the top left corner of the screen. This will change 

the meter view to a channel macro view, where the channel macros in all four slots can be triggered by touch. 

Note: always ensure the correct channel is selected before assigning a channel macro. 
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4.2.2  Expanded Channel Control Area (Q8 Only) 

The Expanded Channel Control Area, positioned between the channel strip and the channel meters, can be 

used to view and adjust various processing controls for any selected channel. If no channel is selected, it will 

appear blank, only displaying the DiGiCo logo. Once a channel has been selected, the buttons along the left-

hand side of the expanded channel control area can be used to select different ‘views’. These are:  

‘Proc’, which displays input processing controls such as gain, trim, DiGiTube, Delay, and Stereo width.  

‘EQ’, which displays parametric EQ and Dynamic EQ controls. 

‘Dyn’ which displays dynamics such as comp, gate, or ducker.  

‘KLANG’ which displays KLANG controls when an aux send is selected. 

‘Aux’ which displays controls for Aux send nodes.  

At the top of each of these views, there are icons to turn controls on and off, copy processing values, and open 

the presets panel.  

A scrollable list of auxes is displayed at the top of the Expanded Channel Control Area. If there are more than 

twenty-four auxes, an ‘Expand’ button appears on the left-hand side. Pressing it will expand the aux list to 

occupy the entire Expanded Channel Control Area. 

To access the Expanded Channel Control Area on either the centre upper or centre lower sections, select a 

channel on either section, then press ‘Select’ in the top left area of the channel view. Pressing ‘Bank’ will 

toggle back to the channel strip view. 

The information displayed in the Expanded Channel Control Area is different based on the type of channel. For 

instance, output channels will have the option on the right-hand side of their ‘EQ’ view to control bands 1-4 or 

5-8, and stereo inputs will have additional stereo processing controls in their ‘Proc’ view.  

On the left-hand side of the Expanded Channel Control Area, there are two side-by-side buttons labelled ‘SD’ 

and ‘M’. These can be used to toggle between SD processing, and Mustard processing. When ‘M’, or Mustard, 

is selected, the top and bottom of the Expanded Channel Control Area will turn yellow to denote that Mustard 

processing is being viewed. In this instance, ‘Proc’ view will display Mustard Tube controls, ‘EQ’ will display 

Mustard EQ controls, and ‘Dyn’ will display Mustard dynamics.   

The Expanded Channel Control Area can also be used to display Nodal Processing EQ and Dynamics. To do this, 

select an aux with nodal processing active from the list at the top of the Expanded Channel Control Area. The 

top and bottom of the Expanded Channel Control Area will turn purple to denote that nodal processing is being 

viewed. ‘EQ’ view will display nodal EQ, and ‘Dyn’ will display nodal Dynamics. To exit nodal processing view, 

select either ‘SD’ or ‘M’ from the left-hand side of the Expanded Channel Control Area. 
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SD Input Processing 

 

SD EQ 

 

SD Dynamics 

 

KLANG 
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Auxes 

 

 

Mustard Input processing 
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Mustard EQ 

 

Mustard Dynamics 

 

Nodal EQ 
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Nodal Dynamics 

 

4.2.3  The Master Faders (Q8 Only) 

By default, the left-hand faders in the centre of the worksurface are assigned to the Master buss, which is the 

lowest stereo group output by default.  

Also, by default, the right-hand faders are assigned to Matrix 1 and Matrix 2. 

In addition, these faders can be reassigned to control any input channel or buss of your choice using the 

Layout>Fader Banks panel 

Press the Assign L1/L2 or Assign R1/R2 buttons and the Channel List will be displayed. 

Select a channel by touching its entry in the Channel List and it will be assigned to the relevant Master Fader. 

These faders can also be unassigned (set to empty) by pressing the Unassign L1/L2 or Unassign R1/R2 buttons 
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4.2.4 Macroders (Q8 Only) 

On every worksurface section, there is a set of four encoders and buttons around an LCD screen under the 

Dynamics controls. These are macroders, which can be assigned to control any parameter for a selected 

channel. By default, they are assigned to control aux send nodes 1 to 4. 

 

 

Macroder functions and controls can be found in the ‘Macroder Editor’ panel, which can be accessed by going 

to Master Screen > Setup > Macroders. In the top left corner of the panel, there are three buttons labelled 

‘New’, which adds a new macroder, ‘Duplicate’, which duplicates the selected macroder, and ‘Delete’ which 

deletes one or multiple macroders. The list of commands in the middle to define the functionality of the 

macroder.  

This can also be done by using the ‘capture’ command in the top right corner of the panel. On a new macroder, 

toggle ‘capture’, manually change the parameters that the macroder is intended to control, then toggle 

‘capture’ again to complete the process. At the bottom of the Macroder Editor panel, assign the macroder to 

one of the worksurface encoders, which are represented by little circles in the same formation as the encoders 

on the worksurface. Tapping once will assign the macroder to the encoder, and tapping again will unassign it, 

and leave the encoder blank. Once assigned, the appropriate worksurface encoder will have the colour of the 

LED ring around it change to match the parameter it affects, and the name of the macroder will appear on the 

LCD. 

Macroders can also be assigned to specific channels, as opposed to any channel on a section of the 

worksurface. To do this, toggle ‘Assign to Channel’ in the bottom left corner of the Macroder Editor panel. This 

will open a little window that displays the name of the last selected channel, and a schematic of one set of four 

worksurface macroder encoders. Simply tapping on any one of the four encoders will assign the macroder to 

the selected channel only. That way, whatever section the channel is on, selecting it will change the assignment 

of the macroder encoders on that section to match whatever was particularly assigned. 
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Note that Macroders are fundamentally different from Macros and Channel Macros in that they don’t 

instantly trigger a set of commands. Instead, they control parameter values as the encoders are turned, 

much like underscreen rotaries. 

4.2.5 Meterbridge Displays (Q8 Only) 

The meterbridge displays differ slightly on the 3 console sections. 

All channel displays show the status of various elements of the channel as seen below: 

 

Left display 

The left display can also show general console status indicators optionally by selecting this in the Options > 

Status tab 

 

 

Centre display 

The centre display shows both upper and lower banks’ meters and also meters for the channels which are 

assigned to the right and left assignable master faders and both solo busses. 

There are also indicators for the Audio Master selection, the Mirroring State and the Mirroring Mode. 
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Right display 

The right display shows the standard channel view and the output of the console’s video system. 

 

4.2.6  Layers and Banks (Q8 Only) 

The QUANTUM 8's worksurface is divided into Layers and Banks. Each Bank contains twelve channels, and the 

channels which are currently active on the control surface are defined using the bank (left column) and layer 

(right column) buttons on the switcher screen to the right of the channel strip section’s faders. 

The view in the switcher screen can be locked to prevent accidental changes by holding down on the button in 

the top left corner of the screen. 

It can also be scrolled by swiping to the right to display Snapshot previous and Next buttons. The swipe 

function can also be locked by touching the button in the top right corner of the screen. 

 

 

 

A ‘bank’ is a set of twelve faders, and a ‘layer’ contains up to six ‘banks’. There are up to six ‘layers’ on the left, 

centre lower, and right sections of the desk, and four ‘banks’ on the centre upper section. 

Tapping a bank (left column) button on the Switcher screen assigns the channels in that bank to the surface. To 

access a bank of faders within another layer, tapping the appropriate layer (right column) button on the 

Switcher screen will assign the banks in that layer to the ‘banks’ column on the Switcher screen. Holding any 

bank or layer button down for a couple of seconds will switch the left and right worksurface sections to the 

same bank level or layer. 

Touch to change 

bank 

Touch and 

hold to lock 

Touch to change 

layer 

Touch and 

hold to 

unlock 

Touch to unlock 

swipe control 
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NOTE: There is also a Master Screen Assign button next to each set of faders on the centre section which 

is used to switch the centre section to display the Master Screen. 

The specific channels which are contained within each Bank are defined in the Layout > Fader Banks panel. By 

default, the Input channels will be assigned to Layer 1 on the left and right sections of the console. The 

different output channels and Control Groups will be assigned to the banks on the centre sections. These bank 

assignments can be customised by the user in the Fader Banks panel and saved in a session at any time. 
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 Chapter 5: Quantum Home 
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5.1  Quantum Home 
When the Master screen > System > Quit To Home button is pressed, the console application is closed and the 

Quantum Home interface can be used to adjust various system settings. 

When the system is locked, Quantum Home automatically launches the Quantum application on start-up. 

When unlocked, the system can be configured. 

5.1.6  Main Shortcuts 

• Quantum x: launches the Quantum x application. 

• Quantum Upgrade: launches the Quantum Upgrade application. 

• Network Settings: see section on network settings. 

• Surface CPU Upgrade 

• Quantum Setup: launches the Quantum Setup application. 

• File Browser: opens a standard File Explorer. 
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5.1.7  Settings Pane 

Click the bottom Settings pane to expand it. 

• Quantum Test: launches the Quantum Test application. 

• Delete Startup Sessions: deletes the following start-up files: 

o “D:\Quantumx\startup.ses" 

o "D:\Quantumx\_session.ses" 

• Show All Windows: restores all open windows that have been minimised. 

System Information: see section on system information. 

• Advanced Settings: see section on advanced settings. 

• Power: opens a window with three buttons: 

o Power Off: turns the console PC off. 

o Restart: reboots the console PC (does not reboot the engine or work-surfaces). 

o Cancel: closes the Power windows and returns to the main Quantum Home view. 
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5.1.8  System Information 

Opens a window displaying general information about the system: 

• General: 

o PC Name: name of the console PC – the factory default name should contain the serial number 

of the console. 

o IP Address: static IP address of the console PC. 

o App Version: version number of the Quantum 8 application. 

o Home Version: version number of Quantum Home. 

o System Version: version number of the overall system. 

• Disks: 

o C Drive: amount of free disk space on the C:\ drive. 

o D Drive: amount of free disk space on the D:\ drive. 

o Memory: amount of RAM on the console PC. 

• BIOS: 

o BIOS: version number of the console PC’s BIOS. 

o Firmware: version number of the console PC’s board controller firmware. 

• Save to File: click to save the system information to a text file. The saved file also contains the 

“locked/unlocked” state of the PC and a timestamp. 
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5.1.9  Advanced Settings 

 

• Lock System Settings/Unlock System Settings: locks/unlocks the system and triggers a console PC 

reboot. 

o Locked state: this is the “console mode” in which Quantum Home automatically launches the 

Quantum 8 application at start-up. 

o Unlocked state: “configuration mode” in which advanced settings and network settings are 

enabled. 

• Display Settings: 

o External Screen: settings for the external monitor. 

▪ Resolution: drop-down list of available screen resolutions for the external screen. 

▪ Orientation: drop-down list of screen orientations: 

• Landscape. 

• Portrait. 

• Landscape (inverted). 

• Portrait (inverted). 

• Disconnected: disables the external screen. 

o Configure All: applies the external screen settings and reconfigures the master, left and right 

screens. Once configured, Quantum Home identifies the screens, allowing for a visual 

confirmation of the new display configuration. 

Note that Quantum Home will require a restart after displays configuration, either by locking 

and rebooting the console or by a forced restart of Quantum Home when exiting the Advanced 

Settings menu. 

o Identify Displays: pops up the display identification view on each screen highlighting the 

current screen position. 



SD & Quantum Software Reference Manual  5.1 Quantum Home  

 

• Quantum Home Update: 

o Select File: opens a file dialog window to browse and open a new QuantumHome.exe file. 

o Update: applies the update by replacing the current Quantum Home with the selected file. 

Triggers a restart of Quantum Home. 

5.1.10  Network Settings 

Requires the system to be unlocked to apply new setting. If the system is locked, the current settings are 

displayed but cannot be changed. 

                   

• Console IP Address: shows the current IP address of the console, can be edited to apply a new console 

IP address. 

• Subnet Mask: shows the current subnet mask of the console, can be edited to apply a new console 

subnet mask. 

• Apply: applies the network settings (console and engine IP addresses and subnet mask). 

• Lock & Restart: is enabled after network settings have been applied. Causes the console PC to restart 

and locks the system. 

5.1.11  Keyboard Shortcuts 

• Hold “Space” at start-up: boots to Quantum Home without launching the Quantum application. 
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Chapter 6: DMI Cards 
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The DiGiCo QUANTUM consoles and the SD12 have two option slots on their rear panel for the installation of 

DMI cards (see below). 

These cards come in a variety of I/O types 

 

6.1  Fitting DMI Cards 

NOTE: DMI cards are NOT hot swappable and therefore they should NEVER be fitted or removed from the 

console while the console is powered on. 

To fit a DMI card: 

 

Remove the four screws from the console blanking plate and this will expose a hole in the rear panel with an 

internal connector and a white slider on each side of the hole. Keep the four screws safe in order to secure the 

card in place. 

NOTE: Before fitting the DMI card, carefully examine the internal connector as in some cases this may 

have a protective cover that must be removed before fitting the card. If the cover is present, please 

remove it before proceeding 

NOTE: With the DMI-MADI C there are 2 internal switches that must be set to the A position for use in the 

console. Please check these switch positions (as picture below) before fitting the card. 

DMI Slot 1 DMI Slot 2 

Card fits in slider grooves 
DMI Internal Socket 
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1) Carefully slide the DMI card in the hole using the while slider grooves as a guide and then ensure that it 
pushes into the internal connector correctly with a click.   
 

2) Replace the 4 fitting screws. 

6.2  DMI-MADI Cards 
There are 2 types of DMI-MADI Card: 

MADI B has 2 pairs of BNC connectors  

MADI C has 2 bi-directional Cat5e connectors 

Both of these cards can be used to connect a Standard MADI stream at 48KHz or 96KHz or an SD-Series DiGiCo 

Rack with the appropriate connector (D-Rack, D2-Rack, SD-Rack, SD-MiNiRack). 

NOTE: Only one DiGiCo Rack can be connected to a single DMI-MADI card at one time. 

6.2.1  Connecting DMI-MADI 

External audio connections can be made using either BNC MADI (AES10) or the DiGiCo Cat5e Connection.  

There are 2 types of MADI connection available. A DiGiCo Stage rack can be connected to a console via a bi-

directional MADI connection will have up to 112 channels (56 in, 56 out) of audio plus the control data for the 

Rack (located on CH57).  A bi-directional standard MADI stream will contain up to . channels of Audio (64 in, 64 

out) and can be connected to any 3rd party device that has MADI connectivity. 

A DiGiCo Cat5e connection is a bi-directional up to 64 Channel interface that uses STP Cat5e Cable with 

interference suppressors fitted on each end used to connect D-Racks and D2-Racks. 

Please carefully note the following connection requirements: 

DMI-MADI C to D-Rack at 48KHz  

Connect DMI card Cat5e socket A to D-Rack Cat5e socket. 

DMI-MADI C to D-Rack at 96KHz  

Connect DMI card Cat5e socket A to D-Rack Cat5e socket.  

NOTE: This setup provides one 28 channel 96kHz MADI stream therefore D-Rack input sockets 29-32 will 

not pass audio. 

Position A for 

console use 
DMI-MADI C internal 

switches 
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DMI-MADI C to D2-Rack at 48kHz  

Connect DMI card Cat5e socket A to D2-Rack Cat5e Main socket. 

 

  

D-Rack

Single Console to D-Rack with DMI MADI C Card 

DMI MADI C PORT A
IN/OUT

SINGLE CAT5e
CONNECTION

At 48Khz - all D-Rack I/O available

At 96KHz - only D-Rack inputs 1-28 & outputs 1-16 available 

Audio Sync = MASTER

Console

D-Rack

Single Console to D-Rack with DMI MADI C Card 

DMI MADI C PORT A
IN/OUT

SINGLE CAT5e
CONNECTION

At 48Khz - all D-Rack I/O available

At 96KHz - only D-Rack inputs 1-28 & outputs 1-16 available 

Audio Sync = MASTER

Console
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DMI-MADI C to D2-Rack at 96kHz  

Connect DMI card Cat5e socket A to D2-Rack Cat5e MAIN socket. 

Connect DMI card Cat5e socket B to D2-Rack Cat5e AUX socket. 

 

DMI-MADI B to D2-Rack, SD-Rack or SD-MiNiRack at 48kHz  

Connect DMI card BNC IN socket A to D2-Rack BNC OUT MAIN socket.  

Connect DMI card BNC OUT socket A to D2-Rack BNC IN MAIN socket.  

 

  

D2-Rack

Single Console to D2-Rack with DMI MADI B Card at 48KHz 

DMI MADI B PORT A
IN/OUT

BNC MAIN MADI
IN & OUT

CONNECTIONS

Audio Sync = MASTER

Console

D2-Rack 

Single Console to D2-Rack with DMI MADI C Card at 96KHz   

DMI MADI C PORT A 
IN/OUT 

DMI MADI C PORT B 
IN/OUT 

CAT5e 
MAIN MADI 

CONNECTION 

CAT5e 
AUX MADI 
CONNECTION 

Audio Sync = MASTER 
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DMI-MADI B to D2-Rack, SD-Rack or SD-MiNiRack at 96kHz  

Connect DMI card BNC IN socket A to D2-Rack BNC OUT MAIN socket.  

Connect DMI card BNC OUT socket A to D2-Rack BNC IN MAIN socket.  

Connect DMI card BNC IN socket B to D2-Rack BNC OUT AUX socket. 

Connect DMI card BNC OUT socket B to D2-Rack BNC IN AUX socket. 

 

DMI-MADI B to a Standard MADI device at 48kHz  

Connect DMI card BNC IN socket A to Standard MADI device BNC OUT.  

Connect DMI card BNC OUT socket A to Standard MADI device BNC IN. 

 

DMI-MADI B to a Standard MADI device at 96kHz  

Connect DMI card BNC IN socket A to Standard MADI device CH 1-32 BNC OUT.  

Connect DMI card BNC OUT socket A to Standard MADI device CH 1-32 BNC IN. 

Connect DMI card BNC IN socket B to Standard MADI device CH 33-64 BNC OUT.  

Connect DMI card BNC OUT socket B to Standard MADI device CH 33-64 BNC IN.  

D2-Rack

Single Console to D2-Rack with DMI MADI B Card at 96KHz 

DMI MADI B PORT A
IN/OUT

DMI MADI B PORT B
IN/OUT

BNC
MAIN MADI

INPUT & OUTPUT
CONNECTIONS

BNC
AUX MADI
INPUT & OUTPUT
CONNECTIONS

Audio Sync = MASTER

Console
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6.2.2  Sharing Racks with DMI-MADI 

If the system is running at a sample rate of 48KHz a D2-Rack, SD-Rack or SD-MINIRack can be shared between 2 

consoles (Two QUANTUM 8s or an QUANTUM 8 and another S or SD-Series console) with the connection 

system shown below. 

In this setup: 

1) All inputs can be shared by the two consoles but only one console controls the rack analogue gains (the 

"Master" console) 

2) The console which is not controlling the gains (the "Slave" console) can automatically adjust its digital trims 

to compensate for the gain changes using a system known as "Gain Tracking" (see below) 

3) Only the "Master" console can use the outputs of the shared rack 

The recommended connection between the Monitor (Slave) console and Stage Rack is a single MADI OUT from 

the Shared Rack's AUX MADI connected to the console's MADI A IN 

The FOH (Master console) is connected via MADI A IN and OUT to the stage rack. 

A similar method can be used if the Monitor console requires gain control and the FOH console will track the 

gain changes. 

MADI OUT from the Shared Rack's AUX MADI connected to the FOH console's MADI A IN. 

The Monitor (Master console) is connected via MADI A IN and OUT to the stage rack. 

Note: The "Master" console should be set to provide "Master Sync" (Setup>Audio Sync menu - see 

diagram below) to the Shared rack 

The "Slave" console should be set to receive its Audio Sync from the MADI DMI slot that is connected to 

the Shared Rack. 

1) The operators should agree on and set a level of analogue gain that provides enough headroom for the 

required application. 

2) The second console should connect to the Shared rack in Receive Only mode (only MADI Input cable 

connected) 

3) Gain Tracking (the GT ON/OFF button at the top of the Input channel setup view) can be switched on for the 

console that is in  

"Receive Only" mode for all the channels that are being shared. 

4) When an analogue gain control is changed on the "Master" console, the "Slave" console's analogue gain 

should reflect the changes and the digital trim control should compensate for this change by moving by the 

same amount in the opposite direction. 

IMPORTANT Note: If Gain Tracking is active on a channel, the digital trim control will still respond to the 

local gain adjustment by compensating locally for the displayed gain change. 

If the "Slave" console loads a session where the Analogue Gain and +48V settings do not match the 

current state of the racks, the Master console should then reload its session to update the state of these 

controls on the "Slave" console  
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If the system is running at a sample rate of 48KHz, a D-Rack can also be shared between 2 consoles (Two 

QUANTUM 8s or an QUANTUM 8 and another SD-Series console with Cat5e connections eg SD9 or SD11) with 

the connection system shown below. 

This setup is similar to the one previously described but requires a DiGiCo Little Red Box. 

The Little Red Box has separate Cat5e connections for: 

The D-Rack itself 

The FULL CONNECT " Master" console 

The RECEIVE ONLY "Slave" console 

In all other respects the setup is the same as that for the D2-Rack and SD-Rack 

Shared Rack

FOH & MONITORS WITH SHARED RACK at 48KHz USING MADI

MONITORS
Audio Sync = DMI MADI IN

Uni-Directional Gain Tracking
FOH has control of the Analogue Gains

and Monitors can track this

AUX MADI
OUT

DMI MADI PORT A
IN/OUT

DMI MADI 
PORT A IN

MAIN MADI
IN/OUT

Connection can be: 
A single Cat5e cable for DMI MADI C

OR
2 BNC cables for DMI MADI B

Connection can be: 
A single Cat5e cable for DMI MADI C

OR
1 BNC cable for DMI MADI B

FOH
Audio Sync = MASTER

Console 1

Console 2
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Shared 
D-Rack

Little
Red Box

SHARING A D-RACK at 48KHz USING MADI

MONITORS
Audio Sync = DMI MADI IN

Uni-Directional Gain Tracking
FOH has control of the Analogue Gains

and Monitors can track this

DMI MADI C - PORT A IN/OUT

FULL CONNECT 
PORT

D-RACK PORT

RECEIVE 
ONLY
PORT

DMI MADI C 
PORT A IN/OUT

Cat5e
MADI IN/OUT

FOH
Audio Sync = MASTER

Console 1

Console 2
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6.3  DMI - Dante Cards 
A DMI-Dante 64@96 DMI card provides 64 input and 64 output channels at 48kHz or 96kHz, along with 

support for SRC (Sample Rate Conversion). This enables the desk to run at a different sample rate to the Dante 

network. 

 

Sample rate conversion can be enabled in the Audio IO panel by enabling ‘Auto SRC’. This will automatically 

switch on when necessary to convert the sample rate of the desk inputs and outputs to match the Dante 

network’s sample rate e.g. the Dante network at 96kHz and console structured at 48kHz. SRC will not affect the 

number of input and output channels that can be routed. 

For both Dante cards, all control and configuration of the Dante interface is done externally by the Dante 

controller software. A separate control computer must be provided to do this.  

In S-Series, the Dante network can be set to use the console as the network system clock (in the Dante 

Controller software) or the Dante card can be selected as the console clock source. 

In the picture below, the Dante Controller software displays two DiGiCo DMI Dante devices. 

The second device in the list is installed in an QUANTUM 8 and has been manually labelled "DiGiCo QUANTUM 

8". 

In the Dante Device Config tab the QUANTUM 8 DMI-Dante card must be set to match the QUANTUM 8 sample 

rate at 48KHz or 96KHz 

Example 1 - Console is Master clock for Dante Network 

In the Dante Clock Status tab, the QUANTUM 8 DMI-Dante card is set to Sync To External and Preferred Master. 

This setup enables the DMI-Dante in the QUANTUM 8 to take its Audio Sync Source from the console itself and 

in turn provide sync to the rest of the Dante network. The console would typically be set as Audio Master in the 

Main Menu > Audio Sync panel  

 

Set Preferred Master
&

Sync To External

Display Preferred Master
&

Sync To External

Sample Rate

Console Master Audio Sync
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Example 2 - Dante Network is Master clock for console  

If the console is required to use the Dante network as its sync source the following settings should be applied.  

Enable Sync to External = OFF 

 

  

Sync To External = OFF

Console External DMI Sync
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6.4  DMI - ADC - DAC - MIC - AES Cards 

    

The DMI-ADC card provides 16 analogue inputs on 2 x 25 way "D" connectors. 

The ADC card is a line card only. There is no microphone amplifier or phantom power available.  

The S-series consoles have no gain control function for these inputs (only digital trim). Maximum input level 

+22dBu. 

The DMI-DAC card provides 16 analogue outputs on 2 x 25 way "D" connectors. 

DAC card is line level only. Maximum output level +22dBu (Digital Full Scale). 

The DMI-MIC card provides 8 microphone pre-amps on 1 x 25 way “D” connector. 

The S-Series consoles have control over phantom power, gain and pad on the card. 

The DMI-AES card provides 16 Inputs (8 pairs) and 16 outputs (8 pairs) on 2 x 25 way "D" connectors.  

All AES inputs are provided with sample rate conversion (SRC) by default.  

All AES outputs are synchronised to the mixer system clock.  

Multi-Pin Connector Pinouts  

The DMI module range use 25 way “D” connectors, Female on the module (Male required on the connecting 

cable). The pins connections are as follows.  

Analogue inputs and outputs  AES-EBU combined in/out 

Sorted by pin  Sorted by function Sorted by pin  Sorted by function 

Function  Pin Function Pin Function Pin Function Pin 

8+ 1 0 2 4out+ 1 0 2 

0 2 0 5 0 2 0 5 

7- 3 0 8 3out- 3 0 8 

6+ 4 0 11 2out+ 4 0 11 

0 5 0 16 0 5 0 16 

5- 6 0 19 1out- 6 0 19 

4+ 7 0 22 4in+ 7 0 22 

0 8 0 25 0 8 0 25 

3- 9 1- 12 3in- 9 1in- 12 

2+ 10 1+ 24 2in+ 10 1in+ 24 



SD & Quantum Software Reference Manual  6.4 DMI - ADC - DAC - MIC - AES Cards  

0 11 2- 23 0 11 1out- 6 

1- 12 2+ 10 1in- 12 1out+ 18 

nc 13 3- 9 nc 13 2in- 23 

8- 14 3+ 21 4out- 14 2in+ 10 

7+ 15 4- 20 3out+ 15 2out- 17 

0 16 4+ 7 0 16 2out+ 4 

6- 17 5- 6 2out- 17 3in- 9 

5+ 18 5+ 18 1out+ 18 3in+ 21 

0 19 6- 17 0 19 3out- 3 

4- 20 6+ 4 4in- 20 3out+ 15 

3+ 21 7- 3 3in+ 21 4in- 20 

0 22 7+ 15 0 22 4in+ 7 

2- 23 8- 14 2in- 23 4out- 14 

1+ 24 8+ 1 1in+ 24 4out+ 1 

0 25 nc 13 0 25 nc 13 

 

Pinout and connection notes:  

0 = earth/ground or screen/shield nc = not connected  + = phase/hot - = antiphase/cold 

Analogue connections for input and output are connected in the same way, as shown. 

Analogue connections for channels 1-8 shown, channels 9-16 follow the same pattern (1 = 9, 2 = 10 etc.). 

AES connections are shown as 4 stereo (2 channel) connections, equivalent to channels 1-8. 

AES connections for stereo connections 1-4 (ch 1-8) shown, connections stereo 5-8 (ch 9-16) follow the same 

pattern (1 = 5, 2 = 6 etc.).  
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6.5  DMI - Waves - Hydra Cards 

         

DMI-Waves has 64 Inputs and 64 Outputs at both 48kHz and 96kHz - there is no control from the console, just 

simple routing of audio inputs and outputs.  

Configuration of this card on the Waves network is done with Waves own software and Control Panels - please 

refer to Waves own documentation for SoundGrid Studio, Waves MultiRack or Waves SuperRack. 

DMI-Hydra has 56 inputs and 56 Outputs and only functions when the console is at a sample rate of 48kHz - 

there is no control from the console, just simple routing of audio inputs and outputs.  

The ID of the card on the Hydra network can be changed from the console by touching the Set Network ID 

button, entering a new number using the on screen keyboard and the power cycling the console. 

Configuration of this card on the Hydra network is done with Calrec's own software and Control Panels - please 

refer to Calrec's own documentation for details. 

IMPORTANT NOTE: If a DMI Hydra card is used in the QUANTUM 8, the console MUST be set to Clock 

Master. 

The Hydra DMI cannot be used as a clock source for the console itself.  

  Set Hydra ID

Select Hydra DMI
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6.6  DMI - ME - A3232 Cards 

         

The DMI-ME provides 40 outputs at 48kHz and 96kHz to Allen & Heath ME-1 or ME-500 Personal Mixers. There 

are no controls on the card. 

The DMI-A3232 allows connection to A168 STAGE Racks. Each Cat5 port supports up to 32 I/O, for a total 

channel count of 64 I/O. The rack can be run in two different modes. In Cascade Mode, up to two A168 racks 

can be connected to each port. In redundant mode, one A168 rack can be connected with redundant cabling 

to both ports on the card. When a DMI-A3232 is connected, each rack connected will be shown in a different 

view. The mode is changed by touching the desired mode in the Port Control Mode section.  

QUANTUM 8 consoles have control over gain, phantom power and pads of the rack. 

NOTE: When changing the Port Control Mode, there is a physical switch on the A168 STAGE racks that 

must also be changed. 

NOTE: The primary and secondary ports on the racks are not interchangeable. The primary port must be 

used as the main connection. 
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6.7  DMI – AMM 
Quantum 852, Quantum 338 and SD12 are compatible with the DMI-AMM card. The DMI-AMM card 

automatically manages live microphones in unpredictable dialogue situations. When one person speaks, that 

microphone’s gain level fades up instantly, while the other microphone gains are reduced. When the speaker 

pauses, all microphone levels will adjust to medium gain to collectively match the level of one microphone at 

full gain. The resulting effect will be as if all speakers are sharing one microphone. When several people talk at 

once, the gain is shared. The AMM Controls (Figure 1) can be found in the Audio I/O window after conforming 

the DMI card (Figure 2 & 3).  

 

Each of the 64 slots within the AMM control panel include a group assign (Group A & Group B) and a weight 

control. The Floor control of each group imposes a lower limit on the level detector for all microphones 

assigned to that group, this prevents a noisy microphone from receiving a disproportionate share of gain. The 

Floor should be left at the default value of -130dB for normal operation.  

Figure 1: AMM Control Window 
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There are two ways to route channels to the AMM. The first is from within the AMM Control window itself. 

Touch the white box below each of the slots, this will open the AMM Routing window (Figure 4). Here you can 

ripple route channels to the AMM, using touch turn to select the desired number of channels. The AMM is 

automatically assigned a post-fader Insert B. Therefore, AMM can also be assigned in a way that DiGiCo users 

will be more familiar with, via the Insert B routing window at the bottom of a channel strip (Figure 5).   

 

 

 

 

Figure 2: Conform AMM 

Figure 3: Open AMM Control 
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Figure 4: Routing Within AMM Control 

Figure 5: Routing via Insert B Routing Menu 
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When channels are routed to the AMM and assigned to a group, a Share % bar is seen in yellow on the right 

side of an AMM slot. This represents the gain Share that the channel is getting when the AMM is active. This 

meter is shown in terms of percentage, meaning that if 2 speakers stop talking at the same time then they will 

both get 50% of the gain share. The Weight control allows adjustment of the relative sensitivity on a per 

channel basis. When weighting controls are balanced (equal), each microphone has an equal opportunity to 

“take over” the system. Changing the weight will not have an effect on the overall level of the channel, just 

how easily it can take a share of the gain. Adding weight to one primary microphone ensure that the particular 

microphone (e.g. a chairperson) will get more of the share of gain (Figure 6).  

 

 

There are a set of master controls available at the bottom of the AMM Control window. These include a Floor 

control for each AMM group within the card and a safe control. The Floor control imposes a lower limit on the 

level detector for all microphones assigned to the relevant AMM group. This prevents a noisy microphone from 

receiving a disproportionate share of gain. The Floor should be left at the default value of -130dB for normal 

operation. The safe option excludes these floor controls from snapshots. 

 

 

All AMM parameters (both master and channel specific) are saved on a per snapshot basis and can be safed or 

removed from the global scope. Only input channels can be added to the AMM. It can be saved globally via the 

Input Devices option in the Global Scope menu on the Snapshots window. This is NOT enabled by default. 

Figure 6: AMM Share Percentage and Weights 

Figure 7: AMM Master Controls 
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6.8  DMI KLANG 

 

The Card provides 64 sends from the console and returns 16 stereo binaural mixes plus a stereo solo (34 

Channels).   

From the control panel, the card’s network details can be viewed.  There are 2 modes, Dynamic, where the 

cards IP is set by DHCP; and Fixed IP, where the IP address, Subnet Mask and Gateway (if required) can be 

defined. 

All of these settings are also available in KLANG:app. 

For Firmware details please see https://www.klang.com/en/downloads  

6.9  DMI AVB 

 

This Milan Certified card provides 64 input and 64 output channels at both 48kHz & 96kHz.   

There are threee sample rate modes, 48kHz, 96kHz and Mixed mode which allows a 96KHz device to share AVB 

streams with other devices set to 48KHz but this will require additional configuration. 

Figure 8: Global Scope > Input Devices 

https://www.klang.com/en/downloads
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Consoles with DMI slots offer the facility to add a DMI AVB port type and this also provides a DMI AVB Control 

panel where The AVB card sample rate and mode can be selected. 

 

Firmware updates for DMI AVB are done via the AVB Update Tool.  

Further information on DMI AVB is available in TN632 – DMI AVB User Guide. 

https://support.digico.biz/hc/en-gb/articles/33360877185041-DMI-AVB-Card-User-Guide

